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1. ABOUT FILEHOLD 

FileHold is a document management software system that is easy to use, easy to install, and is 
affordable for small to large organizations. It integrates with existing applications and enriches 
Microsoft SharePoint deployments. Features include web access, search, version control, 
tagging, workflow, secure user rights, mark up and annotations, redaction, scanning, and OCR 
and indexing.  

Records Management features allow records to be converted to archives, put into legal hold, or 
be scheduled for final disposition. 

2. ACCESSING FILEHOLD 

You are able to access FileHold many ways: 

 Web Client via a web browser. 

 FileHold Desktop Application (FDA) 

 Microsoft Office applications including Word, Excel, Outlook, and PowerPoint 

 Mobile FileHold through your mobile device such as an iPhone 5 or Samsung Galaxy Ace 
II 

Access to files can be gained through any of the methods by users with a valid FileHold 
account.  

Access via the web client can occur using LAN, WAN, an Intranet or over the Internet. Working 
with files via the web client does not require installation of our document management 
software. However, to access the system via the FileHold Desktop Application (FDA) or 
Microsoft Office applications, users will be required to install FDA on their computer. 

The web client and the FDA interface are very similar. You can use either to access the 
document Library but it is recommended that you generally use FDA as it is faster than going 
over the web and has more advanced functions than the web client. See a list of differences 
between the Web Client and FDA. 

2.1. FILEHOLD CONNECTION OPTIONS 

In order to connect to the FileHold server via the web client, FDA, or Microsoft Office 
applications, you must ensure that you have entered the correct connections settings. The 
connection settings are set in the FDA. You must have your username, password, know 
whether it is a locally managed account or domain (Active Directory) account, and the URL 
path to the FileHold server. 

TO SET THE FILEHOLD CONNECTION SETTINGS 

1. Open the FileHold Desktop Application (FDA) and select File > FileHold Connection 
Options. 

2. Select the following options that you want to enable: 

http://www.filehold.com/help/user/fda-web-client-feature-comparison
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 Automatically run FileHold application when I logon to Windows — This option will 
automatically start up FileHold after you log into your computer. 

 Automatically logon to FileHold Library when Desktop Application starts — This 
option will automatically log you in after you launch the FDA. You do not need to 
enter your username and password. 

 Remain logged in even if no activity is performed — This option keeps your account 
logged into the system even if you are not using it. This is dependent upon the 
settings made by the System Administrator. 

3. Select one the following options: 

 Always prompt for credentials — You will always need to log in with a username and 
password. 

 Use my windows account username and password to logon — This uses your 
Microsoft Windows account username and password to login. You will need to ask 
your System Administrator which type of account you are using. 

 Use the following username and password to logon — Your System Administrator will 
provide you with a username and password. Enter the username and the password 
twice.  

4. Select the default domain: 

 Local FileHold Account – Select this option if a username and password was 
provided by your System Administrator. 

 “Domain Name” — Select this option if you are using your Microsoft Windows user 
account to login to FileHold. 

5. Enter the FileHold Server URL. The URL will be given to you by your System 
Administrator and should be in the format 
http(s)://yourcompanyservername/FH/FileHold. 

6. Enter the number of maximum simultaneous transfers. This is the number of documents 
that can be uploaded or downloaded at a time. This number should be kept at 1. NOTE: 
This option may be locked down by your System Administrator. 

7. Select the Share my Inbox with others check box if you want to share your Inbox with other 
users of the same local computer. See Sharing Inboxes for more information. 

8. Click Test URL. If the server URL is correct, you will receive a “Connection Successful” 
message. 

9. Click Test Logon. If the username and password are correct, you will receive a “Logon 
Successful message.” 

10. Click OK. 

2.1.1. Sharing Inboxes 

When importing documents into FileHold, you can now share the contents of your Inbox with 
other users if you have sufficient rights. 

Documents in the Inbox can be shared between users on the same computer. Sharing your 
Inbox allows others to file the contents of your Inbox on your behalf. For example, if there is a 
dedicated scanning station with several people scanning documents to be added into FileHold, 
all users who can log into the Windows environment of that scanning station will be able to file 
all the scanned documents in the Inbox. This is because the Inbox is shared between all the 
users who can log in with a Windows user account. 
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You can set whether you want to share your Inbox in the Connection Options window. Note 
that if you change this setting, it won’t take effect until you log off and then log back in. 

NOTE: The Shared Inbox check box option is only available to users who have at least the 
Write permission to the common application data folder (usually “C:\ProgramData”), which 
normally defaults to members of the Administrators group only. See the Manage Imports Tool 
in the Library Administrator Guide or the Knowledge Base for more information. 

2.2. FILEHOLD DESKTOP APPLICATION (FDA) 

The FileHold Desktop Application (FDA) has a very simple, intuitive and familiar Library 
structure similar to your traditional filing cabinets (cabinets > drawers > folders > documents) 
and Microsoft Windows Explorer folder hierarchy. 

 

You may have your connection settings set to automatically log into FileHold when you start 
the FDA. If you have not selected that option, you will need to login manually. 

TO LOG INTO FDA 

1. Open the FDA. If there is not a shortcut to FDA on your desktop, go to Start > Programs 
> FileHold > FileHold Desktop Application. 

2. Select one of the following options: 

 Go to File > Logon to FileHold Server as username — This uses your stored 
Microsoft Windows or locally managed username and password. 

 Go to File > Logon to FileHold Server as… — This allows you to login using an 
alternative user name and password than the one that is stored in the connection 
options. Enter a username, password, and select a domain. Click OK. 

3. You are now logged into FileHold. Click OK to close the Welcome Screen. 

http://www.filehold.com/help/home
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 Select the check box on the Welcome Screen to not display this screen when FDA 
starts. You can re-enable this screen in the User Preferences. 

2.2.1. FDA Menus and Toolbars  

The FDA has several methods in which functions can be performed.  

 The FileHold toolbar that can be used to perform operations on single or batch (many 
documents at once) documents such as check out or get a local copy.  

 A right-click context sensitive menu where only those functions that can be performed will 
be available to use.  

 The main menu bar where other functions of the FDA can be performed. 

 

 

The following table describes the functionality of the FDA FileHold Toolbar buttons. 

Button Description Permissions Needed 

 Add File 
Add a file to Library Users with Publisher rights or higher. 

 Make a 
local copy 

Makes a copy of the 
documents to the local user 
computer. 

All users with access to the folder. 

 Check out 
Checks out a document for 
editing. 

Users with Publisher rights or higher. 

 Link 
documents 

Creates a link between two 
or more documents. 

Users with Publisher rights or higher. 
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Button Description Permissions Needed 

 Delete 
Deletes a document from 
the Library.  

Deleted documents can be 
recovered by a Library 
Administrator before a set 
amount of time. See the 
Library Administration 
Guide. 

Users with Publisher plus Delete rights or 
higher. 

 Email 
Emails the document as an 
attachment or as a link in 
the body of an email.  

Users with Publisher rights or higher and 
email settings have been enabled by the 
Library Administrator. 

 Check 
out and Email 

Checks the document out 
and sends it in an email 
attachment or as a link in 
the body of an email. 

Users with Publisher rights or higher and 
email settings have been enabled by the 
Library Administrator. 

2.2.2. FDA Hotkeys  

The following are a list of the hotkeys (shortcut keys) found in the FileHold Desktop 
Application.  

Hotkey Description 

Ctrl+Shift+F  Add the content of a desktop folder to the 
document management system. 

Ctrl+Shift+P  Show/hide metadata and properties pane. 

Ctrl+Shift+T  Show/hide the document tray. 

Ctrl+Shift+L  Logoff from FileHold. 

Ctrl+F  Cursor moves to simple “Google” like Search 
bar. 

Ctrl+Shift+A Adds a file to the Library. 

Ctrl+Double-Click Opens the document in its native application 
and checks out the document from the Library 
at the same time. 

Double-click Opens the document in its native application 
but does not check it out. 

F5 Refreshes the screen. 
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2.3. WEB CLIENT 

To access the FileHold web client, you will need to use a valid web browser. See the browsers 
that FileHold supports: 

 

The interface of the web client is similar to that of the FDA. Most functions are identical but 
there is more end-user functionality in the FDA.  

Library Administration and System Administration functions are performed through the web 
client as well. 

TO LOG INTO THE FILEHOLD WEB CLIENT 

1. Open a web browser and enter the URL for the FileHold login screen. This should be 
provided by your System Administrator. It is usually in the format 
http(s)://yourcompanyservername/FH/FileHold/WebClient/LoginForm.aspx 

TIP: It is recommended that you create a bookmark, favourite, or shortcut to the web client 
URL for easy access. 

2. Enter your username, password, and select the domain. 

3. Click Log In. 

NOTE: If you are using Active Directory in conjunction with FileHold, your administrator may 
have configured the web browser for authentication. If this is the case, click the Logon with 
Windows Authentication link on the login page. 

2.3.1. Web Client Menus and Toolbars 

The Web Client has two methods in which functions can be performed.  

 The FileHold Toolbar that can be used to perform operations on single or batch (many 
documents at once) documents such as check out or get a local copy. To select multiple 
documents, select the check box next to the document name. 

 A context-sensitive menu where only those functions that can be performed will be 

available to use. Click on the arrow button  to display the menu.  

http://www.filehold.com/how-to-buy/system-requirements
http://www.filehold.com/how-to-buy/system-requirements
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The following table describes the functionality of the Web Client FileHold toolbar buttons. 

Button Description Permissions Needed 

Get a copy Makes a copy of the documents to 
the local user computer. 

All users with access to the folder. 

Check out Checks out a document for editing. Users with Document Publisher 
rights or higher. 

Edit metadata Opens the metadata pane for 
editing. 

Users with Document Publisher 
rights or higher. 

Link Creates a link between two or more 
documents. 

Users with Document Publisher 
rights or higher. 

Move/copy Moves or copies the document from 
one area in the Library to another. 

Users with Document Publisher 
rights or higher and have ownership 
of the document. 

Users with Organizer rights or 
higher. 

Delete Deletes a document from the Library.  

Deleted documents can be 
recovered by a Library Administrator 
before a set amount of time. See the 
Library Administration Guide. 

Users with Document Publisher plus 
Delete rights, Publisher plus Delete 
rights, and Organizers, who have 
ownership of the document. 

Organizer plus Delete and higher 
roles.  

Convert to 
offline 

Converts the document to an offline 
document. Offline documents are 
those documents that are stored 
outside the FileHold repository, such 
as a library, file room or filing 
cabinet. 

Users with Cabinet Administrator 
rights or higher and are owners of 
the cabinet. 

Send to > Tray Adds the document to your 
document tray. 

All users with access to the folder. 

Send to > 
Virtual folder 

Sends the document to a Virtual 
folder. A Virtual folder must be 
available or created. 

All users with access to the folder. 
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Button Description Permissions Needed 

Send to > 
Email 

Emails the document as an 
attachment or as a link in the body of 
an email.  

All users with access to the 
document and email settings have 
been enabled by the Library 
Administrator. 

Send to > 
Email and 
check out 

Checks the document out and sends 
it in an email attachment or as a link 
in the body of an email. 

Users with Document Publisher 
rights or higher and email settings 
have been enabled by the Library 
Administrator. 

Send to > 
Library archive 

Sends the document to the Archive. Users must be a member of the 
System Administrators / Senior 
Library Administrators group OR a 
member of the Library Administrators 
group which is the owner of the 
cabinet where the document 
belongs. 

Send to > 
Existing 
Workflow 

Adds main or supporting documents 
to an existing workflow. 

Users with Document Publisher role 
or higher. User must have access to 
all added documents and be owner 
of the document version when 
adding main documents. 

Initiate 
Workflow > 
workflow 
template name 

Allows you to select the workflow 
template name from the list and start 
a workflow. 

Selecting more than one document 
will start a multiple document 
workflow. 

Users with Document Publisher 
rights or higher and is owner of the 
document.* 

*Unless the ‘Allow non document 
version owner to initialize workflow” 
permission setting is enabled. See 
the System Administration Guide for 
more information. 

2.4. MICROSOFT OFFICE APPLICATIONS 

FileHold supports access to files when using Microsoft Word, Excel, Outlook, PowerPoint or 
Visio applications. 

The FileHold Desktop Application must be installed and the user must be logged in to use the 
FileHold Office Toolbar and menu commands. When using Microsoft Office 2007, the FileHold 
toolbar and menu will appear in the application toolbar under the Add-Ins tab. In Microsoft 
Office 2003, the menu items are under the File menu. 
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Office 2003 

 

Office 2007, 2010 

Using the FileHold Toolbar and menu commands you can browse the Library, add a document, 
check in a document, send for approval or review (workflow) and in Microsoft Outlook you can 
add an attachment to an email from FileHold. See the table below for details. 

Button/Menu item Description Permissions Needed 

 / Browse to FileHold 
Opens the Get From FileHold 
window where you can select which 
document you want in the Library. 

All users with access to 
the folder. 

 / Send to FileHold > 
Add Document. 

Opens the Add Document to 
FileHold window where you can 
select the location in the Library and 
enter metadata for the document. 

Users with Publisher 
rights or higher. 

 / Send to FileHold > 
Check In Document 

Opens the Check Document Back 
Into FileHold window where you can 
check your document back into the 
Library. 

Users with Publisher 
rights or higher 

 / Send to FileHold > 
Send Review / Approval 
Feedback 

Allows you to select the document 
you are reviewing or approving and 
enter any comments and feedback. 

Users with Publisher 
rights or higher 

Add Attachment from 
FileHold  

Opens the Get From FileHold 
window where you can select which 
document you want in the Library to 
add as an attachment to an email.  

All users with access to 
the folder 

 

When opening FileHold from a Microsoft Office application, the Library tree looks and performs 
the same as it does in the web or desktop applications. Users can also see the associated 
metadata. In the Get From FileHold window, you can perform various functions such as get a 
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copy of a document, check it out, rename, delete, view version history, and open the file after it 
has been downloaded.  
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In the Add Document to FileHold window, you can select the location in the Library structure for 
the document, fill out the metadata, close the document before adding to the repository, delete 
the local copy, and email folder members to notify them that a document has been added to 
the folder. To change the document name in the FOC, click on the document name and type a 
new one. 
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3. UNDERSTANDING ROLES, PERMISSIONS, AND ACCESS TO THE LIBRARY 

Only users with the correct role can use and manage certain parts of the Library structure. 
Your System Administrator assigns users to groups and a role to each group. Your Library 
Administrator will have created the Library structure and assigned group membership to the 
cabinets, folders, and schemas (document type). The role assigned to the group will determine 
what permissions you have in terms of functions in the system and accessing cabinets, folders, 
and documents.  

The following user roles are shown in the order of least permission to most permission. 

NOTE: You can be logged into FDA and the Web Client at the same time but you cannot be 
logged into two FDAs or web clients at a time. Only one user account can log into FileHold at a 
time. 

 

Role Name Description 

Guest User A Guest User has read-only rights. Unlike all other roles, a user with 
the guest user role can log into FileHold many times. If multiple 
people log into FileHold with the same guest user name the log files 
will show the same user regardless of the actual person that logged 
into the system. You can purchase low cost packs of guest user 
connection licenses in groups of 50 to be used with the portal. You 
will need at least one named user regardless of how many 
connection licenses are purchased. 

With the guest user role you can optionally bypass the login process 
entirely by setting up a Self-Service Portal with a guest user account. 
The Self-Service Portal is an optional module that allows users to 
access FileHold with a special URL. The portal does not require a 
login as this is done programmatically. The user simply visits the 
URL and the portal page appears. For more information about guest 
user licenses, contact sales@filehold.com. 

Read Only A Read-Only user role may only download or open and read 
documents from FileHold. They cannot edit, delete, or create 
documents or metadata. They can email documents if given this 
functionality by System Administrators. 

Document Publisher Document Publisher user role can read, get a copy, add, check-
in/check-out, edit documents, and metadata. They can move 
documents that are owned by them.  They cannot delete any 
documents including those which they have added to the system. 

Document Publisher + 
Delete 

Document Publisher Plus Delete user role can do everything a 
Document Publisher can do and delete their own documents. They 
must be the owner of the document in order to delete it. To see the 
owner of a document, you can look at the version properties in the 
metadata pane. 

http://www.filehold.com/features/optional/self-service-portal
mailto:sales@filehold.com?subject=Guest%20User%20Licenses
http://www.filehold.com/help/user/metadata-pane
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Role Name Description 

Publisher Publisher user role can do everything a Document Publisher can do 
plus: 

 Create new folders and folder groups. 

 Copy or move folders and folder groups they have already created. 

 Clone folders and folder groups created by other users and become 
the owners of the folders / folder groups. 

 Publishers cannot delete existing documents, folders or folder 
groups including those which they have added /created. All 
documents and folders created by the Publisher will be owned by 
them and they cannot change the ownership. 

Publisher + Delete Publisher plus Delete user role can do everything that a Publisher 
can do plus delete documents, folders and folders group owned 
(created) by them. 

Organizer The Organizer role is for users who are responsible for organizing 
documents that are scanned or imported into the system or who are 
assigned to organize documents added by other users. For example, 
organizers would move the documents generated by scanner 
operators to their correct folder in the library. Only trusted personnel 
should be given this role. Organizer role user can: 

 Move all documents (which they have an access to) in other places 
in the library including documents which they do not own. In other 
words, they can move documents that are owned by other users. 

 Move, copy or clone all folders and folder groups regardless of their 
ownership. In case of cloning they will become the owners of folder / 
folder groups. In case of copying and moving the original ownership 
of folders / folder groups is preserved. 

 Add folders / folder groups (in which case they will become their 
owners) and rename folders and folder groups. 

 Delete documents that they own. 

 Change document owner regardless of ownership 

 Convert offline documents to electronic documents 

Organizer + Delete Organizer plus Delete role can do everything that Organizers can do 
plus delete all documents, folders and folder groups regardless of 
their ownership. This organizer and delete role can only do this 
within cabinets, folders and Schemas that they are a member of. 

This role should be used by trusted personnel only. 
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Role Name Description 

Cabinet Administration Cabinet Administrators can only administer the cabinets that they 
own; they cannot create cabinets for themselves. They can: 

 Create, edit, and delete drawers, folder groups and folders and 
manage their properties (i.e. membership structure). 

 Access all documents (in Publisher and Delete capacity) from 
anywhere in the library structure unless they are restricted from that 
area of the library structure. If they do not have access to the 
cabinet and folder they will not be able to access the documents. 

 Delete and move electronic records as long they are owners of the 
cabinet. Electronic records can only be moved to another cabinet in 
which they own. 

 Move documents between cabinets as long as they are owners of 
the cabinet. If users need to move documents between cabinets that 
they do not own, then use an organizer role instead. 

 Have access to all document schemas. 

 Change document owner for documents in the cabinets that they 
own. 

 Convert electronic documents to electronic records and vice versa 
for cabinets that they own. 

 Convert electronic documents to offline documents for cabinets that 
they own. 

Library Administration Library Administrators can perform, within their cabinets, the same 
functions as Cabinet Administrators plus: 

 Create cabinets for which they will be the owner of and manage 
them in the Library. 

 Full access to FileHold’s Library Administrator where they can 
manage metadata fields, schemas, events, set up workflow 
templates, manage numerous global settings (i.e. viewer 
permissions, search engine settings, reporting services permissions 
and more),perform various managerial functions such (as check-in 
for user, change document owner, recover deleted document etc.) 
and access many useful reports and usage logs. 

 Library Administrators cannot create cabinets for Cabinet 
Administrators to own. If a Library Administrator creates a cabinet, 
then they are the owners. 

Senior Library 
Administration 

Senior Library Administrators have full control of the FileHold library 
itself and Library Administration area. Senior Library Administrators 
can create cabinets to be managed by any Library Administrator or 
Cabinet Administrator. 
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Role Name Description 

System Administrators System Administrators have complete control of the system. They 
can perform all of the functions of all other roles. However, the main 
tasks of the System Administrators are to add users to the system 
(including assigning the initial password and setting requirements for 
all new passwords and ability to self register), assign users to their 
appropriate groups, enable document control numbers and version 
control numbers, manage user accounts, user groups and the 
system license pool. The System Administrator also has access to 
various global settings (outbound e-mail, system wide configurations 
for managing the various documents format conversion permissions 
etc.) and as well as user activity reports. 

 

NOTE: All roles provide document emailing capability. This can be disabled on a role by role 
basis by a System Administrator in the FileHold Groups area. See the System Administrator 
Guide for more information. 
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4. INBOX (SEND TO LIBRARY) 

The FileHold Desktop Application’s (FDA) Inbox is designed to streamline the importing of 
many documents into the library by removing the bottlenecks associated when adding and 
classifying files en masse. The Inbox is a queue or list of files that have not yet been copied to 
the FileHold Server.  

The Inbox is specific to each user's FileHold Desktop Application (FDA) on their workstation 
and user account profile unless you share your Inbox. Sharing your Inbox allows others to file 
the contents of your Inbox on your behalf. For example, if there is a dedicated scanning station 
with several people scanning documents to be added into FileHold, all users who can log into 
the Windows environment of that scanning station will be able to file all the scanned 
documents in the Inbox. This is because the Inbox is shared between all the users who can log 
in with a Windows user account. 

The Inbox is the first category visible in the library structure. The Inbox acts as a staging area 
for documents that are queued for processing on the client machine prior to be sent to the 
Library. All documents in this list remain on the client machine until they are sent to the library. 
Files located in the Inbox will only be ready to be sent to the Library once they have both 
required metadata (tags) values entered and a destination folder associated with each file. 

Users can quickly add all the files from a network folder to the Inbox to prepare for filing. Files 
in the Inbox that still need to have their metadata or destinations set will have a status of “Info 
Required”. This information is necessary before they can be filed in the Library. 

NOTE: The Inbox is not available in the Web Client interface. 

The status column lets users know if more information is required before the file can be sent to 
the document management system. A status of "Info Required" indicates that the required 
metadata or a destination have not been set. Once all the required information is set, the status 
changes to "Ready to Send" and file can then be uploaded by clicking the Send or Send All 
(used when multiple files are ready to be sent to the Library). The documents are then sent to 
their destination folders and are removed from the Inbox. 

The Inbox can be sorted by document name, type, coming from, or going to by clicking on the 
column header name. The columns can be sorted in ascending or descending order by clicking 
on the arrow button next to the header name.  

 

The following table describes the functions of the Inbox: 

Function Description 

+ (Add documents) Adds documents from outside the document management 
system. 

Remove from Inbox Removes the selected document(s) from the Inbox. 

Edit Metadata Allows you to enter the metadata for the selected 
documents..  

Select multiple documents to be filed under the same schema 
and click Edit Metadata. You can set all the metadata fields to 
the same value. 
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Function Description 

Edit Destination Allows you to select the destination folder for documents.  

Select multiple documents to be filed under the same folder 
and click Edit Destination. You can set the destination to the 
same folder. 

Send Sends a single document to the Library. The metadata and 
the destination must be set in order to send a document to 
the repository. 

Send All Sends all documents that have set metadata and destination 
to the library. 

Auto-File Automatically files documents in folders. This needs to be 
configured. See the Library Administration Guide for 
information on Auto-filing. 
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5. MY FILEHOLD 

The My FileHold area of FileHold provides views of documents that are unique to each user. In 
other words, it is a personal document workspace for you. This area allows you to access the 
documents that you use most frequently, documents that you have checked out, documents 
that are awaiting your review and/or approval, and any alerts or reminders that you have set on 
documents. 

 

5.1. MY FAVORITES 

My Favorites is a list of files that the user has flagged as favorites. To make a document a 
“favorite”, click the star next to the document name so it turns yellow. A yellow star indicates a 
favorite document and will show up in the My Favorites list. 

 

5.2. CHECKED OUT DOCUMENTS 

Checked Out Documents are a listing of documents that the user has checked out of the 
system. For more information on how to check a document in and out, see Checking In/Out. 

 

5.3. DOCUMENT ALERTS 

Document Alerts is a list of notifications received about documents or folders users have 
subscribed to. For more information on setting document alerts, see Setting Document Alerts 
and Reminders. 

5.4. DOCUMENT REMINDERS 

Document Reminders is a list of reminders to check on certain documents at a set time. For 
more information on document reminders, see Setting Document Alerts and Reminders. 
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5.5. RECENTLY ADDED AND RECENTLY ACCESSED 

Recently Added is a list of files that the user recently added to any location in the document 
management system in the last 2 weeks. 

Recently Accessed is a list of files recently accessed (opened, checked out/in, reviewed, etc.) 
to any location in the document management system in the last 2 weeks. 

 

5.6. CALENDAR 

The Calendar helps keep you organized by showing all of your tasks, reminders, and event 
schedules so you can become more proficient at accomplishing your document management 
goals. 

The Calendar is shown in the My FileHold area of the Library tree in the FileHold Desktop 
Application (FDA). The Calendar is not available in the Web Client. 

 

TO ACCESS THE CALENDAR 

1. In FDA, got to My FileHold > Calendar. 

2. The Calendar can be viewed by the Month, Week, Day, or today (current date). You can also 
scroll through the months, weeks, days, and years using the scroll arrows. 

3. Click Today to bring you back to the current date (today’s date). 

4. You can click on a day in the Month or Week view to see the details for the day. 

5. Click on a task or a reminder in the Day view to open the document in the My Tasks view for 
tasks or in the My Document Reminders View for reminders. 
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You can view the following items in the Calendar: 

 Active, overdue, and completed workflow tasks: 

 Completed tasks are in a light green background. 

 Due tasks are in a green background with bold text and then number of tasks due in 
brackets. 

 Overdue tasks are shown in red with bold text and the number of overdue tasks in 
brackets. A task is considered overdue the day after the task is due. Note that this 
shows that there is only one task overdue but two tasks were due on that day. Only 
one task was completed. 

 Reminders are displayed in cyan background. Active reminders that have not been marked 
as read are bolded with the number of active reminders listed in brackets (). Active 
reminders that have been marked as read will be unbolded. Only the current days’ 
reminders are considered active. Lapsed and future reminders are not active. 

 Scheduled events when the Include Events button is selected. Only users with Library 
Administrators roles and above can access this feature. Events are for when documents 
are set to be archived, converted to a record, disposed, or a user defined event. Events are 
displayed in yellow background. 

5.7. RECENT FOLDERS 

The Recent Folders area displays a list of the last 10 used folders is displayed in the tree in 
FDA, the Select Destination windows, and FileHold Office Client window. The Recent Folders 
list is not displayed in the Web Client. This is useful for viewing and keeping track of what 
areas of the document management system you are using and quick access to the documents 
in those folders. 
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6. REVIEWS AND APPROVALS (WORKFLOW) 

The Reviews and Approvals area of FileHold allows you to see the tasks (reviews and 
approvals) that you are assigned to in a workflow. You can also check the status of a workflow 
using the Workflow Status Report. 

6.1. WORKFLOW OVERVIEW 

The FileHold workflow engine is designed specifically to streamline the review and approval of 
files as they proceed through their lifecycle (creation > initiation > review > approval > 
completion). In many collaborative work environments, this labor intensive growth stage of the 
document is where the most time savings can be realized using the workflow functionality. 
Every time a workflow is initiated, a unique workflow instance is created and managed by the 
FileHold workflow engine. The workflow engine is designed to manage literally thousands of 
simultaneous workflow instances for thousands of files. 

Organizations typically must manage a number of internal processes in order to track things 
like order processing, purchase requests and travel expenses. Workflow brings order to these 
independent processes in a transparent, dynamic, and robust fashion making it a key part of 
the document lifecycle. A workflow contains one or more activities (reviews and approvals) to 
be completed during the lifecycle of a document. Workflows can be used with all of the 
document types: document, record and offline. 

Workflows are created by the Library Administrator and associated with schemas (document 
type). The workflow must be initiated at the document level by a user of the system. The 
initiator can be any user with Document Publisher or higher permission and is a member of the 
document schema.  

Observers and participants are assigned to the workflow. Groups can be selected as observers 
of the workflows but only individual users can be participants. Participants are involved with the 
review and approval of the documents but observers do not participate; they can only observe. 

Once a workflow has been initiated, the first activity in the workflow begins. In the example 
below, the first activity for the participant is to review the document. Participants are notified by 
email or via their My Task list of any new task requiring attention. While the workflow is in 
progress, observers can watch over the workflow, modify, or reassign tasks. 

When all tasks in the activity are completed, the activity is considered complete and the next 
activity begins. On completion of the last activity, the workflow is considered complete. The 
time from workflow initiation to completion can be from hours to months to years depending on 
the process being managed.  

The basic elements and roles of users involved in a simple workflow can be seen in the 
diagram below. 
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6.2. MANUALLY INITIATING A WORKFLOW 

Initiating a workflow can be done by anyone with Document Publisher or higher permissions as 
long as they have access to the document(s). Once initiated, workflows are considered 
complete when all activities are completed, the workflow is canceled, or the document is not 
approved. 

Workflows can only be initiated on the latest version of a document and the file must be 
checked in. Workflows can be initiated manually on documents as soon as they are added to 
the system or they can be automatically initiated depending on how the schema was 
configured by the Library Administrator. See Automatically Initiating Workflows for more 
information. 

Users can only initiate workflows from the list of workflow templates that are associated with 
the document's schema. The templates are not created by the user; they are created by the 
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library administrator. However, the library administrator can create an “ad-hoc” template that 
leaves all fields to be defined by the initiator.  

You can have up to 20 activities (review or approve) in a workflow template. You can create 
workflow templates in both the Web Client and the FileHold Desktop Application (FDA). 

The following users and roles can initiate workflows: 

 The document version owner – The owner of the document version who has 
Document Publisher role or higher. If the user who owns the document is not the user 
who is initiating the workflow, enable the permission setting “Allow non document 
version owners to initialize workflows” in the System Administrator area. See the 
System Administration Guide for more information. 

 Cabinet owner – A Cabinet Administrator can initiate a workflow on any cabinets that 
they have ownership of. 

 Senior Library Administrator or higher role –Can initiate a workflow on any documents 
in the system. 

If someone other than the document owner initiates the workflow, the document owner may be 
an observer if the Library Administrator has configured the workflow to allow this in the 
template. For more information on creating workflow templates, see the Library Administration 
Guide. 

Workflows cannot be initiated on the following files in the document management system: 

 A document with an existing workflow instance associated with it. 

 Documents with a status of “checked out”. 

 Shortcuts to documents located elsewhere in the document management system. 

 The user does not have correct permissions to initiate the workflow. 

TO INITIATE A MANUAL WORKFLOW ON A SINGLE DOCUMENT 

1. Right-click on a document that is associated with a schema workflow and select Workflow 
> Initiate Workflow name.  

NOTE: The if the document is not associated with a schema with a workflow template 
applied to it, this option will not be available. 

2. The workflow template opens. In the FDA, click on the coloured areas to expand and 
contract the different areas of the workflow template. The Web Client does not have a 
graphical view for the workflow templates. 
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3. If the Library Administrator created an ad-hoc workflow template, you may fill in some or all 
the following fields, depending on how the administrator configured the template: 

Field Description 

Workflow Name The workflow name is set by the Library Administrator when 
creating the workflow template. This name can be modified if 
configured.  

Renaming the workflow is useful since the My Tasks list and 
Workflow Status report displays the workflow name instead of 
individual document names. If the workflow template name is not 
altered, then several workflows with the same name appear in the 
views. 

Workflow Description  Description of what the workflow is designed to accomplish. This 
is usually set by the Library Administrator. 

Hide This Version of the 
Document until it is 
Approved  

When selected, it hides the version of the document that is 
undergoing a workflow process. Only those participants, initiator, 
document owner, Library Administrator, and observers in the 
workflow can see the document in the Library. 
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Field Description 

Email Notification  Defines the number of days before an activity becomes overdue. 
An email is sent to the person responsible for completing the 
task. Enter the number of days or hours before a task is overdue 
to send the email. 

To repeat the overdue task email notification after a specified 
period of time, enter the number of hours to resend the email. For 
example, if 8 hours is entered, an overdue email will be sent 
every 8 hours until the task is complete.  

If the repeat value is left empty then the notification will only be 
sent once.  

Observers  Designated users that are allowed to observe the workflow as it 
proceeds. Observers will be able to view the ongoing status of a 
workflow from their status report. Observers are not participants 
and have no tasks to complete.  

Depending on how your Library Administrator has configured the 
workflow template, you may be able to set the observers for the 
workflow. Click the … button to select the users or groups to 
observe the workflow. 

Allow document version 
owner to observe the 
workflow 

When selected, allows the document owner to observe but not 
participate in the workflow process. 

Workflow Activity and 
number 

States the activity type (review document or approve document) 
order in which the activities are performed. This order can be 
changed using the drop down list.  

If allowed, an activity can be removed from the workflow template 
by clicking the red X.  

Reviewers/ Approvers Reviewers are those tasked with looking over a document for 
completeness and accuracy.  

Approvers are those tasked with actually approving the document 
for organizational use. 

Depending on how your Library Administrator has configured the 
workflow template, you may be able to set the 
reviewers/approvers for the workflow. Click the … button to select 
the users and/or groups to approve or review the document in the 
workflow. 

When adding groups to an activity, it will be expanded to 
individual users when initiating a workflow. Adding or removing 
users from a group will not affect existing workflows. 

Include Document Version 
Owner 

Includes the document version owner as a participant in the 
activity. If this option is selected, the list of participants can be left 
empty. 

Include Workflow Initiator 
Includes the workflow initiator as a participant in the activity. . If 
this option is selected, the list of participants can be left empty. 
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Field Description 

1 of X 
If only one of the participants is required to approve or review the 
document, select the 1 of X check box. For example, if only 1 out 
of the 5 participants is required to approve the document. The 
first person to complete the task will void and remove the task 
from all other participants. Users can first reserve the task. See 
Reserving a Task in a Workflow for more information. 

Force Reservation 
When enabled, it forces one of the participants in the task to 
“reserve” the task. When this option is enabled, it is not possible 
to submit a review or approval without first reserving the task by a 
single participant. While a document is “reserved” no other 
participants in the activity will be able to complete the task. 

If this option is not enabled, a task can still be reserved but the 
participant is not forced to prior to completing the activity.  

The first person to reserve and complete the task will void the 
task for all other participants. See Reserving a Task in a 
Workflow for more information. 

Note that this option is only available if the 1 of X check box is 
enabled.  

Allow Check Out 
When enabled, allows the participants in the workflow activity to 
check out the document.  

In order for this option to be available on the workflow template, it 
must be enabled in the System Administrator > Permission 
Settings area. 

The review or approval cannot be completed while a document in 
the activity is checked out; the document must be checked in 
before a review or approval can be submitted. When the 
document is checked in as a new version, the version number is 
increased and becomes the version associated with the workflow. 

If the 1 of X option is selected on the template, then the task is 
automatically reserved when it is checked out. The task remains 
reserved even when the document is checked in so the user can 
complete the approval or review task. See Reserving a Task in a 
Workflow for more information. 

Due by  
In the Due By field, enter the number of days or hours after 
workflow initiation that the approval or review is due. For 
example, it the task is due in 2 days from now, enter 2 in the days 
field. If the task is due in the next 2 hours, enter 0 in the Days 
field and 2 in the Hours field. 

Alternatively, to enter an exact date and time that a task must be 
completed select the Fixed Date and Time check box and enter 
a date and time in the field.  

The Due date is calculated when the workflow is launched, so this 
field should be configured for the number of days or hours from 
launch that the first task will be due. 

Task Instructions Any specific instructions to be included for the participant. 
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4. Click OK. A message will display confirming initiation of the workflow. 

6.2.1. Initiating a Workflow on Multiple Documents 

In some workflow instances, multiple documents may need to be either reviewed or approved 
together as a “package”. In this case, multiple document workflows can be used. Multiple 
document workflows must be initiated manually. Once a group of documents are selected, a 
workflow can be initiated to create a single workflow instance. In order for the workflow 
initiation to be successful, all of the documents must meet all the requirements such as 
belonging to a schema that uses the same workflow template and must be accessible by all 
participants listed in the template.  

When a workflow is initiated on multiple documents, these documents are called the “main 
documents” meaning that all the documents in the package must be approved and/or reviewed 
together. Main documents can have only one active workflow at a time; they cannot be in 
another active workflow. Once the documents in the package have been reviewed and/or 
approved, all of their statuses are changed to the same status such as “reviewed” or 
“approved”.  

Main documents can be added or removed from the workflow after it has been initiated. 
Notifications are sent to workflow participants when documents are added or removed from the 
workflow. If a document is removed, the approval status is changed to “Not submitted for 
approval” and the effect of the “Hide last version…” setting (if applicable) is removed from the 
document. Documents that have been checked out under the workflow cannot be removed. 

Multiple document workflows can also have “supporting documents”. Supporting documents 
are added to the workflow instance to assist in the review and/or approval process of the main 
documents. Supporting documents do not have their status changed, the Sign Off Sheet is not 
updated, and they are not affected by the “Hide last version…” setting. Supporting documents 
can be added or removed from an existing workflow after the workflow has been initiated for 
the “main documents”. A supporting document can participate in multiple active workflows; 
however, it has to be a supporting document. It cannot be a main document in another 
workflow. A supporting document cannot be checked out or deleted while under the workflow 
process.  

An example workflow on multiple documents and supporting documents is displayed below. 
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Document Reviewers

Document Approvers

All main documents statuses are 

changed to “Approved”

The status for all supporting 

documents remain unchanged

ü ü ü 
Main documents

Workflow initiator adds supporting 

documents to the workflow. Supporting 

documents assist in the review or 

approval of main documents.

Main documents

Workflow initiator initiates a review and 

approve workflow on 3 documents 

simultaneously

Supporting 

documents

Supporting 

documents

Supporting 

documents

Main documents move together 

through the workflow as a “package”

Observers

Supporting 

documents

Document reviewers review 

main documents and mark as 

Reviewed. Supporting 

documents are viewed but not 

marked as reviewed.

Document approvers approve 

main documents and mark as 

Approved. Supporting 

documents are viewed but not 

marked as approved.
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TO INITIATE A WORKFLOW ON MULTIPLE DOCUMENTS 

1. Select all of the documents to go through the workflow as a “package”. You can locate the 
documents through a search, a virtual folder, My Favourites, document tray, etc. 

 In the FDA, use the CTRL + click or SHIFT + click to select multiple documents. 

 In the Web Client, select the check boxes next to the document names. 

 Remember that all documents in the package are reviewed and approved together 
as a single unit. All documents are considered “main documents”. 

2. Do one of the following 

 In the FDA, right-click and select Workflow > Initiate Workflow template name. 

 In the Web Client, select Initiate Workflow from the menu bar and select the 
template name from the list. 

 Remember that all documents must have the same workflow template as a part of its 
schema. If all documents do not have the same workflow template in their schemas, 
then an error message appears stating that the workflow cannot be initiated.  

3. The workflow template opens. In the FDA, click on the coloured areas to expand and 
contract the different areas of the workflow template. The Web Client does not have a 
graphical view for the workflow templates. 

4. Depending on how the workflow template is configured, you may be able to modify some 
or all of the template details. See the table in Manually Initiating a Workflow for information 
on the template details. Click OK to start the workflow. 

5. You will receive a message stating that the workflow has been successfully initiated. Click 
OK. 

6.2.2. Adding or Removing Main or Supporting Documents from a Workflow 

Documents can be added or removed from an active workflow. Documents can be added as 
“main” or “supporting” documents. Main documents are all the documents in a “package” must 
be approved and/or reviewed together. Supporting documents can be added to the workflow 
instance to assist in the review and/or approval process of the main documents. 

Documents can be removed from the “Documents associated with workflow template name” 
pane. Documents that are checked out cannot be removed from the workflow. Once the 
document has been removed, the approval status changes to “Not submitted for approval” and 
the effect of the “Hide all versions…” flag is removed.  

The following users and roles can add and remove main and supporting documents in 
workflows: 

 Workflow initiator – The workflow initiator who has Document Publisher role or higher 
and has access to all existing main documents. 

 Cabinet owner – A Cabinet Administrator that has ownership of the cabinets where all 
the documents in the workflow are stored. 

 Senior Library Administrator or higher role 

When adding documents to existing workflows: 

 The workflow template associated with the documents must be associated with the same 
workflow template used to initiate the workflow in its schema. 

 All observers and participants must have access to the document.  

 Only the last version of the document can be added to a workflow.  

http://www.filehold.com/help/workflow/hide-document-until-approved
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 If adding a main document, then the document cannot be associated with another 
workflow.  

 When adding a supporting document, it cannot be checked out or deleted after it has been 
added.  

TO ADD A MAIN OR SUPPORTING DOCUMENT 

1. Select one or more documents to add to the workflow. 

2. Right-click on the documents and select Workflow > Add to Existing Workflow. 

 Alternatively, in the Web Client select Send To > Existing Workflow from the menu 
bar. 

3. In the “Add Documents to Existing Workflow" window, select the workflow that you want 
to add the documents to from the list of existing workflows. 

4. Select one of the following options and click OK: 

 Main documents that are reviewed or approved in the workflow – The selected 
documents are added to the existing workflow “package” as main documents and will 
be reviewed and/or approved along with the other main documents.  

 Supporting documents associated with the workflow – The selected documents are 
added to the existing workflow to assist in the review and/or approval of the main 
documents. 

5. The documents are added to the existing workflow and can be seen in the “Documents 
associated with workflow template name” window as Main and/or Supporting documents.   

 

TO REMOVE A MAIN OR SUPPORTING DOCUMENT 

1. Go to My Tasks or the Workflow Status Report and click the Show Documents link for 
the workflow you want to remove documents from.  

2. In the “Documents associated with workflow template name” window, select the 
document to be removed and click Remove.  

3. At the message prompt, “Are you sure you want to remove the selected documents from 
the workflow template name?” click OK. The document is removed from the active 
workflow.  

6.2.3. Automatically Initiating Workflows 

Workflows can be automatically initiated depending on the configuration of the workflow 
template. This removes the manual step of initiating a workflow for a document. 

See the Library Administration Guide or Knowledge Base for more information. 

http://www.filehold.com/help/home
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6.3. MY TASKS LIST – VIEWING WORKFLOW TASKS 

A list of all workflow tasks assigned to a specific user is accessible to them through the 
document management system by selecting Review and Approvals > My Tasks from the My 
FileHold area. 

 

There are two types of activities supported by the FileHold: the document approval activity and 
the document review activity. The My Tasks list shows all active review or approval tasks 
assigned or delegated to the user. Previously completed or cancelled tasks do not appear in 
the list. Once a workflow is initiated, an email will be sent to the user (if configured) notifying 
them of a workflow task.  

 

From the My Tasks list, you can: 

 Submit a review or approval. 

 Cancel the workflow. 

 Delegate a task to another user. 

 Reserve or undo a reservation for a task. Tasks that can be reserved are marked with an 
asterisk *. 

 See the documents that are a part of the workflow (Show Documents link). 

 Get a local copy of the document under review or approval (in the “Documents associated 
with workflow name” pane). 

 View the Status Report for the task (View Workflows). 

 Check out a document (in the “Documents associated with workflow name” pane). 

6.3.1. Approving Documents 

The approval activity is designed to facilitate the formal collection of signatures / approvals for 
an individual file version. When approving documents, there are three options when completing 
the task: 

 Approve  

 Do not approve 

 Postpone approval 

For documents to be considered “approved” it must pass through a workflow with at least one 
Approval activity and must be approved by all participants in all activities in the workflow. Only 
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the version of the document that is going through the workflow process is marked as 
“approved”. 

If one of the participants of the approval activity “does not approve” the document(s), then the 
workflow is automatically terminated. This can happen at any step along the way in a workflow. 
For example, a file can pass through a first approval activity only to be rejected during a 
second approval activity. If the participant in the second activity rejects the document the 
activity is terminated, the workflow is terminated, and the document is flagged as "not 
approved". 

If a version of a document has been marked as “Not Approved”, the system does not allow a 
workflow to be done on the same document version. Instead, a new version of file will have to 
be added to the system and the workflow re-initiated. The document needs to go through the 
entire workflow process before it can be considered approved and complete. Alternatively, the 
workflow can be restarted on the same version by an initiator or administrator. See Restarting 
Workflows for more information.  

There are situations where a document cannot be approved because some conditions have 
not been met but there is nothing wrong with the document itself. An option called “Postpone 
Approval” can be used in these conditions. Once the “postpone approval” option is selected, 
the workflow is immediately terminated and the status of the document will be set to “Approval 
Postponed”.  

A document under a workflow approval process can be checked out by a participant if 
configured in the workflow template. The approval task cannot be completed while a document 
in the activity is checked out and the document must be checked in before the approval can be 
submitted.  

A feedback document can be attached to any of the approval options. A feedback document is 
a separate document from the document being approved. It can contain comments or 
supplemental information. It can be seen in the Workflow Status Report, Review and Approval 
History (by administrators), and Sign Off Sheet. 

Once an approval is submitted, you need to enter your password to confirm your selected 
option. This is akin to an electronic signature.  

If it is a multiple document workflow, then the approval option selected is applied to all main 
documents. See Initiating a Workflow on Multiple Documents for more information.  

TO APPROVE A DOCUMENT  

1. Go to Reviews and Approvals > My Tasks and select a workflow where the task is set to 
Approve. 

2. In the FDA, click Submit Approval from the menu bar or right-click on the task and select 
Workflow > Submit Approval. 

 In the Web Client, select the check box next to the task name and click Submit 
Review/Approval from the menu bar. 

3. In the Submit Approval window, select one of the following options: 

  I Approve This Document  The document(s) status changes to “Approved”. 

 I Do Not Approve This Document  The document status changes to “Not 
Approved” and the workflow is terminated. 

 I Postpone Approval of This Document  The document status changes to 
“Approval Postponed” and the workflow is terminated. 

4. Enter any comments if desired. 

5. If desired, attach a feedback document. Click Browse to locate the file.  
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6. To remove the local copy of the feedback document, select the Remove the local copy… 
check box.  

7. Click OK.  

8. In the Please Enter Your Password window, enter your FileHold password. You must 
enter your password to approve, postpone or not approve the document and click OK.  

  

NOTE: If you log in to FileHold using a domain (Microsoft Active Directory), enter the same 
password for logging into your network. 

9. The task is removed from the My Tasks list. If the document was approved and there is 
another activity in the workflow, then the task moves to the next assigned participant. If the 
document was not approved or postponed, then the workflow is terminated.  

6.3.2. Reviewing Documents 

The review activity is designed to facilitate the collection of comments and feedback on a file(s) 
from other users. The review activity can be used alongside one or more review or approval 
activities. Unlike the approval activity, the review activity does not have the same rules for 
activity termination. The review approval activity is considered complete once all participants 
have completed the task of reviewing the document and providing comments and/or feedback 
documents. 

Once a review activity is initiated, the document tasks are automatically routed to the 
participants and appear in their My Tasks list. Email notification can also alert users when they 
are assigned a new task of reviewing a document.  

As the activity progresses, participants complete their review tasks by providing comments 
and/or attaching feedback to the file. All comments and feedback files are routed back to the 
initiator so they can get the feedback they need to continue working on the document. 
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Documents that are under a workflow can be viewed and/or checked out during the review 
process (if configured). .The review task cannot be completed while a document in the activity 
is checked out and the document must be checked in before a review can be submitted. 

When all participants complete all of the review tasks the activity is completed. The next 
activity in the workflow will then begin. If this is the last activity in the workflow the workflow will 
be marked as complete. 

If it is a multiple document workflow, then the review status is applied to all main documents. 
See Initiating a Workflow on Multiple Documents for more information. 

TO REVIEW A DOCUMENT IN FDA OR WEB CLIENT 

1. Go to Reviews and Approvals > My Tasks and select a workflow where the task is set to 
Review. 

2. In the FDA, right-click and select Workflow > Submit Review. 

 In the Web Client, select the check box next to the task and click Submit 
Approval/Review. 

3. In the Comments field, enter your comments for the document.  

4. To attach a document containing additional feedback, click Browse to add the file. 

5. Select the Remove the local copy of this file after my review feedback has been 
successfully sent check box if applicable. 

 

6. Click OK. The task is removed from your My Tasks list. If there is another activity in the 
workflow, then the task moves to the next assigned participant. 

6.3.3. Using Microsoft Office Applications for Workflow Tasks 

The integration with FileHold allows users to fully interact with their files with Microsoft Office 
applications. FileHold supports the completion of workflow tasks from the following Microsoft 
Office applications - Word, Excel, PowerPoint, Outlook, Visio, and OneNote 2010. 
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The FileHold Add-Ins toolbar allows you to get a copy of the document or check out a 
document that is under a workflow. You can also attach the current Microsoft Office document 
as a feedback document for a workflow task and approve/review the document at the same 
time.  

TO GET A COPY OR CHECK OUT A DOCUMENT UNDER WORKFLOW FROM THE ADD-INS TOOLBAR 

1. In a Microsoft Office application, go to the Add-Ins toolbar and click Browse . 

2. Go to My Tasks list. 

3. Right-click on the workflow instance and select Show Documents. 

4. Select the document name from the list and select click of the following options: 

 Get a Copy – Opens a copy of the document in the associated application. 

 Check Out – Checks out and opens the document in the associated application. The 
document is locked down and the workflow task cannot be completed until the 
document is checked back in. See Checking Out a Document for more information. 

TO ADD A MICROSOFT OFFICE DOCUMENT AS A FEEDBACK DOCUMENT 

1. Create and save the feedback document locally.  

2. Click Send to FileHold > Send Review / Approval Feedback in the FileHold Add-Ins 
toolbar. 

3. Select the document that you are reviewing or approving in the list and click OK. 

4. If you are submitting a review, enter your comments, attach a feedback document, and 
select any of the options and click OK. See more about reviewing documents.  

 Select the Use Active Document check box to use the file that is currently being 
edited to be attached as a feedback document. 

5. If you are approving a document, select whether you approve, not approve or postpone 
approval on the document(s), enter a feedback document, and select any of the options 
and click OK. See more about approving documents. 

 If you select the Use Active Document check box, the file that the user is currently 
editing will be attached as a feedback document. 

6. Select the “Close this document after my approval…” check box to close the document 
in the associated application. 

7. Select the “Remove the local copy…” check box to delete the local copy of the feedback 
document. 

8. Click OK. The document is attached as a feedback document and the task is marked as 
complete. 

6.3.4. Reserving a Task in a Workflow 

When a Library Administrator creates a workflow template, they can decide if only one out of a 
group of participants needs to complete a task using the 1 of X check box in the template. For 
example, a sales group consisting of four users is added as the participants in a review task 
but only one person on the team needs to complete the review the document. 

If only one person has to complete the task (1 of X option is selected), then the option to “force 
the reservation” of a task is available. Participants may be forced to “reserve” a task in a 
workflow depending on how the template was configured. If enabled, this enforces that one 
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user out of the group of participants must reserve the task before the task can be reviewed or 
approved and the task completed.  

If the “force reservation” setting is not enabled in the template, then the task can be completed 
without a reservation; however a reservation can still be made for the task. The first person to 
complete the task with or without reserving it automatically voids the task for all other 
participants in the activity.  

Once a task is reserved by a single participant, the task is removed from the My Task list for all 
other participants in the activity. The status for the user who has the task reserved becomes 
“Reserved” until the review or approval process is complete. The status for the remaining 
participants who did not reserve and complete the task becomes “Voided”. If a task is reserved 
by another participant, a notification email will be sent to all other participants. 

In the workflow status report and My Tasks list, tasks that can be reserved are shown with an 
asterisk. If a task needs to be or can be reserved, the Reserve/Undo Reservation button is 
available from the My Tasks and Workflow Status Report. If the “force reservation” setting is 
enabled in the template, then the task must be reserved before it can be approved or reviewed.  

Other reservation rules include: 

 A future task cannot be reserved.  

 A reserved task cannot be overridden or delegated.  

 An administrator can reserve or undo a reservation for another user.  

A task can be reserved if you have been assigned a task, or if you are a senior library 
administrator or higher. A cabinet administrator can reserve a task for a user if they have 
ownership of the cabinet where all of the main workflow documents reside.  

For more information on creating workflow templates, see the Library Administration Guide. 

See the table below for a summary of the rules on the 1 of X and Force Reservation settings in 
a workflow template. 

Workflow Template Settings Effect on Workflow 

Workflow Template

1 of X
ü 

Force Reservation

 

 Only one participant in a group of participants in the 
activity can complete the task. 

 Participant may “reserve” the task but is not forced 
to; the task can still be completed without the 
reservation. 

 First participant to complete the task voids the task 
for all other participants. The task is removed from 
their task list. 

 The activity is considered complete after a single 
participant completes the task.  

If the participant reserves the task even though it is 
not enforced: 

 Only the participant who reserved the task can 
complete the task. 

 The status of the task changes to “Reserved” for the 
participant who reserved it. 

 The status of the other participants who did not 
reserve the task changes to “Blocked”. 

 The participant who reserved the task can undo the 
reservation which frees the task for the other 
participants to complete. 
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Workflow Template

1 of X
ü 

Force Reservation
ü 

 

 Only one participant in a group of participants in the 
activity can complete the task. 

 A participant must reserve the task before the task; 
the task cannot be completed without the 
reservation. 

 First participant to reserve the task voids the task 
for all other participants. The task is removed from 
their task list. 

 The activity is considered complete after the single 
participant reserves and completes the task.  

If the participant reserves the task: 

 Only the participant who reserved the task can 
complete the task. 

 The status of the task changes to “Reserved” for the 
participant who reserved it. 

 The status of the other participants who did not 
reserve the task changes to “Blocked”. 

 The participant who reserved the task can undo the 
reservation which frees the task for the other 
participants to complete. 

 

TO RESERVE A TASK 

NOTE: You may be forced to reserve a task prior to being able to complete the task. Check the 
workflow template to see if the “Force Reservation” setting is enabled. 

1. Do one of the following: 

 From My Tasks, select task that you want to reserve and click Reserve/Undo 
Reservation. Tasks that can be reserved are marked with an asterisk (*). 

 From Workflow Status Report, select task that you want to reserve and click 
Reserve/Undo Reservation. Tasks that can be reserved are marked with an 
asterisk (*). Only current tasks can be reserved, future tasks cannot. 

2. A message appears asking if you are sure that you want the reservation. Click OK. The 
status for the participant who reserved the task becomes “Reserved”. The task is removed 
from the My Tasks list of the other participants and their status changes to “Blocked”.  

3. After reserving the task, the task can be completed as normal (mark as 
reviewed/approved). After the task is completed, the status for all other participants 
changes to “Voided”. 

TO UNDO A RESERVATION 

1. Select the task that you have reserved from the My Tasks or the Workflow Status Report. 
The status of the task should be “Reserved”.  

2. Click Reserve/Undo Reservation.  

3. A message appears asking if you are sure that you want to undo the reservation. Click 
OK. The task is now unblocked for the other participants and reappears in their My Tasks 
list. The task can now be reserved by another participant in the activity. 
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6.3.5. Checking Out a Document Under the Workflow 

A document under a workflow process can be checked out by a participant in the active 
workflow activity. Once a document has been checked out by a participant, it is locked down 
and cannot be checked out by another participant until the document has been checked back 
in.  

The review or approval cannot be completed while a document in the activity is checked out 
and the document must be checked in before a review or approval can be submitted. When the 
document is checked in as a new version, the version number is increased and becomes the 
version associated with the workflow.  

If the 1 of X option is selected on the template, then the task is automatically reserved when it 
is checked out. The task remains reserved after the document is checked in so the user can 
complete the approval or review task.  

In order to use this feature, a permission setting in the System Administrator area must be 
enabled. See the System Administration Guide for more information. The option “Allow Check 
Out” must be enabled in the workflow template for each activity in order for a participant to 
check out a document. If the option is not enabled in the template, then none of the documents 
in the workflow can be checked out for that activity. 

In order to see if any documents have been checked out in the activity, click the Show 
Documents link from the My Tasks or Workflow Status Report. The status of the document is 
“Checked out” in the documents list. 

TO CHECK OUT A DOCUMENT UNDER A WORKFLOW 

1. Go to My Tasks or the Workflow Status Report and click the Show Documents link for the 
workflow that you want to check out a document from. 

2. In the “Documents associated with workflow template name” pane, select the document to 
be checked out. 

3. In the FDA, right-click on the document and select Check Out This Document. 

 In the Web Client, select the check box next to the document name and click Check 
Out. 

4. Browse for the folder to check out the document to (if required) and click OK. 

5. A message stating that the document is checked out opens. Click OK. The activity is now 
locked down and cannot be completed (approved/reviewed) until the document is checked 
back in. When the document is checked in, the workflow is associated with the new 
version.  

TO CHECK IN A DOCUMENT UNDER A WORKFLOW 

1. Go to My Tasks or the Workflow Status Report and click the Show Documents link next 
to the workflow name for which you want to check in a document. 

2. In the “Documents associated with workflow template name” pane, select the document to 
be checked in. 

3. In the FDA, right-click on the document and select Check In This Document. 

 In the Web Client, using the context sensitive menu, select Check In Document. 

4. Select one of the following options and click Check In: 



End User  Guide  F i leHold 14  

February 2014  39 

 Undo Check-out. I have not made any changes. 

 Edit Metadata for this document after check-in. 

 Delete the local copy of the file after it has been successfully checked in (FDA). 

 Email notify all folder members that this document has been Checked-In. 

6.3.6. Get a Local Copy of the Workflow Document 

You can save a copy of the document under the workflow process to your local computer. Note 
that getting a copy of the document does not check out the document. To check out the 
document, complete the check out process. 

TO GET A LOCAL COPY OF THE WORKFLOW DOCUMENT 

1. Do one of the following: 

 In the FDA, from My Tasks or Workflow Status Report, click the Show Documents 
link. In the “Documents associated with workflow template name” window, select the 
document. Right-click on the document and select Get a Local Copy. 

 In the Web Client, from My Tasks or Workflow Status Report, click the Show 
Documents link. In the “Documents associated with workflow template name” 
window, select the check box next to the document name and click Get a Copy. 

2. In the FDA, if prompted, select the location to save the document and click OK. The 
document is copied to that location. 

 In the Web Client, the document is downloaded to the browser’s download folder. 

6.3.7. Restarting a Workflow 

Workflows can be restarted on: 

 An active workflow from the first activity to the current one. 

 A completed workflow that has been marked as “not approved” or “approval postponed” 
from the first activity to the one that was marked as not approved or postponed. 

Workflows can be restarted by: 

 Workflow initiator 

 Senior library administrator or higher 

 Cabinet administrator if they have ownership of the cabinet where all of the main workflow 
documents reside. 

If the workflow is restarted, the current workflow is cancelled (if not already completed) and 
displays the Restarted status. A new, identical workflow is started and the previous activities 
are copied from the original workflow including feedback documents and comments. The name 
and date/time of the original workflow is appended to the description area of the new workflow 
template. 

Workflows are restarted in the workflow status report.  

TO RESTART A WORKFLOW 

1. In the workflow status report, select the activity to be restarted. It can be an active or a 
completed workflow that was marked as not approved or approval postponed.  
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2. Click Restart Workflow.  

3. Click OK at the alert message. 

4. A new workflow is started with notifications being sent to the participants. The old 
workflow instance status changes to “Restarted” and a new workflow instance is created. 
The old workflow name and date/time is appended to the description in the new workflow 
template details. 

 

 

6.3.8. Delegating Tasks to Another User 

Task delegation is a critical component of any workflow system as it allows work to continue to 
flow if a participant is either too busy or unavailable. Once delegated, the user will be notified of 
their new tasks.  

A task cannot be delegated if it has been reserved. A future task can be delegated. 

You can automatically delegate all tasks assigned in the event of vacation or extended 
unavailability. Learn more about setting up automatic task delegation in the workflow 
preferences. 

TO DELEGATE A TASK TO ANOTHER USER 

1. Go to Reviews and Approvals > My Tasks or Workflow Status Report. You can 
delegate tasks from either location. 

2. Select the task that you wish to delegate and click Delegate Task. 

3. Enter the first or last name or email address of the person you want to delegate the task to 
and click Find.  

4. In the Search Results, select the user and click Select User(s). 

5. The task is now updated for the delegated task. In the Workflow Status Report, you can 
see who the task has been delegated to and who it is on behalf of. 
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6.3.9. Cancelling Workflows 

A workflow can be cancelled by the person who initiated it or by a Library or System 
Administrator. Cancelling a workflow terminates the workflow immediately and notification 
emails are sent to all participants. See Workflow Notifications for more information. 

TIP: Workflow approvals are automatically terminated if a workflow is marked as not approved 
or approval postponed by a single participant.  

TO CANCEL A WORKFLOW INSTANCE 

1. Do one of the following: 

 In the FDA, select the workflow name from My Tasks or Workflow Status Report. 

 In the Web Client, select the check box next to the workflow name from My Tasks or 
Workflow Status Report. 

2. Click Cancel Workflow. All participants in the workflow that had tasks assigned to them 
will have the tasks automatically removed from their Task List. If they have set preferences 
to alert them of cancelled tasks by email, an email will be sent.  

6.3.10. Viewing the Workflow Status Report for a Single Task 

You can view the workflow status report for a single task from the My Tasks List. 

TO VIEW THE STATUS REPORT FOR THE TASK 

1. From the My Tasks list, select a task from the list and click View Workflows. 

2. The workflow status report is shown. Click Back to My Tasks to return to the task list. 

6.4. VIEWING THE SIGN OFF SHEET 

In the Sign-Off Sheet, you are able to view the list of participants that have either approved, not 
approved or postponed approval of the workflow document, when it was signed off, and if they 
have signed it off on behalf of someone else. If the status is “Voided” this means that the task 
was reserved and completed by another participant.  

The sign off sheet can be viewed from the: 

 Folder list 

 Search results 

 Workflow status report > Show Documents link 

 Version History 

 My Tasks > Show Documents link 

TO VIEW THE SIGN OFF SHEET 

1. In the FDA, right-click on the document and select Workflow > View Sign-Off Sheet.  

 In the Web Client, click the down arrow on the document name and select Sign Off 
Sheet. 

2. The Sign-Off Sheet pane appears below. Click X to close the pane. 
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6.5. WORKFLOW STATUS REPORTS 

The Workflow Status Report shows the status of all workflows that are occurring in the system 
that the user is the initiator of, a participant in, or an observer. The report shows the tasks from 
all activities, including those that have not yet started (future tasks). Users can access the 
Workflow Status Report by clicking on the Reviews and Approvals > Status Report. 

 

In Reviews and Approvals Status Report pane, all of the workflows that you are involved in are 
shown. The workflow name, the number of main documents and supporting documents 
involved with the workflow, the initiator, the start and due dates, the percent completed, and 
the status of the workflow. The possible statuses of a workflow are: 

 Pending Approval (In progress) – When the workflow is in progress. 

 Completed – If the workflow is completed the final approval or review status is shown. 
(Approved, Not Approved, Approval Postponed, or Reviewed). 

 Cancelled – If the workflow has been cancelled, the status of Cancelled is shown. 

The number of main and supporting documents in the workflow is shown in the workflow 
summary line. To view all of the documents that are involved in the workflow, click the Show 
Documents link. The documents appear in the “Documents associated with <workflow 
template name>” window. The documents are listed by main or supporting document types. 
See Multiple Document Workflows for more information. From here, documents can be 
checked out, emailed, viewed, downloaded, or deleted. 

 

Click the View Details link to review the workflow template details. If you are using the FDA, 
click on the coloured areas to expand and contract the different areas of the workflow template. 

Under each workflow name, click on the + or > symbol to view all the activities in the workflow. 
The activity order, type (review or approval), the participant, on behalf of (if the task was 
delegated), comments, attachments, start date, due date, and completion date, the percent (%) 
completed, and if the task status. The possible statuses of a task are: 

 In Progress (Blank) – If the task is in progress, then the status is blank (empty). 

 Future (Blank) – If the task is in the future, then the status is blank (empty). 

 Cancelled – The workflow has been cancelled. 

 Overridden – The workflow task has been ignored and no action is taken. The workflow 
completed or moved on to the next activity in the workflow. 

 Voided – The task was reserved and completed by another participant. The task was 
removed and voided from all other participants. 

 Reserved – The task is currently reserved by a participant. 

 Blocked – The task is currently reserved by another participant thereby blocking all other 
participants from the task.  
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An asterisk (*) appears next to the participant’s names’ for all tasks that are available to be 
reserved in the Workflow Status report.  

 

To view comments that a participant has left for a document, double-click on Comments link. 
The Comment Details window displays the comments from that participant and task. 

 

To download a copy of the feedback document, click the Save icon in the Attachments 
column. In the FDA, select the location to save the feedback document and click Save. The 
document is downloaded to that location. In the Web Client, the feedback document is saved to 
the browser’s default download location. 

From the workflow status report, you can take the following actions on a task: 

 Show Documents (link) – Opens the documents associated with the workflow (main 
documents and supporting documents) in a separate window. 

 View Details (link) — Displays the workflow template. 

 Restart a Workflow – Select the completed activity from where to restart the workflow from. 
Workflows can be restarted on not approved, approval postponed, or an active workflow. 
Workflows marked as completed and approved cannot have their workflows restarted. 

 Rename Workflow – To rename the workflow instance, select the workflow from the list 
and click Rename Workflow. Enter the new workflow instance name and click OK. 
Workflows can only be renamed by the initiator or senior administrator if the “allow initiator 
to define” option has been enabled in the workflow template. 
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 Cancel a Workflow — Allows you to cancel the workflow. Confirm the cancellation by 
clicking OK at the message prompt. 

 Clear Completed — Removes the completed workflows from the list. 

 Clear Cancelled — Removes the completed workflows from the list. 

 Reserve/Undo Reservation – Allows you to “reserve” or undo the reservation for the 
selected task. Once a task is reserved by a participant, it prevents all other participants 
from completing the task and is removed from their task list. The status of the user who 
reserved the task is “Reserved”. The status of the other users is “Blocked”. Once the task 
is completed by the participant that reserved the task, the statues changes to “Reviewed” 
or “Approved” and the status for all other participants is “Voided”. If the reservation for the 
task is undone, then the task is available to all participants again. This function is available 
only if the option Force Reservation is enabled in the workflow template. See Creating 
Workflow Templates for more information. An asterisk (*) appears next to the participant’s 
names’ for all tasks that are available to be reserved in the Workflow Status report.  

 Override Task— Overrides a task or activity by moving it to the completed state without 
affecting the rest of the workflow. Use this feature when a workflow member is absent and 
the workflow needs to be completed. See Overriding Workflow Tasks for more information. 

 Delegate Task — Delegates a task to another user. Expand the workflow by clicking > next 
to the workflow name to select a task to delegate and click Delegate Task. In the Find 
People window, enter a name or email address and click Find Now. In the Search Results, 
select the user and click Select Users. A message stating the task delegation was 
successful appears. Click OK. A task that is marked as “Reserved” cannot be delegated. 
Future tasks can be delegated.  

 Print (FDA Only) – Prints an exact match of what is displayed on the screen. 

 Export (FDA Only) – When exporting the report, you can choose to export only the 
workflow or you can include both the workflows and the tasks. The report can be exported 
to CSV or HTML. Note that for the HTML report, the workflow must be expanded in the 
Workflow Status Report results to print the tasks. In other words, the HTML report will be 
exported to look exactly how it appears on the screen.  

To scroll through the workflows or to increase the number of workflows shown on the screen in 
the Web Client, use the controls at the bottom of the report. 

  

6.6. VIEWING THE REVIEW AND APPROVAL HISTORY OF A DOCUMENT 

The document review and approval history is essentially a snapshot of the workflow status 
report but only for the selected document. You can view the workflow name, initiator, number 
of main documents, completion status plus all the activity information such as participant name, 
comments, attachments, status and so on.  

The document review and approval history can also be exported (CSV or HTML) or printed 
from the FDA.  
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TO VIEW THE WORKFLOW HISTORY 

1. From the My Tasks or Workflow Status Report, click Show Documents. The “Documents 
associated with <workflow template name>” pane opens. 

2. In the FDA, right-click on a document and select Workflow > View Review and Approval 
History. 

 In the Web Client, click on the arrow next to the document name and select Review 
and Approval History. 

3. The Document Review and Approval History is displayed. To print (FDA Only) an exact 
match of what is displayed on the screen, click Print. 

4. To export the history, click Export and select an option. When exporting the report, you 
can choose to export only the workflow or you can include both the workflows and the 
tasks. The report can be exported to CSV or HTML. Note that for the HTML report, the 
workflow must be expanded in the Workflow Status Report results to print the tasks. In 
other words, the HTML report will be exported to look exactly how it appears on the 
screen. 

5. To return to the previous screen, click Back to Folder. 

 

6.7. OVERRIDING WORKFLOW TASKS 

In some situations, tasks in a workflow need to be removed from the workflow in progress. 
Overriding a task removes the task from the workflow instance without affecting the remaining 
workflow tasks. When a task is overridden for a participant, the status of the task changes to 
“overridden”. In the case where a document is being approved by other participants, the 
remaining approvers determine if the document is “approved”. 

Overriding a task or activity is only available to the workflow initiator or administrators. A task 
cannot be overridden if it has been reserved. Completed tasks and activities cannot be 
overridden. A future task can be overridden. 

TO OVERRIDE A TASK  

1. Go to Reviews and Approvals > Workflow Status Report and select the workflow that 
you want to override. 

2. Click the + sign to view the workflow activities/tasks in the workflow. Select the task you 
want to override and click Override Task.  

3. The Override Workflow Tasks message opens stating that the task will be pushed to 
completion without affecting the rest of the workflow. Click OK. The status is updated to 
“Overridden”.  
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6.8. WORKFLOW NOTIFICATIONS 

You can receive workflow notifications to your email. These are set in the Workflow 
Preferences. See Workflow Preferences for more information.  
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7. SEARCHING 

You can find a document in FileHold using the powerful and robust search capabilities. There 
are three methods of searching for documents in FileHold: 

 FastFind — Use predefined hot-keys to search within FileHold from third party applications. 

 Simple Search —The Simple Search feature is a “Google-like” toolbar that uses a full-text 
search. FileHold has the ability to recognize, index text and allows users to search content 
of all your favorite document types including PDF, Microsoft Office, Zip and many more. 
When searching using the full text search, the system searches both the metadata 
associated and the content of the document for matches. Full text search is particularly 
useful for general searches of files stored in a records management system. For example, 
searching the system for all files that make reference to Sarbanes Oxley. 

TIP: In order to do partial word searches, you need to use a wildcard (*) before or after the 
word you are searching for.  

 FDA 

Web Client 

 Advanced Search — The Advanced Search allows users to use the metadata associated 
with a document to help locate the file. This is particularly useful when users have a 
specific piece of information they would like to search for. .Up to five search parameters 
can be used in an advanced search. 

 

7.1. HOW TO ACCESS SEARCH 

There are several methods in accessing the Search function. 

 Click Search, My Saved Searches, or Public Saved Searches in the Library Tree. Using 
Search will search all documents in the Library tree. 

 

 Using the “Google”-like search toolbar located in the top right of the window. Click the 
down arrow next to the search toolbar to access the Advanced Search screen. 

 

In FDA 
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In Web Client in a Folder View 

 Right-click on any area of the library and select Search. This restricts the search to that 
location in the Library. 

 

 From the simple search screen, click Advanced to access the Advanced Search screen.  

 

7.2. HOW FILEHOLD SEARCHES FOR DOCUMENTS 

Users can only retrieve documents to which they have access. Access is based on user rights 
and permissions. Therefore, in order for a user to see a document in their search results they 
would have to be a member of the cabinet, folder, and schema that the document belongs to. 

The following are how the document management system conducts searches for documents: 

 When using the operator “Contains”, it searches all metadata and content (full text 
indexing) of the documents.  

 It searches for whole words only. Partial words need wildcards (*, ?,) (think of “Google"). 

 Metadata searches will return the most relevant of results. Metadata searches also return 
faster search results as it searches the Microsoft SQL database only. 

 When the user invokes search functionality on a cabinet, drawer, folder group, or folder, 
the search will be restricted to the portion of the file structure from which the search was 
invoked. 

 The contents of the Library Archive are NOT included in the search. To expand the search 
to include the Library Archive, select the Include in Archive check box in the Advanced 
Search options. 

 Documents that have been deleted from the system are not included in the search. 

 Only the latest version of a document is searched. The document usage history and 
document version history are not included in the search scope. To expand the search to 
include all document versions, select the Include All Document Versions check box in the 
Advanced Search options. 

 My FileHold, Search, Saved Searches and Virtual Folders contents are not searched 
because these are links to documents and not where the documents reside. 

 Metadata field names that have been edited or deleted are not searched. To search using 
old metadata field names, select the Search Using Historical Metadata Fields check box in 
the Advanced Search options. 
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7.2.1. General Usage 

1. Avoid searching for two (2) letter words alone; instead use three (3) letter words or simply 
use a wild card  *  before or after the 2 letters. Two letter word searches are not searchable 
for several technical reasons: 

 The two letters you are searching for can appear in a portion of a word, or very commonly 
on their own, these if used in the search engine criteria, would greatly slow down and 
impede the performance of the FileHold search system. 

 In addition, they can also affect the quality of search results because they can appear 
inside a larger word or on their own with great frequency. This throws off search quality to 
unacceptable levels. The document management system is designed to ignore common 
words or characters as they tend to slow searches without improving the quality of the 
results. See the table below on Noise Words. 

 For example, if you wish to search for "AT" when you are looking for a document that 
describes "AT Commands for communicating with a cellular phone or communication 
hardware device", then we recommend using AT* Commands in the search bar. Use the * 
wildcard right after AT and before Commands. 

2. Use whole words when searching for words inside of documents. Simple search acts like a 
"Google" search and partial words may not return the results you are looking for or may not 
return any results. If you need to use partial words, use a wildcard (*, ?,) with the search. 

3. If you use a very generic search term, then the search engine may time out. Try to look for 
unique words or terms or limit the search to a specific area in the Library. 

7.2.2. Noise Words 

A noise word is a word such as "the" or "if" that is so common that it is not useful in searches. 
To save time, noise words are not indexed and are ignored in index searches. All single letters 
are ignored and include the list of words in the table below. 

Letter  Noise Words 

A  a, about, after, all, also, an, and, another, any, are, as, at 

B  be, because, been. before, being, between, both, but, by 

C  came, can, come, could 

D  did, do 

E  each,  even 

F  for, from, further, furthermore 

G  get, got 

H  had, has, have, he, her, here, hi, him, himself, how, however 

I  i, if, in, indeed, into, is, it, its 

J  just 

L  like 

M  made, many, me, might, more, moreover, most, much, must, my 

N  never, not, now 

O  of, on, only, or, other, our, out, over 



Fi leHold 14  End User  Guide  

50  February 2014 

Letter  Noise Words 

S  said, same, see, she, should, since, some, still, such 

T  take, than, that, the, their, them, then, there, therefore, these, they, this, those, 
through, thus, to, too 

U  under, up 

V  very 

W  was, way, we, well, were, what, when, where, which, while, who, will, with, would 

Y  you, your 

 

7.2.3. Search Requests 

FileHold supports different types of search requests: 

 An "any words" search is any sequence of text, like a sentence or a question. In an "any 
words" search, use quotation marks around phrases, put AND in front of any word or 
phrase that is required, and NOT in front of a word or phrase to exclude it. Note that the 
operators + and – are not supported. Examples include: 

 banana pear "apple pie" 

 "apple pie" NOT salad AND "ice cream" 

 An "all words" search request is like an "any words" search except that all of the words in 
the search request must be present for a document to be retrieved. Example: 

 FileHold Systems will find all documents with the words FileHold and systems 

 A "boolean" search request consists of a group of words, phrases, or macros linked by 
connectors such as AND and OR that indicate the relationship between them. Examples 
include: 

Search Request Meaning 

apple AND pear Both words must be present. 

apple OR pear Either word can be present 

apple w/5 pear Apple must occur within 5 words of pear 

apple NOT w/12 pear Apple must occur, but not within 12 words of 
pear 

apple AND NOT pear Only apple must be present 

apple w/5 xfirstword Apple must occur in the first five words 

 

Noise words, such as “if”: and “the”, are ignored in searches.  

Such operators and logics including: stemming, fuzzy, synonym and phonic can be used with 
full text search. Because the stemming, fuzzy, synonym and phonic search methods can 
impact search performance the ability to search using Fuzzy, Synonym and Phonic searching 
is a global setting configured by the Library Administrators. See the Library Administration 
Guide or the Knowledge Base for more information. However, individuals can search using 
these logics for individual full text searches. Search terms may include the following special 
characters: 

http://www.filehold.com/help/home
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Character Meaning Examples 

? Matches any character. appl? would match apply and apple but 
not apples 

= Matches any single digit. N=== would match N123 but not 
N1234 or Nabc 

* Matches any number of characters. 
Use to search for a term where the 
spelling is in question or there are 
multiple possible spellings. 

Note: Use of the * wildcard character 
near the beginning of a word will slow 
searches somewhat. 

appl* would match apple, application, 
etc. 

*cipl* would match principle, participle, 
etc. 

ap*ed would match applied, approved, 
etc. 

% Fuzzy search. The number of % 
characters you add determines the 
number of differences the search 
engine will ignore when searching for 
a word. The position of the % 
characters determines how many 
letters at the start of the word have to 
match exactly. 

ba%nana: 

Word must begin with ba and have at 
most one difference between it and 
banana. 

b%%anana: 

Word must begin with b and have at 
most two differences between it and 
banana. 

# Phonic search. Phonic searching 
looks for a word that sounds like the 
word you are searching for and 
begins with the same letter. 

Put a # in front of the word in your 
search request. Example: #smith will 
also find Smithe and Smythe. 

~ Stemming. Stemming extends a 
search to cover grammatical 
variations on a word.  

Add a ~ at the end of words that you 
want stemmed in a search. 

Example: apply~ also finds applying, 
applies, and applied. 

A search for fish would also find 
fishing. 

& Synonym search. Synonym searching 
finds synonyms of a word that you 
include in a search request. 

Put a & at the end of the words you 
want to use in your search request. 

A search for fast& would also find 
quickly. 

7.2.4. Words and Phrases 

To search for a phrase, use quotation marks around it, like this: "fruit salad" 

If a phrase contains a noise word, the search engine will skip over the noise word when 
searching for it. For example, a search for statue of liberty would retrieve any document 
containing the word statue, any intervening word, and the word liberty.  

Punctuation inside of a search word is treated as a space. For example:  

 can't would be treated as a phrase consisting of two words: can and t.  

 1843(c)(8)(ii) would become 1843 c 8 ii (four words). 
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7.2.5. AND connector 

Use the AND connector in a search request to connect two expressions, both of which must be 
found in any document retrieved. For example, apple pie and poached pear would retrieve any 
document that contains both phrases. 

A search for banana and pear w/5 grape would retrieve any document that (1) contains 
banana, AND (2) contains pear within 5 words of grape. 

7.2.6. OR Connector  

Use the OR connector in a search request to connect two expressions, at least one of which 
must be found in any document retrieved. For example, apple pie or poached pear would 
retrieve any document that contained apple pie, poached pear, or both. 

7.2.7. W/N Connector (Proximity Search)  

Use the W/N connector in a search request to specify that one word or phrase must occur 
within N words of the other. For example, apple w/5 pear would retrieve any document that 
contained apple within 5 words of pear. 

The following are examples of search requests using W/N: 

 apple or pear w/5 banana 

 apple w/5 banana w/10 pear 

 apple and banana w/10 pear 

The xfirstword term is useful if you want to limit a search to the beginning of a file. For 
example, apple w/10 xfirstword would search for apple within 10 words of the beginning of a 
document. 

7.2.8. NOT and NOT W/Number (Proximity Search) 

NOT allows you to exclude documents from a search. For example: apple sauce AND NOT 
pear would return all documents with term apple sauce but exclude any that had pear.  

NOT standing alone can be the start of a search request. For example, NOT pear would 
retrieve all documents that did not contain pear.  

If NOT is not the first connector in a request, you need to use either AND or OR with NOT such 
as apple OR NOT pear or NOT apple w/5 pear.  

The NOT W/ ("not within") operator allows you to search for a word or phrase not in association 
with another word or phrase. For example: apple NOT w/20 pear.  

Unlike the W/ operator, NOT W/ is not symmetrical. That is, apple NOT w/20 pear is not the 
same as pear NOT w/20 apple. In the apple NOT w/20 pear request, it searches for apple and 
excludes cases where apple is too close to pear. In the pear NOT w/20 apple request, it 
searches for pear and excludes cases where pear is too close to apple. 

CAUTION: “NOT” cannot be used in conjunction with the search parameter “Folder name”. For 
example, Folder name contains “not procedures” is not a valid search string. 

7.3. SIMPLE SEARCHES 

Simple Search (also called full text searches) in FileHold uses a “Google-like” toolbar to return 
full-text search results. 

There are three locations where you will find the Simple Search screen: 
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 Click Search in the Library hierarchy. The simple search form that appears allows users to 
search the contents of the entire documents management system using the full text search 
engine. 

 The Search field located in the top right hand corner of the FileHold Desktop Application 
user interface. 

 

 In a folder view of the Web Client. 

 

The search results returned have a relevance ranking. The relevance value (expressed as a 
percentage) is an approximation of how close the document is to the search criteria. 

TO DO A SIMPLE (FULL TEXT) SEARCH 

1. In the simple search bar, enter the search term and click Search. The search results are 
displayed. 

7.4. ADVANCED SEARCHES 

Advanced Search allows you to search by specific metadata fields and other system recorded 
information about the document.  

Users can combine searches in order to filter results. Users can also choose to search by 
metadata only, search the archive, include all versions and search using historical metadata 
fields by checking the boxes at the bottom of the advanced search form.  

The parts of an advanced search include: 

 Metadata Field Selector – Allows users to select the metadata field they want to search the 
document management system with. 

 Search Operator Selector – Allows users to select an operator to accompany a selected 
metadata field. The list of operators are Equal to, Between, Greater than >, Less than <, 
Greater than or equal to >/=, Less than or equal to </=, In the list, or Is Blank.  The list of 
available operators is dependent on the type of Metadata field selected. 

 Search Criteria Value Select – Allows users to enter a specific search criteria based on the 
metadata field and operator selected. The value field is based on the type of metadata field 
selected. By default there is only one value field for each operator. The only exception is 
the “between” operator that allows users to search between two values such as dates or 
numbers. 

 Add or Remove Search Rows – The [ - ] and [ + ] buttons to the right of each row allow 
users to remove or add (respectively) rows from the search criteria. Multiple search rows 
are joined automatically joined using the AND operator. 
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TO ACCESS THE ADVANCED SEARCH FORM 

 From the 'Search and Saved searches' simple search, click the Advanced link to the right 
of the search button. 

 To access the advanced search from the folder of the document management system 
view, click on the gray down arrow to the right of the search field icon in the top right corner 
of the folder view. 

 

 Clicking on a Saved Search. 

 Right-clicking on the file structure and selecting Search. Remember that the search will 
automatically be set to start at the library, cabinet, drawer, folder group of folder level 
depending on where the user right clicks. 

TO DO AN ADVANCED SEARCH 

1. In the Advanced Search screen, use the following table to build search queries. You can 
use up to 5 search filters to build the search query. 

 

Search option Description 

File Or Metadata  Allows users to add a full text search value to their metadata 
search criteria. This hybrid approach can be used to combine the 
best aspects of full text and metadata only searching. The same 
full text search operators apply to this field as in Full Text 
Searching. 

Document Name  Searches the system for a file by the name in the search criteria. 

Checked Out Status Search by the checked out status of: 

 Checked In 

 Checked Out 

Person  Allows users to search by: 

 Owned By Me 

 Owned By Someone Else 

 Checked Out By Me 

 Checked Out Be Someone Else 
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Search option Description 

File Date  File Data menu allows users to search by: 

 Date Last Modified 

 Creation Date 

 Approval Date (for workflow) 

Approval Status Search by the workflow status of: 

 Approved 

 Pending Approval 

 Not Approved 

 Not Submitted for Approval 

 Approval Postponed 

Library Location  Allows users to restrict searching to a specific cabinet, drawer, 
folder group or folder in the document management system. 

Common MD (metadata) 
Fields  

Allows users to search by common metadata fields –i.e. 
“Customer Name”. The list of possible metadata field options is 
customized based on how the library administrator has defined 
the document classification standards for the FileHold server. 

Search by Document Type  Allows users to restrict their search by document type and the 
associated metadata. The list of possible document types and 
associated metadata fields is customized based on how the 
Library Administrator. 

Search by Metadata Field 
Name 

Depending on the document type selected, the associated 
metadata fields are available to search by.  

Document Log Action Search for documents that have been checked out, downloaded, 
checked in, copied, moved, archived, viewed, printed, published, 
added, linked, emailed, etc. 

Document Log Date Search for documents that have had actions performed on them 
within a date or date range. 
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Search option Description 

Special Fields  Allows users to search for files by: 

 Folder name – Search using part of a folder name when the 
“Contains” operator is selected. Note that no wildcards or 
dtSearch keywords can be used for this option. 

 File Type – The File Type Extension list is dynamically 
updated and sorted alphabetically. A new file extension 
entry is dynamically added to the initial standard list upon 
adding a document with a new file extension for the first 
time. The list is not updated in FDA until the user logs in and 
out. Multiple file extensions can be used when the qualifier is 
set to “In the list”. Insert a comma between the file 
extensions. 

 FileHold ID – The unique ID number given to every version 
of a document. See Entering Metadata. 

 Document Control No. – Specialized metadata field used to 
track specific document numbering requirements.  

 Version Control No. – Like document control numbers, used 
to track specific document numbering requirements. 

 Has Markup – User can find documents that have been 
"Marked Up" using the Brava Viewer Markup Tool. 

 Has Link – Users can find all documents that have been 
linked with other documents. 

 Is Favorite – Provides a list of documents that are marked 
as favourites. 

 Document Format – Select Electronic Document, Electronic 
Record, or Offline Document type. 

 

2. Select any of the following advanced search options: 

 Search Metadata Only – Searches the metadata only and not the contents of a document 
(full-text search). 

 Include Archive in Search- Searches the documents in the Library archive and includes any 
matches in the results. FileHold will search only the Library (current documents) if this 
option is not selected. 

 Include All Document Versions - Searches all versions of the document. FileHold will only 
search the latest version if this option is not selected. 

 Search Using Historical Metadata Fields - If metadata field names and values have been 
changed over time, you can still search these "historical" items as FileHold keeps track of 
any changes that have been made. 

3. The above options can be saved by clicking the Save  icon so they are kept for every 
advanced search performed. 

4. Click Search. The search results are returned. You can continue to add or modify the 
advanced search criteria, save the search, or export the results to a CSV file. 
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7.5. SAVED SEARCHES 

You can save your advanced search templates as a Saved Search. Every time the search is 
invoked any new documents that meet the query are brought into the results view. 

Saved searches can be made personal or public. An Administrator can create "Public Saved 
Searches". Public saved searches can be made available to all users or can be assigned 
security rights so that only certain groups and users can use the public saved search..  

Personal searches saved by the user are called My Saved Searches. These personal saved 
searches can only be used by the user that created them.  

There are three types of saved searches: 

 Regular saved search – The search template is saved with all of the search criteria 
including operators and values for the selected criteria. 

 Quick search – The search template is saved with only one empty variable in the template. 
When a user runs a quick search, they are required to enter the search term for the empty 
variable while all other search criteria remain fixed. 

 Empty search – The search template is saved with empty values for all the search criteria. 
The user is forced to enter the values prior to running the search. 

7.5.1. Regular Saved Searches 

A regular saved search repeats a pre-defined search when invoked. All of the set values and 
operators in the template are used in the search. 

TO SAVE A REGULAR SAVED SEARCH 

1. After performing an advanced search, click Save as Saved Search. 

2. In the My Saved Searches window, enter a Name for the search. 

3. If you want to make the search accessible to other users, select the Make this saved 
search public check box (available to administrators only).  

4. If this is a public saved search, click Next. Select the groups and/or users that can use this 
public Saved Search and click Add. Public saved searches can only be created by Library 
Administrators or higher roles. 

5. Click OK. The Saved Search name is now in the Library hierarchy under Search > My 

Saved Searches or My Public Saved Searches with an icon . 

TO USE A REGULAR SAVED SEARCH 

1. Click on the named of the saved search in the My Saved Search or My Public Saved 
Searches area. 

2. The results of the search are displayed. You can modify the search query by adding, 
changing, or removing any of the filters. 

7.5.2. Quick Searches 

Quick searches are a type of saved search that allows you to leave a single variable in the 
advanced search template empty while all other variables remain fixed. When a user runs a 
quick search, they are required to enter the search term for the empty variable that was set up 
in the template. The search results that are returned meet all advanced search criteria plus the 
quick search term the user entered.  
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Quick searches are useful for conducting searches in Mobile FileHold since search terms 
cannot be entered for regular saved searches (non-quick type saved searches). Quick 
searches can be made private or public by administrators just like regular saved searches. 
Public saved searches can be made available to other users while personal saved searches 
are only available to the individual that created them. 

CAUTION: Search variables with an operand of Owned by Me, Checked out by Me, and the 
operator “Is Blank” cannot be used in quick searches. 

TO CREATE A QUICK SEARCH 

1. After performing an advanced search, click Save as Saved Search. 

2. In the Save this Search window, enter a Name for the quick search or overwrite an 
existing search. 

3. If you want to make the search accessible to other users, select the Make this saved 
search public check box (available to administrators only).  

4. Select the Quick Search Condition check box and select the search variable that you 
want a user to be able to enter a search term for. 

5. If this is a public saved search, click Next. Select the groups and/or users that can use 
this public Saved Search and click Add. Public saved searches can only be created by 
Library Administrators or higher roles. 

6. Click OK. The Quick Search name is now in the Library hierarchy under Search > My 

Saved Searches or My Public Saved Searches with an icon . 

TO USE A QUICK SEARCH 

1. Click on the name of the quick search in the My Saved Search or My Public Saved 
Searches area. 

2. Enter a value for the single search term and click Search. 

3. The results of the search are displayed. You can view or modify the advanced search 
query by clicking on the Advanced link in the header. 

7.5.3. Empty Search Templates 

When an advanced search is saved, all of the search criteria values can be left empty. This will 
force the user to enter the search values and click Search once the saved search is selected. 
This differs from regular saved searches which stores the search values in the template and 
runs the query automatically. 

TO CREATE AN EMPTY SAVED SEARCH 

1. After performing an advanced search, click Save as Saved Search. 

2. In the Save this Search window, enter a Name for the quick search or overwrite an 
existing search. 

3. Select the Make this saved search empty check box. 

4. If you want to make the search accessible to other users, select the Make this saved 
search public check box.  

5. If this is a public saved search, click Next. Select the groups and/or users that can use 
this public Saved Search and click Add. Public saved searches can only be created by 
Library Administrators or higher roles. 
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6. Click OK. The Empty Saved Search name is now in the Library hierarchy under Search > 

My Saved Searches or My Public Saved Searches with an icon . 

TO USE AN EMPTY SEARCH 

1. Click on the name of the empty saved search in the My Saved Search or My Public Saved 
Searches area. 

2. Enter the values for the search terms and click Search. The results of the search are 
displayed.  

7.6. USING FASTFIND 

FastFind is an optional feature that can search third party applications using hotkeys and return 
the search results in FileHold. 

Once FastFind is enabled you can use the hotkeys in any third party application. The pre-
defined hotkeys are: 

 Mouse search — Alt+S. Activates an on-the-fly screen scraper. When this is done a green 
bar appears in the bottom-left corner of the user’s desktop screen. Users can now start 
moving their mouse over screen form objects such as data fields or field labels. The text 
under the current mouse position is captured and displayed in the green bar. If a user 
wishes to search with the captured text they may left click to invoke the FileHold search. 
This initiates the Full Text Search and Metadata search in FileHold and the search results 
are displayed within FileHold’s standard search results screen. Pressing the ESC button at 
any time will stop the mouse search mode. 

 Selection search — Ctrl+D. Selection Search is similar to the Clipboard Search (and in fact 
is using Clipboard Search as its internal mechanism), however, it uses a one step process 
to initiate the search after a user highlights their selection on a business application form or 
as a part of the content of a document opened in a 3rd part application. Invoking Ctrl+D is 
all that is needed to initiate search and display results within FileHold application. 

 Clipboard search — Alt+C. Users can copy any text from the screen to the Windows 
clipboard using traditional “Copy” menu option or the Alt+C shortcut available in most 
Windows applications and then by pressing the Alt+C combination they can activate the 
Full Text Search and Metadata search in FileHold and the search results are displayed 
within FileHold on the standard search results screen. 

 Enable screen OCR search (Alt + F) – Allows you to do a search based on the Click to Tag 
functionality. Once the shortcut key is invoked, you can click on the text on the screen or 
draw a bounding box around the text. Then a search is performed in FileHold to meet the 
selected criteria from the screen. 

Since FastFind uses the contents of the clipboard any string displayed on the screen which can 
be copied to the clipboard (similarly to when using the well known Cut/Paste sequence in 
Windows), it can be used as the search criteria including partial highlights of the text strings. 

FastFind must be a purchased option and enabled before the feature will work. You can also 
create your own FastFind templates that work with the system. See the Knowledge Base for 
more information. 

TO ENABLE FASTFIND 

1. Go to File > Preferences and Settings > FastFind Preferences and select the Enable 
FastFind check box. See more information about FastFind preferences. 

2. Click Apply and then OK. 

http://www.filehold.com/help/home
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7.7. SEARCHING FOR PREVIOUS VERSIONS OF A DOCUMENT 

For system performance reasons, only the most recent version of the document is included in 
the search scope. However, users can use the advanced search setting to include all versions 
of documents (most recent and all previous) stored in the document management.  

TO SEARCH FOR A PREVIOUS VERSION OF A DOCUMENT 

1. In the Advanced Search, select the Include All Document Versions check box. 

 

7.8. SEARCHING FOR DOCUMENTS IN A WORKFLOW 

You can refine your search criteria to search for documents based on their approval status. 
Using Advanced Search, the user can select the Approval Status metadata field for any 
document types (schema) as long as that schema has at least one workflow template 
associated with it that contains at least one approval activity. Use the Approval Status select 
box to choose whether or not the file being searched for is approved or rejected. The Approval 
Status field can be used in combination with any other metadata field criteria for searching. 

NOTE: If the workflow has NOT been set to hide the file until approval is complete, the file will 
be able to be seen by all users with access to the document. If the workflow is set to hide the 
document until approval then it will not be able to be seen by users who are not participants in 
the workflow instance. All users will be able to see the file once it is approved and the workflow 
completed. 

TO SEARCH FOR A DOCUMENT BASED ON APPROVAL STATUS 

1. Go to Advanced Search. 

2. Click File or Metadata and select Approval Status. 

3. Select a qualifier: Equals or In the List. 

4. Select a status: Approved, Pending Approval, Not Approved, Not Submitted for 
Approval or Approval Postponed. 

5. Click Search. 
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8. VIRTUAL FOLDERS 

A virtual folder does not contain the actual document; it only holds a pointer back to the 
document. All virtual folders are private (i.e. unique to the user) unless they are made public. 
Public virtual folders can be seen by users with the correct permissions to the documents. 

 Regular Users can create virtual folders for their own use. They cannot be made public. 

 Library Administrators or higher roles can create virtual folders and make them private or 
public. Public virtual folders are seen by all users that are given access. Users with access 
to a virtual folder will still need the proper permissions to access any documents that are 
listed. 

 Users have access to Public (or shared) Virtual Folders in both the Web Client and 
FileHold Desktop Application. These folders are created and populated by Library 
Administrators to collect and disseminate documents to multiple users. Public Virtual 
Folders are a perfect way for documents located throughout the FileHold library to be 
displayed in one place for access by all users that are given access to by Library 
Administrators who assign the membership when creating virtual folders. Library 
Administrators can change their personal virtual folders to public and back again. 

Virtual folders can be deleted at anytime. The documents contained in a virtual folder are not 
deleted from the system. They will still be located in their original folder. 

TO ADD A VIRTUAL FOLDER 

1. Right click on the Virtual folder section in the FileHold Desktop Application and select Add 
Virtual Folder. 

2. Enter the name for the Virtual Folder.  

3. If you are a Library Administrator, you can set the folder as public or private. 

4. Do one of the following:  

 Click OK if a private folder. 

 Click Next if a public folder. 

5. If the Virtual Folder is a public folder, set the security to allow user access and click OK. 

TO DELETE A VIRTUAL FOLDER 

1. Right-click the Virtual Folder name from the list and select Delete. 

2. Click OK on the warning message to proceed with the deletion process. 
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9. THE LIBRARY STRUCTURE 

The Library structure is created by the Library Administrator. The Library structure serves the 
purpose of visually organizing the documents and providing security based on access. 

Users of the system only have access to the portion of the file structure that they assigned by 
the Library Administrator. See Understanding Roles, Permissions, and Access to the Library 
for more information. 

The Library contains cabinets, drawers, folder groups (this level is optional), and Folders. 
Documents are stored within the folders. 

9.1. CABINETS 

Only Library Administrators, Senior Library Administrators, and System Administrators can 
create cabinets. 

In order for a user to see a cabinet they must be a member of the cabinet. Only members of 
cabinets can see and access its content. In order to manage the access to a particular cabinet, 
the owner of the cabinet can add and remove member access and permissions. For more 
information on cabinets, see the Library Administration Guide. 

9.2. DRAWERS 

Only Cabinet Administrators, Library Administrators, Senior Library Administrators, and System 
Administrators can create drawers. 

In order for a user to see a drawer they must be a member of the cabinet in which the drawer 
resides. The availability of actions is dependent on the rights that users have to the cabinet that 
the drawer resides unless further restrictions have been placed on the drawer by its owner, the 
Library Administrator or the Systems Administrator. For more information on drawers, see the 
Library Administration Guide. 

9.3. FOLDER GROUPS 

Folder groups are intended to be used as an extra layer of division in the Library structure but 
their use is optional. Like drawers that divide cabinets into more manageable size; folder 
groups divide drawers into more suitably sized portions. Folder groups contain only folders. 

In order for a user to see a folder group they must be a member of the cabinet in which the 
folder group resides. The availability of actions is dependent on the rights that users have to 
the cabinet that the folder group resides unless further restrictions have been placed on the 
folder group by its owner, the Library Administrator or the Systems Administrator.  

The following actions can be performed on folder groups: 

Action / Function What the Function Does Who Can Access the 
Function 

Open Folder Group Expands the folder group 
revealing its contents. 

All users with access to the 
cabinet that the folder group 
belongs to. 

Search Allows users to restrict their 
search to files located in the 
selected folder group. 

All users with access to the 
folder group. 

Properties Displays the folder group All users with access to the 
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Action / Function What the Function Does Who Can Access the 
Function 

Properties. folder group. 

Set Default View Allows user to select a default 
view that has been created in 
the View Preferences. 

All users with access to the 
folder group. 

Add Folder Allows user to add a folder to 
the folder group. 

Users with Publisher or higher 
access.  

Move Folder Group Moves the folder group to a 
different drawer. 

Users with Organizer or 
higher access. 

Copy Folder Group Makes a copy of the folder 
group including all folders and 
files it contains. 

Users with Organizer or 
higher access. 

Clone Folder Group 
Structure 

Makes a copy of the folder 
group and the folders it 
contains. Does not copy 
documents in folders. 

Users with Publisher or higher 
access. 

Delete Folder Group Deletes the folder group and all 
items it contains. 

Users with Organizer + Delete 
or higher access.. 

Archive Folder Group Manually sends the contents of 
the folder group to the Library 
Archive.  

Library Administrator or 
System Administrators only. 

Export Exports all documents in the 
folders contained in the folder 
group.  

Users with Organizer or 
higher access. 

TO MANAGE FOLDER GROUPS 

1. Right-click on a cabinet and select Manage Folder Groups. The folder group list window 
opens with a list of existing folder groups. 

2. To add a folder group, click Add Folder Group. 

3. Enter a folder group Name. 

4. Select a weight for this folder group from -10 to 10. The lower the weight (such as -10), the 
higher the folder group name appears in the Library. The higher the weight (such as 10), the 
lower the folder group name appears in the list. Leave the weight at 0 if you want the folder 
groups sorted alphabetically. 



Fi leHold 14  End User  Guide  

64  February 2014 

 

5. Click Save. The folder group name is added to the list. 

TO ASSIGN A FOLDER GROUP TO A DOCUMENT FOLDER 

1. Right-click on a folder in the Library and select Properties. 

2. In the Folder Group field, do one of the following: 

 Select the folder group to which you want this folder to belong from the list. 

 To create a new folder group, select Add a New Folder Group and enter the name 
in the New Folder Group Name field. 

3. Click OK. The folder is moved into the selected folder group. 

TO EDIT OR DELETE A FOLDER GROUP NAME 

1. Right-click on a folder group in the Library and select Properties. 

2. Click Edit Folder Groups. 

3. To edit a folder group name, double-click on a folder group. 

4. In the Edit Folder Group window, enter a new name for the folder group and a weight 
(optional). The lower the weight (such as -10), the higher the folder group name appears in 
the Library. The higher the weight (such as 10), the lower the folder group name appears in 
the list. Leave the weight at 0 if you want the folder groups sorted alphabetically. 

5. Click Save. 

6. To delete the folder group, click Delete. 

9.4. FOLDERS 

Folders are the level in the library structure where documents reside. Documents can only 
reside at the folder level. Only users that are members of a particular folder can access the 
files that reside in that folder. 

When a user with a role of Publisher or higher creates a new folder they must associate groups 
(or users) with the folder in order to protect the contents of the folder from unauthorized users. 
ONLY groups (or users) associated with a folder will see and have access to the folder. 
Permissions can be further restricted once the groups or users are assigned as members.  

The groups that are available to be members of the folder are inherited from the cabinet in 
which the folder resides. If you wish to add groups other than the ones that appear in the folder 
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properties, the group must first be added at the cabinet level of the document management 
system. After the group is added at the cabinet level, the new group will appear in the Available 
FileHold Group listing in the folder properties security section. 

Security on the folder can be modified using the advanced security option. You are able to give 
a user or group a role that is less than what is already designated to them. For example, you 
can modify a cabinet administrator’s role to reduce it to document publisher. If a group or 
user’s permissions are modified using the advanced security option, a red dot appears on the 
folder that has been modified when the user logs in. 

 

The availability of actions is dependent on the rights that users have to the cabinet that the 
folder resides unless further restrictions have been placed on the folder by its owner, the 
Library Administrator or the Systems Administrator. The following actions can be performed on 
folders: 

Action / Function What the Function Does Who can Access the 
Function 

Open Folder Opens the folders and shows 
the files it contains. 

All users with access to the 
folder based on the folder 
membership. 

Search Allows users to restrict their 
search to files located in the 
selected folder. 

All users with access to the 
folder. 

Properties Displays the folder properties. All users with access to the 
folder. 

Set Default View Allows user to select a default 
view that has been created in 
the View Preferences. 

All users with access to the 
folder. 
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Action / Function What the Function Does Who can Access the 
Function 

Alert Me of Changes Subscribes the user to be 
alerted when certain actions 
are performed on the folder 
by other users. The types of 
actions that trigger alerts are 
managed by the users Alert 
Preferences. Users can 
remove folder alerts from the 
My FileHold; Document alerts 
page OR select the 'Disable 
This Alert' option from the 
folder menu.  

All users with access to the 
folder. 

Disable This Alert Disable the alert for the 
folder. The user will no longer 
be alerted when certain 
actions are performed on this 
folder. Re-activate the alert 
by clicking on the 'Alert Me of 
Changes' option in the folder 
menu. 

All users with access to the 
folder. 

Move Folder Moves the folder to a different 
drawer or folder group. 

Users with Publisher or higher 
access that are the folder 
owner. 

Copy Folder Makes a copy of the folder. Users with Publisher or higher 
access that that are the folder 
owner. 

Delete Folder Deletes the folder and all 
documents it contains. 

Users with Publisher and 
Delete or higher access that 
are the folder owner. If the 
user is Publisher and Delete 
role they must be also be the 
owners of all document 
versions in the folder before 
they can delete a document.  

Clone Folder Makes a copy of the folder 
group and the folders it 
contains. Does not copy 
documents in folders. 

Users with Publisher or higher 
access. 

Archive Folder Manually sends the contents 
of the folder group to the 
Library Archive.  

Library Administrator or 
System Administrators only. 

Export Exports all documents in the 
folders contained in the folder 
group.  

Users with Publisher or higher 
access and that are the folder 
owner. 

TO CREATE A FOLDER 

1. In the Library, right-click a drawer or folder group and select Add Folder. 
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2. Enter a Name for the folder. 

3. Select a folder owner for the list. Your permissions may be restricted to only allowing 
yourself to be the owner of the folder.  

4. Select a Default Schema from the list. The list of schemas will be only those that you have 
access to. 

5. Select a Folder Group from the list (if applicable). 

6. Select a Weight for the folder. The lower the weight (such as -10), the higher the folder 
name appears in the Library. The higher the weight (such as 10), the lower the folder name 
appears in the list. Leave the weight at 0 if you want the folder groups sorted 
alphabetically.  

7. Select a Color from the list. Options include: yellow (default), green, red, and blue. The 
folder is displayed in the library tree in the selected colour. 

8. Click Next. 

9. In the Security tab, do the following: 

 In the Group By field, select how you want the available FileHold Groups displayed. 

 In the Available FileHold Groups area, select the groups you want to be able to 
access the cabinet and click Add Groups. The group is added to the Current 
Members of Cabinet list. 

 In the Eligible Users in the FileHold Group, select the user you want to be able to 
access the cabinet and click Add User. The user is added to the Current Members of 
Cabinet list. 

 To remove a user or group from the cabinet, select the name from the Current 
Members of Cabinet list and click Remove Members. 

 To view all Groups and Users, click Group Members. A new All Groups/Users panel 
opens on the right side of the window. 

 To see which user roles the user or group belongs to, select the user or group name 
in the Current Members list and click Effective Permissions. The user role for that 
cabinet member will appear in the Effective Permissions list. 

 To set advanced security options on a user or group, select the user or group name 
in the Current Members list and click Advanced Security Options. To modify the 
rights, select a user role from the list and click Apply. To revert to the default user 
role, click Restore. Note that if a group or user’s permissions are modified, a red dot 
appears on the folder that has been modified when the user logs in.  

 Select the Inherit Security Permissions from Cabinet check box if you want to 
inherit the security settings from the cabinet that the folder will reside. If you select 
this check box, you cannot modify the members of the folder. 

10. Click Next. 

11. In the Auto-tagging tab, you can set the documents that are added to the folder to be 
automatically tagged (metadata automatically added). See the section Creating Auto-
Tagged Folders for more information.  
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12. Click Save. The folder is added to the Library structure. 

 

TO EDIT THE FOLDER PROPERTIES 

1. Right-click on a folder in the Library and select Properties. The folder properties window 
opens. 

2. Make any changes to the folder properties and click Save. 

TO DELETE A FOLDER 

1. Right-click on a folder in the Library and select Delete Folder.  

NOTE: You need to have delete permissions in order to delete a folder. 

2. You will receive a warning message. Click OK to delete the folder. The folder is removed 
from the Library. 

 

TO COPY A FOLDER 

1. To copy a folder, its security, and all of its contents including documents, right-click on the 
cabinet and select Copy Folder. 

2. Enter a name for the copied folder  and click OK. The copied folder appears in the Library 
hierarchy.  

WARNING: Copying large folders and its contents will cause the FileHold server to consume 
resources and may slow down the system. We recommend that you do this after business 
hours if copying folders containing tens of thousands or many hundreds of thousands of 
documents. The amount of time it will take to copy a folder and its contents is dependent on 
the server hardware that powers the system; the faster the server hardware the better. 



End User  Guide  F i leHold 14  

February 2014  69 

TO CLONE THE FOLDER STRUCTURE 

1 To clone a folder, its security, and all of its contents including drawers, folders and folder 
groups, right-click on the cabinet and select Clone Folder.  

2 Select a destination in the Library for the cloned folder. 

3 Enter a name for the cloned folder and click OK. The cloned folder appears in the Library 
hierarchy. 

NOTE: Cloning a folder does NOT copy the documents. Use Copy Folder to copy folders and 
documents.  

TO ARCHIVE A FOLDER 

1. To send a folder and its contents to the Library Archive, right-click on the folder name and 
select Archive Folder. 

2. At the message prompt, click OK. The folder and its contents are moved to the archive. 

 

TO MOVE A FOLDER 

1. Right-click on a folder and select Move Folder. 

2. Select the destination location by navigating through the Library in the dialog box and click 
OK. The folder is moved to the location. 

9.4.1. Creating Auto-Tagged Folders 

When documents are added to the system, you need to set the document with metadata in 
order to store it in the Library. Auto-tagging removes the manual step of setting the metadata 
step out of the process. The metadata values to be automatically applied to all files placed in 
the folder with auto-tagging configured. Auto-tagging on a folder is set on a document schema; 
therefore, all files using that schema will use the predefined auto-tags.  

Auto-tagging can be set at the cabinet or folder level. If some of the documents in the cabinet 
or folder belong to a different schema type than what has been defined in the auto-tagging tab, 
then the metadata will not be changed or overwritten. 

When documents are added to a folder that is auto-tagged, they must follow the rule that is 
defined and no changes can be made to that rule. For example, if the auto-tagging rule is set to 
the Invoices schema, then no other document types can be added to that folder. 

Auto-tagging rules are set up by the folder owner or higher roles.  

TO SET AUTO-TAGGING ON FOLDERS (OR CABINETS) 

1. When creating a new folder go to the Auto-Tagging tab or for an existing folder, go to 
Folder Name > Properties > Auto-Tagging. 
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2. In the Auto-Tagging tab, select the Enable Auto-tagging check box to have all documents 
in this folder automatically “tagged” with the same metadata based on the schema as they 
are added to this cabinet. This assumes that all of the documents that are being added to 
the cabinet have mostly the same metadata as all the other documents in the cabinet. This 
ensures a highly compliant filing system and standardization across all documents within 
the cabinet or folder. Users can select to have some standard repetitive metadata added 
automatically, manually, or a combination of both. 

3. Select the Make this the default auto-tagging settings for all folders in this cabinet if 
desired if you are setting up auto-tagging at the cabinet level. This option is not available at 
the folder level. 

4. In the Auto-Tagging Metadata area, select the document schema and the metadata. You do 
not have to set all the metadata fields; you can leave them blank for the user to enter them. 

5. Click Save. 

6. The folder with the auto-tagging rule has the letter “A” on the folder signifying that is being 
automatically tagged. 
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10. DOCUMENT ACTIONS AND FUNCTIONS 

A variety of actions can be taken on individual document versions. Actions are accessible from 
the contextual menu associated with a document by either right clicking on the document name 
if accessing the software using the Desktop Application or clicking on the down arrow 
associated with the file if accessing the document management software using a web browser. 
The availability of actions is dependent on the rights that the user has. 

Action /Function Description Permissions needed 

Open (FDA only) Opens the selected document 
in its native application. 

All users with access to the 
document. 

Open in document viewer 
(FDA only) 

Opens files in the Brava 
document viewer. This option 
is only available if the Brava 
viewer is installed and 
licensed for the user. 

Users that have been 
assigned a Brava viewer 
license. 

Open in PDF/Image Viewer 
(FDA only) 

Opens the document in the 
PDF/Image Viewer. This 
menu item is only available if 
the Brava Viewer is installed 
and licensed for the user. 

Users that have been 
assigned a PDF/Image 
Viewer license. 

Open to Reorder 
Pages/Images (FDA only) 

Opens the document in the 
PDF/Image Viewer in order to 
reorder the pages or images. 
This menu item is available if 
you have the Brava viewer or 
PDF/Image viewer installed 
and licensed for the user. 

Users that have been 
assigned a PDF/Image 
Viewer or a Brava Viewer. 

Make a Local Copy (FDA)  

Get a Copy (Web Client) 

Creates a copy of the 
document to the user’s local 
machine. The copy is 
automatically sent to the My 
FileHold Documents folder. 

All users with access to a file. 

Check Out This Document 
(FDA)  

Check Out (Web Client) 

Checks out the document and 
downloads it to your working 
directory which is typically My 
FileHold Documents folder. 

Users with document 
publisher rights or higher. 

Check In This Document 
(FDA)  

Check In (Web Client) 

Checks documents back in 
the system and opens the 
'lock" on the document. 
Documents that are checked 
in are given a new document 
version number. 

Users with document 
publisher rights or higher. 
However, only the user that 
has checked the document 
out of library OR the library 
system administrator may 
check it back in. 
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Action /Function Description Permissions needed 

Workflow > Initiate workflow 
template name (FDA)  

Initiate Workflow > Workflow 
template name (Web Client) 

Allows you to select the 
workflow template name from 
the list and start a workflow. 
Selecting more than one 
document will start a multiple 
document workflow.  

Users with Document 
Publisher rights or higher and 
is owner of the document.*  

*Unless the ‘Allow non 
document version owner to 
initialize workflow” permission 
setting is enabled. 

Workflow > View Sign-Off 
Sheet 

Listing of all users that either 
approved or rejected this 
version of the document, 
when they did it and if they 
signed-off on behalf of 
someone else. 

Users that are participants or 
observers in a workflow. 

Workflow > View Review & 
Approval History 

View the history of comments 
for a workflow. 

Users that are participants or 
observers in a workflow. 

Workflow > Cancel Workflow Cancels a workflow in 
progress. 

Initiators of a workflow or 
Library Administrators or 
higher. 

Workflow > Submit Approval Allows you to approve a 
document. 

Users assigned to perform an 
approval task in a workflow. 

Workflow > Submit Review Allows you to submit a review 
on a document. 

Users assigned to perform a 
review task in a workflow. 

Metadata and File Properties Displays the Metadata and 
file properties for a file stored 
in the documents 
management software. 

All users with access to the 
folder the document is in. 

Edit Metadata Displays the Metadata and 
file properties for the selected 
files and allows you to edit 
the metadata en masse. 

Users with document 
publisher rights or higher. 

Link Documents (FDA) 

Link (Web Client) 

Displays the Create Links 
window to link the selected 
documents together. 

Users with document 
publisher rights or higher. 

View Linked Documents Displays all documents that 
are linked to a selected 
document. 

All users with access to the 
folder the document is in. 

Redact Document (FDA only) Sends a file to the Brava 
viewer so that the user may 
redact (black out) portions of 
the text before sharing for 
security reasons. 

Users with a Brava viewer 
license who have the role of 
Document Publisher or 
greater. 

Send to > Document Tray Send a document to the 
Document Tray. 

All users with read only or 
higher. 

Send to > Virtual Folder Send a document to a Virtual 
Folder. 

All users with read only roles 
or higher. 
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Action /Function Description Permissions needed 

Send to > Local Folder Downloads a copy of 
document to a folder on your 
local computer. You can 
browse to where you want the 
document downloaded. 

All users with read only roles 
or higher. 

Send to > Export Exports the documents to 
your local computer in their 
native format and a XML file 
containing the metadata, 
schema, and library location 
for the selected documents. 

All users with document 
publisher roles or higher 
unless restricted by 
administration. 

Send to > Email Emails the document as an 
attachment or a link to the 
document in the document 
management system. 

All users with read only roles 
or higher unless restricted by 
administration. 

Send to > Email and Check 
Out 

Emails the document as an 
attachment or a link and 
checks out the document at 
the same time. 

All users with document 
publisher roles or higher. 

Send to > Library Archive Sends the document to the 
Library Archive. 

All users with Library 
Administration or higher 
unless restricted by 
administration. 

Send to > Printer (FDA only) Send the document to your 
printer. This function is 
available only if you have the 
Enterprise Office Viewer. 

All users with document 
publisher roles or higher 
unless restricted by 
administration. 

Send to > Existing Workflow 
(Web Client only)  

Add to Existing Workflow 
(FDA) 

Adds a main or supporting 
document to an existing 
workflow. 

Users with Document 
Publisher role or higher. User 
must have access to all 
added documents and be 
owner of the document 
version when adding main 
documents. 

Publish As Allows users to convert 
documents in FileHold to 
PDF, TIFF, DWF or CSF. 
This function is available only 
if you have the Enterprise 
Office Viewer. 

All users with document 
publisher role or higher 
unless restricted by 
administration. 

Notify Me Create a Document Alert or 
Reminder and/or cancel ones 
that have been created. 

All users with access to the 
document. 
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Action /Function Description Permissions needed 

Create Shortcut Allows the user to create a 
shortcut to a selected 
document in another Folder 
located in the document 
management system. Note 
that this functionality has 
been disabled in FileHold 12 
unless it is enabled by an 
administrator. 

Users with Publisher access 
rights or higher that have 
access to the folder the 
document is in. 

Go to Document Location Takes you to the folder 
location of the selected 
document. This function is 
available when you are not in 
a folder such as in My 
Favorites, search results, 
virtual folder and so on. 

All users with access to the 
document. 

Copy or Move Make a copy of a document 
or move it to another location 
in FileHold. 

Document Publisher and 
Publisher need to have 
ownership of the document. 
Organizers or higher 
permissions can move 
documents owned by anyone. 
Restrictions on where a 
document can be moved to 
will apply. 

Delete Delete a document from the 
system. 

All users with Document 
Publisher + delete 
permissions or higher (and in 
some cases, they can only 
delete their own documents. 
See User Roles for more 
information). Library 
Administrators can recover 
deleted documents within the 
configured number of days. 

Convert to Offline Converts an electronic 
document to an offline 
document. Downloads the file 
to the local machine and 
deletes all versions of a file 
from the document 
management system. 

Users with Cabinet 
Administrator rights or higher 
and are owners of the 
cabinet. 

Rename Rename a document. Users that created the file or 
those with Document 
Publisher or higher 
permissions. 

Change Document Owner Change the owner of a 
document version. Ownership 
change can be done one 
document at a time. 

Users with Organizer role and 
higher. Cabinet 
Administrators must own the 
cabinet. 

http://www.filehold.com/help/system/user-roles
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Action /Function Description Permissions needed 

View Version History Displays the usage logs for 
the selected document 
including:  

• All versions of the 
document. Actions that users 
have taken on the document 
by document version.  

• Edits to the document. 

All users with access to the 
folder the document is in. 

Download as Zip File Downloads multiple 
documents as one zip file. 
Note: This command only 
appears if multiple documents 
are selected first. The zip file 
name will include the user 
name and the download date. 

Users with access to the 
folder the document is in. 

10.1. ADDING DOCUMENTS TO FILEHOLD 

Users with Document Publisher and higher permissions can add files to the document 
management system. Documents can be brought into FileHold using several methods: 

 Drag and drop — Drag and drop a document from your local computer. 

 Directly within FileHold — From the Inbox or a folder location. 

 From Microsoft Office applications — Use the integrated FileHold toolbar to add 
documents.  

 Microsoft Outlook – Add emails using the integrated FileHold toolbar or the “watched 
folder”.  

 Watched Folders — Documents can be brought into the system automatically from a 
scanner location. See Watched Folders for more information. 

 Manage Imports — Documents can be brought into the system automatically using the 
Manage Imports tool. See the Library Administration Guide for more information. 

 For other ways to get documents into FileHold, see the Knowledge Base. 

10.2. DRAGGING AND DROPPING DOCUMENTS 

You can use Windows Explorer to drag and drop one or many documents into a folder or the 
Inbox of the FileHold Desktop Application (FDA). If dragging and dropping multiple documents, 
they will be automatically sent to the Inbox for processing. 

You cannot drag and drop documents into the FileHold Web Client. 

TO DRAG AND DROP DOCUMENTS 

1. In Windows Explorer, select the files to be transferred to FileHold from the local computer. 

2. Drag and drop them to their destination folder or to the Inbox. 

3. For files dragged to a folder destination, enter the metadata (unless the folder is auto-
tagged) and click Add. The document is added to the location. 

http://www.filehold.com/help/home
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4. For files dragged to the Inbox, enter the metadata and select a destination.  

 Click Set Metadata and Set Destination to enter the metadata and select the 
destination folder. 

 Click Send or Send All to send the document(s) to the folder. 

 

 See Entering Metadata for a Document for more information on setting metadata on 
documents. 

10.3. ADDING DOCUMENTS DIRECTLY FROM THE FILEHOLD DESKTOP APPLICATION 

There are many ways in which you can add one or documents directly from the FileHold 
Desktop Application: 

 Click the Add File (+) button from the Inbox or folder location. 

 Go to File > Add File to Library. This option allows you to add one or many documents. 

 Go to File > Add Folder to Library. Adds the entire contents of a folder (not the folder 
itself) to the Inbox.  
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If you are adding more than one document at a time, then the documents will automatically go 
to the Inbox for processing. 

TO ADD FILES DIRECTLY FROM FILEHOLD 

1. Do one of the following: 

 From the Inbox or a folder location, click Add File (+ sign).  

 Go to File > Add File to Library. 

 Go to File > Add Folder to Library. 

2. Select the file from the local computer and click OK. 

3. If the file was added to the Inbox, the metadata and destination will need to be set. Click 
Set Metadata and Set Destination to enter the information. After the information is 
entered, click Send or Send All. See Entering Metadata for a Document for more 
information on setting metadata on documents. 

4. If the file was added to a folder, enter the metadata and click Add.  

10.4. ADDING DOCUMENTS THROUGH THE FILEHOLD WEB CLIENT 

When adding documents via the web client, you can only add a single document at a time. If 
you need to add multiple documents, use the FileHold Desktop Application. Since there is no 
Inbox in the Web Client, you add a document from within the destination folder. 

TO ADD A DOCUMENT VIA THE WEB CLIENT 

1. In the destination folder, click Add File to Folder. 

 

2. When the Metadata pane opens, select the document type from the list. 
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3. Select the format of the document, if applicable. 

4. Click Browse to locate the file that you want to add to the repository. 

5. Fill out the required metadata fields. See Entering Metadata for a Document for more 
information on setting metadata on documents. 

6. Click Save.  

10.5. ADDING DOCUMENTS FROM MICROSOFT OUTLOOK 

Users can save entire emails, including attachments or save just the attachment without the 
email. Emails can be brought into the system: 

 Drag and drop emails from Microsoft Outlook into the FileHold document management 
system. 

 Use the Add to FileHold button from the Add Ins toolbar in Microsoft Outlook. The email 
message has to be opened in order to use the Add to FileHold button as you cannot do it 
from the messages view. 

 Using a Microsoft Outlook ‘watched folder’ allows you to add any emails into the “watched 
folder” in Outlook so that the emails are brought into a folder on the local computer or 
network location. Then having a watched folder or managed import set up in the FileHold 
Desktop Application (FDA) (see the Library Administrator Guide for more information), the 
emails automatically get brought into system for processing. 

Emails are saved as msg files and open in Outlook with their attachments. The email header 
information (To, From, CC, Date, Subject and Attachment) may be automatically extracted into 
the metadata fields, depending on what your administrator has configured. That way, you do 
not have to type this information in; instead the system will do it for you. See Extraction Rules 
in the Library Administration Guide for more information. 

For the watched folder in Outlook, you can set up special email rules in Outlook to ensure the 
correct emails are being moved into the document management system. You can also drag 
and drop emails into the watched folder. Once an email has been sent into the document 
management system, it can never be imported again.  



End User  Guide  F i leHold 14  

February 2014  79 

TO ADD EMAILS FROM MICROSOFT OUTLOOK 

1. Do one of the following: 

 From Microsoft Outlook, select one or more emails and drag and drop the files into 
either the Inbox or a folder location. Enter any required metadata and/or destination 
information. See Entering Metadata for a Document for more information on setting 
metadata on documents. 

 From Microsoft Outlook, open an email and go to the Add-Ins tab and click Add to 
FileHold (+ sign). Select the folder location and enter the metadata and click Add. 
See Entering Metadata for a Document for more information on setting metadata on 
documents. 

 Drag and drop or set up an Outlook rule to send documents to the Outlook watched 
folder. See below for more information.  

TO SET UP THE MICROSOFT OUTLOOK WATCHED FOLDER 

1. Create a folder in Microsoft Outlook that you want add the emails to. 

 

2. On your local computer or network location, create a folder that you want FileHold to 
“watch” for new emails to be brought into the repository. 

3. In the FileHold Desktop Application, do one of the following: 

 Set up the Watched Folder for the folder you just created on your local computer or 
network drive. See Watched Folders for more information. Note that if you are using 
a Watched Folder, the email header information is not extracted into the metadata 
fields of the schema. If you want the email header information extracted into the 
metadata fields, use a managed import instead. 

 Have your Library Administrator set up a Managed Import for the folder that was 
created on your local computer or network. See the Library Administrator Guide for 
more information. 

4. In Outlook 2010, select the Add Ins tab in Outlook and click FileHold Watched Folder. 

 In Outlook 2007, click FileHold Watched Folder in the toolbar. 

 

5. In the FileHold Watched Folder Configuration window, click the Enable Outlook Watched 
Folder check box. 

6. In the Watched Folder in Outlook field, click Browse to select the watched folder you 
created in Microsoft Outlook. 
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7. In the Destination Folder for Export field, click Browse to select the watched folder on your 
local computer or network drive. 

8. To create an XML file when the emails are exported, select the Export XML files in 
Document Import compatible format check box. This XML file is created for each .msg 
file and can be using in conjunction with the Manage Imports tool to import emails into the 
repository. The XML file contains the following message header information: To, From, CC, 
Date, Subject, and Attachments. Note that this does not need to be turned on to work with 
FileHold Watched Folders. The XML files do not get imported into the repository. 

 

9. Click OK. 

10. Test your configuration by adding a msg file to your Outlook watched folder. Then go into 
FileHold to ensure that the file has been brought into the Inbox for processing or sent to the 
folder, depending on your configuration settings in the Watched Folder or Managed Import. 
If you are setting up a managed import for emails, ensure that you have an email schema 
and an email extraction rule configured. 

TO ADD ONLY AN ATTACHMENT FROM AN EMAIL 

If attachments are saved to the system without the email they are stored in their native format. 

NOTE: You cannot drag and drop an email attachment. You will need to use the Send to 
FileHold command. 

1. In Microsoft Outlook, select and open an email with an attachment. 

2. Right-click on the attachment and select Add to FileHold. 

3. Select a destination for the document. 

4. Enter the metadata for the document. See Entering Metadata for a Document for more 
information on setting metadata on documents. 

5. Select the following options, if applicable: 

http://www.filehold.com/help/library/email-extraction-rule
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 Close the document before I add it — Closes the document in the application you are 
working in after you have added the file. 

 Delete the local copy of this file after it has been successfully added — Deletes the 
copy of the file from your local computer after it is added. 

 Email notify all folder members that this document has been added to this folder — 
Sends an email alert to all the members of the selected folder. 

6. Click Add or Auto-File if the document was added to a folder that is auto-tagged. 

10.6. ADDING DOCUMENT FROM MICROSOFT OFFICE APPLICATIONS 

FileHold has integration with Microsoft Office applications such as Word, Excel, PowerPoint, 
Visio, and OneNote (2010 only). The integrated toolbar can be found on the Add Ins tab of the 
Office applications. 

The FileHold Office Client (FOC) window is used when adding, browsing, checking in, 
attachments or approving documents in FileHold from within Microsoft Office applications. 

 

TO ADD FILES FROM MICROSOFT OFFICE APPLICATIONS (EXCLUDING MICROSOFT OUTLOOK) 

1. Create or open a document in a Microsoft Office application such as Microsoft Word.  

2. Save the document to your local computer.  

3. In Microsoft Office 2007 or higher, select the Add-In tab and click Add to FileHold (+ sign) 
or Send to FileHold > Add Document.  

 For Microsoft Office 2003 users, use the File menu > Add to FileHold. 

4. The FileHold Microsoft Office Client window opens. 

5. Select a destination folder and enter the metadata. 
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6. Select the following options, if applicable: 

 Close the document before I add it — Closes the document in the application you are 
working in after you have added the file. 

 Delete the local copy of this file after it has been successfully added — Deletes the 
copy of the file from your local computer after it is added. 

 Email notify all folder members that this document has been added to this folder — 
Sends an email alert to all the members of the selected folder. 

7. Click Add or Auto-File if you selected a folder that has been auto-tagged. 

10.7. ADDING OFFLINE DOCUMENTS 

An offline document is something that cannot be stored in the document management system 
such as a map, book, or blueprints. An offline document can also point to documents that are 
not yet in electronic form such as a location of a folder in a filing cabinet in a historical records 
room. You will need to create an offline document schema in order to add offline documents 
that have a metadata field that states where the offline document is stored. The schema simply 
points to where the document is physically stored. 

Offline documents are tracked in the system so you can see who has the document out or in 
other words, who has taken the item from its physical location. 

Offline documents can be: 

 Checked out 

 Converted to an electronic document 

 Undergo a workflow 

 View the version history 

TO ADD OFFLINE DOCUMENTS 

1. In FDA, go to File > Add Offline Document. 

 In the Web Client, select "Offline Document" from the Format of Document drop-
down list. 

2. Select the Offline Document Schema name. See the Library Administration Guide on how 
to create an offline document schema. 

3. Fill out the required metadata fields and click Add. 

10.8. EXPORTING DOCUMENTS IN A VIEW TO A CSV FILE 

From any folder view, search results or other FileHold view, you can export the columns and 
associated values to a CSV file. The CSV file contains information from the entire folder list 
columns except for the icons associated with the documents (i.e. favorites and permissions). 

NOTE: Only the documents displayed on the current “page” will be exported to the CSV file. If 
you have additional pages of documents, you will need to export each page to CSV. You can 
also increase the number of documents displayed on a “page” in the View Preferences. 

TO EXPORT FOLDER CONTENTS TO A CSV FILE 

1. Open a folder or do a search to create a list of files to export. 
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2. Right-click in the column names header and select Export Grids to CSV. 

 

3. Enter a name for the CSV file and select a location to save the document. 

4. Click Save.  

5. You can now open the document in a spreadsheet. 

 

10.9. ENTERING METADATA FOR A DOCUMENT 

When documents are being added to the document management system, it requires two 
pieces of information prior the file being added to the library: 

1. Values for all required metadata fields. 

2. A destination folder. 

The status of the document is “Info Required” until the information is entered. Once the 
required metadata is filled and a destination set, the status changes to “Ready to Send” and 
document(s) can be sent to the library.  

When entering metadata for document, all fields marked with an asterisk * indicate that the 
field is mandatory and must be filled in. The type of metadata collected for a document type is 
determined by how you set up your metadata schema. Metadata is set in the Metadata Pane.  

To open the Metadata pane, click . 
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Once the metadata has been set, it is displayed in the Metadata Pane along with the file 
version properties associated with the selected file. The version properties are displayed below 
the metadata properties. Here, the document owner, version number, status, format, URL links, 
file type, library location, markup status, and file size can be viewed. All of the version 
properties of a file are searchable. See the table below for details on the document Version 
Properties. 

Version Property Description 

Version Displays the number of versions for a document. Click the View All 
Versions link to see all document versions. See Version History for 
more information. 

Owner The user that initially added the file or the user that added the latest 
version of the file. 

Ownership is important when it comes to user roles and being able to 
delete, move, etc 

Library Status States if the document is checked in or checked out. If it is checked 
out it will state who has checked out the document and when it was 
checked out. 

Has Markups If any markups have been added via the Enterprise Office Viewer, it 
states Yes. If there is no markups, it states No. 

FileHold ID A unique ID number given to every document in the system.  

Documents are numbered sequentially as they are added. The 
number after the period (.) indicates the version number. 

Format Types are: 

Electronic Document – documents that can be checked out/in and 
modified. 

Electronic Record – records cannot be modified. There will only be 
one version of this file. 

Offline Document – physical items that reside in your office or point to 
documents that are not yet in electronic format in the document 
management system. 

Library Location The cabinet / drawer / folder group (optional) / folder location of the 
document. 
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Version Property Description 

Document URL Links that can be used to point to the document. There are 2 different 
link types for the two different FileHold clients. 

Copy URL – link to where the document resides when using the Web 
Client (via a web browser). For example, 
http://fileholdserver/FH/FileHold/WebClient/LibraryForm.aspx?docId=1  

Copy FDA Link – link to where the document resides when using the 
FileHold Desktop Application. For example, fda://document/1  

Type of File States the file type such as Microsoft Word, PDF, TXT, JPG, etc. 

Size States the size of the file. 

 

 

TO ENTER METADATA FOR A SINGLE DOCUMENT (DOCUMENT TAGGING) 

1. Add the file to the document management system. This can be done in the Inbox or a 
folder location. 

2. Do one of the following: 

http://fileholdserver/FH/FileHold/WebClient/LibraryForm.aspx?docId=1
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 Click the inline Set Metadata link. 

 Click the Edit Metadata button. 

 Right-click and select Edit Metadata. 

 Click the metadata pane button . 

3. Select the Type of Document (schema) from the list. The metadata fields will change 
depending on which schema you have chosen. 

4. Enter in all the required metadata information. This is marked with an asterisk *. 

5. Fill in the optional information if needed. 

6. Select the check box to delete the local copy of the file after it is added to the Library if 
required. 

7. Select the check box to email all folder members that a document has been added to the 
folder if required. 

8. Click Add or Save & Next to add metadata to the next document in the list. 

TO ENTER METADATA FOR MULTIPLE DOCUMENTS AT A TIME (FDA ONLY) 

1. Add the files to the FileHold Desktop Application. By default, these documents will go to 
the Inbox. 

2. Select the files to be tagged (indexed). Use the CTRL or SHIFT keys to select multiple 
documents. 

3. Do one of the following: 

 Click the Edit Metadata button. 

 Right-click and select Edit Metadata. 

NOTE: Do not click the inline Edit Metadata link. This will cause you to edit the metadata for 
just that selected document. 

4. Select the Type of Document (schema) from the list. The metadata fields will change 
depending on which schema you have chosen. 

5. Do one of the following: 
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 To enter common values for all metadata fields for all of the selected files, select the 
Check All check box and enter the metadata values. 

 

 To enter common values for only select metadata fields, select the check box next to 
the metadata field names.  

 

6. Select the check box to delete the local copy of the file after it is added to the Library if 
required. 
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7. Select the check box to email all folder members that a document has been added to the 
folder if required. 

8. Click Save. 

9. If there are any required metadata fields that were not filled out, enter in all the required 
values for the individual documents. Required fields are marked with an asterisk *. 

10. Fill in the optional metadata fields if needed. 

11. Click Save or Save & Next. 

10.9.1. Entering Metadata Using Click to Tag 

Click to Tag is a method of quickly assigning metadata to a document being added to the 
repository using the FileHold Desktop Application. It allows you to “click” or “rubber band” text, 
numbers, dates, etc. on the screen and inserts the value into the metadata field of the schema. 
When using Click to Tag, the mechanism OCR’s (optical character recognition) the selected 
area on the screen. This makes is possible to extract values not just from the document but 
also from any external application accessible on the user’s computer.  

In order to use Click to Tag, it must be enabled in the User Preferences. Note that this setting 
may be overwritten by your administrator.  

When Click to Tag is invoked in the metadata pane, the user is prompted to open the 
document in the FileHold viewer, the document’s native application, or to not to open the 
document. Not opening the document allows you to tag the document using an alternative file 
or from another application.  

Once an option to tag the document is selected, the screen is covered with an opaque white 
mask called the “fold”. This indicates that the Click to Tag process is in effect. A tool tip 
displaying the metadata field name to tag is shown. You can then click or rubber band the 
value for the metadata field. After the first metadata field is tagged and validated, the next 
metadata field in the list can be captured. The process is repeated until all the values have 
been captured. The “fold” can be activated and deactivated at any time during the tagging 
process in the event that a document needs to be scrolled to other page, zoomed, or tagged 
from a different screen.  

When tagging metadata fields, read-only and auto-tagged fields are skipped from the tagging 
process. Check box type metadata fields are also skipped. For drop-down or drill down type 
metadata fields, the information that is being selected on the screen must be an exact match. If 
no matching value is found, an error message is displayed. Similarly, date type fields will need 
to be properly formatted on the screen or an error message is displayed.  

If no metadata fields are present in the selected schema, the Click to Tag button is not 
available. 

Note that the quality of the documents that are being tagged using Click to Tag need to be 
reasonably high. For this reason, only documents that are electronic in origin should be 
used with Click to Tag. Prior to using Click to Tag, you should test the tagging process 
with your various electronic documents to ensure that it will work well. 

Font/text size needs to be of a reasonable size as Click to Tag does not work well with small 
fonts. If Click to Tag is not working well with the current font size, zoom into the document to 
increase the size of the font on the screen. Due to various quality, font size, or font type 
reasons, some text may not be able to be read (ORC’d) from the screen and cannot be tagged 
using Click to Tag. In these cases, metadata values have to be entered manually. 

Scanned documents may present issues in tagging due to poor quality scans so for this 
reason, the OCR capabilities of your scanning software should be used to tag the documents 
and not Click To Tag. See the Knowledge Base for more information on scanning documents 
and importing metadata into the document management system. 

http://www.filehold.com/help/scanning/scanning-overview
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Click to Tag supports only the English language “out of the box”. This can be modified in the 

FDA.exe.config setting <add key="ClickToTagLanguage" value="eng"/>. For other 

language support, contact FileHold Professional Services at sales@filehold.com. 

TO ENTER METADATA USING CLICK TO TAG 

1. Add a new document(s) or select an existing document(s).  

2. Select a schema from the list if adding a new document. 

3. In the metadata pane, click Click to Tag.  

 

4. In the Click to Tag window, select one of the following options: 

 Open the document in the native application – The document opens in its native 
application. For example, if it is a PDF then it opens in Adobe Reader. 

 Open the document in the viewer – The document opens in the assigned viewer in 
the FileHold Desktop Application. You may need to undock the viewer, adjust the 
size, or move it to another monitor in order to tag the document. You can do this by 
closing the “fold”. See below for more information.  

 Do not open the document – Does not open the document in any viewer or 
application. Use this open to tag the document from an alternative file or from another 
application. 

NOTE: If you are tagging multiple documents at once, then this window does not 
appear. You will need to close the fold and open the document or application that you 
want to tag from and then open the fold again to proceed with tagging. 

5. Once an option is selected, the “fold”, a white opaque mask, appears over the screen. 
This indicates the Click to Tag process is in effect. You may need to deactivate and 
activate the fold to undock the viewer, adjust the size, scroll through a document, 
zoomed, or move it to another monitor, and so on in order to tag the document. To 
deactivate the fold, click Fold in the bottom right corner. To activate the fold, click the 
Unfold button. See the example screen shots below:  

mailto:sales@filehold.com
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 To deactivate or close the fold, you can also right-click on the activated fold and 
select Fold. 

 To move between windows, use Alt+Tab or the task bar instead of deactivating the 
fold.  

  

6. Once the document is opened in the selected viewer and the fold is activated, the first 
metadata field in the schema displays in a tool tip. Capture the value for the metadata field 
by: 

 A single word is captured by clicking on it. 

 Multiple words or lines are captured by dragging a rectangle round the words (rubber 
banding) All words located inside or intersecting the triangle are captured. See the 
example below: 
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7. Continue tagging the rest of the metadata fields in the schema using the click or rubber 
band methods. A tool tip displays each metadata field name.  

8. If you need to change a value or skip to another metadata field, right-click on the fold 
while it is activated. The list of metadata fields for the selected schema is shown. Select 
the desired metadata field name from the list. The metadata field that is currently being 
tagged has a check mark next to its name. 

 

9. If the value of the metadata field is not valid (does not match drop-down or drill down list 
value, invalid date format or check box) or cannot be read due to reasons (such as poor 
quality, font size, font type, and so on) an error message is shown stating the value is not 
valid. Click OK to retry tagging the value. 

 

10. Once the tagging is completed, right click on the activated fold and select Close.  

 Alternatively, click ESC to end the Click to Tag process. 

11. Click Save in the metadata pane to save the information. 

10.9.2. Entering Metadata Using Database Lookups 

Metadata information can be automatically populated into many metadata fields based on a 
single metadata “look up” value that comes from a database such as an accounting database 
or an ERP system. 
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If the administrator has configured the schema to use database lookups, you will see a Lookup 
button in the Metadata pane. Clicking this button after entering or selecting the value from the 
configured database drop down list metadata field retrieves any mapped values from the 
database into the remaining metadata field values of the schema. This can reduce the amount 
of time it takes to index a document with metadata. 

When the list retrieved from the database is presented to the user in the drop down list, only 
the first 100 items will be displayed in the FDA and the first 25 items in the Web Client. As the 
user scrolls through the list or starting typing the value, more values will be loaded into the view 
but is limited to viewing 100 (FDA) or 25 (Web Client) values at a time.  

If there are any blank required fields after the lookup is performed, you will need to enter those 
manually. The values of any read-only or automatically tagged fields are not affected by the 
database lookup. 

The Lookup button in the metadata pane is shown when adding a single document or when 
editing the metadata of a single document. You cannot do database lookups for several 
documents at once from the Inbox; look ups have to be done one document at a time. 

 

For more information on creating database drop down list metadata fields or setting the 
database lookup on a schema, see the Library Administration Guide. 

TO ENTER METADATA USING DATABASE LOOKUPS 

1. Do one of the following: 

 Add a single document to the document management system. 

 Select a single document in the Inbox. 

 Edit the metadata of a document in the library. 

2. Enter or select the value for the database drop down list metadata field that is configured to 
do the lookups.  
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 If you enter a value in the wrong metadata field, you will receive an error message 
“Missing value for <metadata field name>”. 

3. Click Lookup. All of the metadata fields that are configured will pull in the values from the 
database.  

4. Enter values in any other required metadata fields or modify any of the values that were 
retrieved. 

5. Click Add or Save. 

10.9.3. Editing Metadata 

If you have sufficient permissions (Document Publisher or higher role), you are able to edit the 
metadata for a document.  

TO EDIT METADATA 

1. Locate the document whose metadata you want to edit and open the metadata pane.  

2. Click Edit and make any changes to the existing values. 

3. Click Save. 

10.9.4. Using the Document URLs 

You can use the URLs provided in the Version Properties area of the metadata pane to send 
links to other FileHold users instead of sending the entire document. 

TO USE THE DOCUMENT URL LINKS IN THE METADATA PANE 

You can use the document links in the metadata pane to send in an email, add to a web page, 
or copy into a document. Depending on how your Library Administrator has configured it, you 
may be able to copy either or both the web client link and the FDA links. 

1. Select a document from the Library and open the Metadata pane. 

2. To copy the web client link, click Copy URL in the metadata pane. 

3. To copy the FDA link, click Copy FDA Link in the metadata pane. 

4. The link is copied and you can paste the link using Ctrl+V. 

TO LINK FDA AND WEB CLIENT URLS TO A WEB PAGE 

You can link both Web Client URLs and FileHold Desktop Application (FDA) URLs to a web 
page; however, these links still use the security set on the document. The user attempting to 
open a URL must have the cabinet, folder, and Schema permissions in order to access the 
document. 

1. Open the metadata pane for the document's link you want to copy. 

2. Under Version Properties > Document URL, click Copy URL for the web client URL or 
click Copy FDA Link for the FileHold Desktop Application link. 

3. You can paste these links into your web page using Ctrl+V. 

4. When the URL link is clicked from a web page, you will need log in to FileHold; either the 
web client or FileHold Desktop Application, depending on the link type. Both the FileHold 
Desktop Application (FDA) URL and the Web Client URL are maintained. 
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5. Once you are in FileHold, the document will appear highlighted in the folder list. You can 
get a local copy, check out, view version history, etc. 

10.9.5. Copying Metadata 

You can copy metadata values when the metadata panel is in its editable or non-editable form. 

TO COPY METADATA 

1. Select a document and open the metadata pane. 

2. Right-click and select Copy. 

10.9.6. Workflow Documents 

You are able to view the status of a workflow in the Metadata and File Properties panel. 

TO VIEW THE STATUS OF A WORKFLOW DOCUMENT 

1. Select the document whose status you want to view and open the metadata pane. 

2. Under Version Properties > Approval Status, view the status of the document. Click on 
the link to see the sign-off sheet. 

10.9.7. Setting the Destination Folder 

You will need to determine which folder the documents will reside in the library structure. You 
can set the destination for one or more documents at a time from the Inbox. 

TO SET THE DESTINATION FOLDER FOR DOCUMENTS 

1. From the Inbox, select one or multiple documents to be filed under the same folder and 
click Edit Destination from the toolbar. If setting the destination for multiple documents, 
do not use the Set Destination link. 

2. From the Select Location window, browse to the folder location in the library tree and 
click OK. The destination for the documents will be shown in the Inbox. 

10.10. PERMISSION ICONS 

The following permission icons can be seen for each document in the system.     

Permission Icon Description 

 Red, Yellow and Green Dots indicates that the user has full access to 
that file in the document management system and is able to read, edit 
or delete the document. This document is being stored as an 
electronic document type and not as an electronic record and can 
therefore have multiple versions associated with it. 

  
Red and Yellow Dots indicate that the user can only read or edit the 
document. 

 Red Dot indicates that the user has Read-Only access to the 
document. This could indicate that the user has read-only 
permissions, the document is checked out by another user, or under 
workflow. 
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Permission Icon Description 

 Gray Dot - indicates that the document is an electronic record and not 
an electronic document type. This means that there will only be one 
version of this file and there are very strict restrictions for all users for 
the deletion of this document. 

 
Rectangle with Dot - indicates an external/physical documents (called 
an "off-line document”) for which metadata is available but there is no 
electronic file associated with it in the documents management 
system 

H!  "H" - indicates that the document version is hidden while it is 
undergoing a workflow - the "H" is only seen by those that are 
observers or participants of the workflow 

!   "!" - indicates that the current document is under workflow. Only 
previous versions are available at this time. The "!" is seen by those 
who are not observers or participants of the workflow 

 

10.11. DELETING FILES 

You may only delete files if you the correct permissions and are owner of the document. You 
can also delete previous versions of a document. 

TO DELETE A FILE 

1. Select the document name and click Delete X. 

10.12. CHECKING IN AND CHECKING OUT DOCUMENTS 

Document version control ensures that changes made to documents are not accidentally 
overwritten by other users. Checking out a document “locks” the document and prevents others 
from making changes. Users can still get a local copy of the document (read-only) when a 
document is checked out. 

A unique copy of every version of a file checked into the system is retained to ensure that 
documents can be reverted back to a previous version if needed. To view all versions of a 
document, see the Version History. 

It is important for users to remember to check documents in once they are finished editing. 
Users cannot view your changes or check the document out until the document is checked 
back in. To view all of the documents that you have checked out, go to My FileHold > 
Checked Out Documents. 

When the file is checked out, its status is set to Checked Out. In the Version Properties area 
of the Metadata pane, you can see who checked out the document and the date and time it 
was checked out. When a document is checked in, its status is set to Checked In. 
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TO CHECK OUT A DOCUMENT  

1. Locate the document you want to check out in the Library and do one of the following: 

 Click Check Out  from the toolbar. 

 Right-click and select Check Out This Document. 

 To check out and open the file in its native application, hold the Ctrl key and double-
click the document name. 

2. The document status changes to Checked Out and is downloaded to your working folder. 
Your working folder is typically C:\Users\username\Documents\My FileHold Documents. 
The working folder location is set in your User Preferences. 

 If you selected to check out and open the file, it will open in its native application. For 
example, a .doc document will open in Microsoft Word. 

10.12.1. Checking in Documents  

Only the user that checked the document out of the records management system can check 
the document back in. You can check in a document from anywhere the document shows up in 
the system such as the folder location, My Checked out Documents, or a Microsoft Office 
application. 

Documents can be deleted automatically upon check in if the setting ““By default delete 
documents that I Check In to FileHold” is enabled in the User Preferences. It may also be 
locked down by an administrator and cannot be modified. 

It is possible to enable the setting “Edit metadata upon Check In action” in the User 
Preferences so that the metadata pane opens for editing after checking in a document into the 
document management system. If configured to do so, then the metadata pane automatically 
opens upon check in so the values can be modified. This option can be locked down by a 
System Administrator.  

It is also possible to blank out the values for all required fields in a schema by enabling the 
setting “Clear required metadata fields upon Check In” in the User Preferences. If enabled, 
then all required metadata fields (marked with an asterisk *) in the schema are cleared forcing 
you to enter new values upon check in. This option can be locked down by a System 
Administrator. See the System Administrator Guide for details. 

TO CHECK IN FROM MY CHECKED OUT DOCUMENTS 

1. Select document and do one of the following: 
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 Click Check In from the toolbar  

 Right-click on the document name and select Check In This Document. 

2. Click Browse to go the folder location where the document that you are checking in 
located, if needed. FileHold keeps track of where the document was downloaded to so if 
the document is still in the same location, the path is automatically entered. 

3. Select any of the following options, if available/applicable: 

 Edit metadata for these document(s) before check-in – This option opens the 
metadata pane so the metadata field values can be edited. This option may be 
automatically selected if the option “Edit metadata upon Check In action” is enabled 
in the User Preferences. It may also be locked down by an administrator and cannot 
be modified.  

 Delete the local copy of this file after it has been successfully checked in – This 
option removes the local copy of the file from the user’s computer. This option may 
be automatically selected if the option “By default delete documents that I Check In to 
FileHold” is enabled in the User Preferences. It may also be locked down by an 
administrator and cannot be modified. 

 Email notify all folder members that these documents) have been checked in – This 
option sends an email to all users and groups that have access to the folder. This 
option may not be available, depending on the Library Administration settings. See 
the Library Administration Guide for more information.  

3. Click Check In.  

4. If the options “Edit metadata upon Check In action” or “Clear required metadata fields upon 
Check In” are enabled, fill out the required metadata values in the metadata pane and click 
Save.  

TO CHECK IN DOCUMENTS FROM MICROSOFT OFFICE AND OUTLOOK 

1. From a Microsoft Office application, select Send to FileHold > Check In Document or 
click the Check In icon from the FileHold toolbar.  

 In Office 2007 and 2010 these commands are located in the Add-Ins tab. 

TO CHECK IN AN UNCHANGED DOCUMENTS (UNDO CHECKOUT) 

1. After checking in a document, a window will prompt you to select the new version the 
document. At the top of the box is the option 'I have not changed these document(s). 
Please undo the check out of these files'. Select the check box to undo the check out 
leaving the last version of the document as the most recent version.  

 If this option is not selected the when the user clicks the Check-In button, the “new” 
file will upload to the documents management system as the latest version of the file. 

TO CHECK IN MULTIPLE DOCUMENTS  

1. From the My Checked Out Documents view, select the documents to check in and click 
Check In. 

 This option is not available through the Web Client. 

  Alternatively, use the Working Documents feature to check in multiple documents at once. 
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10.13. COPYING OR MOVING FILES 

The Copy or Move function in FileHold allows you to make a copy of a document and/or move 
it to another location in the library. 

In order to move or copy documents, Document Publishers and Publishers need to have 
ownership of the document. Users who are Organizers or higher permissions can move 
documents owned by anyone. Restrictions on where a document can be moved to will apply. 

TO COPY OR MOVE A FILE 

1. Select one or many documents. 

2. Right-click and select Copy or Move. 

3. In the Copy/Move window, select one of the following options: 

 Move files to a new location in the library  

 Copy files to a new location in the library 

4. Click Next.  

5. Select the destination in the library for the documents or folder and click OK. The documents 
are moved and/or copied to the new location. 

10.14. MAKING A LOCAL COPY 

You can make a copy (download) of a document to your local machine. The document is 
downloaded to the working folder location specified in your User Preferences. This is typically 
in the location C:\Users\username\Documents\My FileHold Documents.  

TO MAKE A LOCAL COPY OF A DOCUMENT 

1. Locate the document in the Library and click Make a Local Copy  from the toolbar. 

2. The document is downloaded to your working folder location. 

10.15. EMAILING, AND EMAILING AND CHECKING OUT DOCUMENTS 

You are able to email and “email and check out” documents from the Library. When sending 
files from the document management system, it is important to send the file in a manner that 
allows the other user to access the information while keeping sensitive data safe. 

When emailing a link or attachment, emails retain the properties of your Microsoft Outlook 
messages including signature blocks and other added items like legal disclaimers. 

There are two ways to send files: 
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 Send as an attachment – Attachments are the most common way of sharing files via email; 
however, they are the least secure as anyone who receives the attachment can open the 
document. 

 

 Send as a link – Links are not as common as attachments when sharing documents; 
however, they are the most secure. Those that do not permission in the document 
management system to access the file will be unable to open the document via the link. In 
other words, in order to access a file via a link, the recipient must also have access to the 
document in the system. Both the Web Client URL and FDA link are appended to the body 
of the email.  
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NOTE: Users can also send a link using the Copy URL or Copy FDA Link in the Metadata 
pane. The link can then be pasted into an email. See Adding Metadata and File Properties for 
more information. 

TO EMAIL A DOCUMENT 

1. Locate the file you want to email in the Library and click Email  on the toolbar.  

2. In the Email Attachment Settings window, select one of the following and click OK: 

 Attachments to the email – Sends the document as an attachment to the email. 

 Links at the end of the email body – Appends the FDA and FOC (web client) to the 
body of the email. When a user clicks on the link, the user will need to login to 
FileHold to access the document. If the user does not have the correct permissions 
they will not be able to access the document.  

NOTE: The Library Administrator can configure the system to send files as either an 
attachment or as a link or allow the user to decide. If the function is set to allow the user to 
decide then they will be prompted to select an option. If not, the file will automatically be 
inserted into the email in the format chosen by the Library Administrator. See the Library 
Administration Guide for more information. 

 

3. The email message is created in Microsoft Outlook with either the attachment or the links 
appended to the body of the email. 

TO CHECK OUT AND EMAIL A DOCUMENT 

1. Locate the file you want to email in the Library and click Check Out and Email  on the 
toolbar. 

2. In the Email Attachment Settings window, select if you want to send the document as an 
attachment or a link and click OK. See the previous section for details. 
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3. The email message is created in Microsoft Outlook with either the attachment or the links 
appended to the body of the email. The document is also checked out of the system and 
the status is changed to “checked out”.  

 

10.16. LINKING DOCUMENTS 

The ability to link documents together is a key feature that helps to organize documents into 
logical groups. Links give users quick and efficient access to files that are related to the 
document they are working with no matter where the file is stored in the Library. For example, 
a master contract document may be linked to its amendments.  

The Linked column is visible in most views and shows the total number of documents that are 
directly linked to that document. These links may be of either parent or child relationship. 

Linking maintains a parent-child relationship between the documents that are linked together. 
In other words, one document, the “parent”, will serve as the main document that all other files, 
the “children”, will refer to. When linking two or more documents together the user must specify 
the parent document in the linking relationship. 

You are able to link documents that are in the same folder or from disparate areas of the library 
such as the search results, virtual folder, or document tray. 

TO VIEW DOCUMENT LINKS 

1. From the Linked column, double-click on the linked number. 

2. The Documents linked to Document Name panel opens. All of the documents that are 
linked to the selected document are shown. 

3. Click on the Up or Down arrow in the Parent/Child column to view the parents (Up arrow) 
or children (Down arrow) of the linked document. 
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TO CREATE A LINK BETWEEN TWO OR MORE DOCUMENTS IN THE SAME FOLDER 

1. Select the files that are to be linked within a folder. At least two files must be selected. 

2. Click Link. 

3. In the Create Links Between Documents window, select the “parent” document from the 
list and click Link. The other files are considered “children” to the “parent” file. The 
documents are linked. 

TO CREATE LINKS BETWEEN DOCUMENTS FOUND IN A SEARCH  

1. Run a search. 

2. Select the documents to link together and click Link. At least two files must be selected. 

3. In the Create Links Between Documents window, select the “parent” document from the list 
and click Link. The other files are considered “children” to the “parent” file. The documents 
are linked. 

TO REMOVE DOCUMENT LINKS 

1. From the Linked column, double-click on the linked number. 

2. The Documents linked to Document Name panel opens. All of the documents that are 
linked to the selected document are shown.  

3. Select the document and click Remove Link. The link will be removed. 

TO LINK DOCUMENTS IN THE DOCUMENT TRAY 

1. “Move” all of the documents you want to link into the Document Tray. 

2. In the Document Tray, select the files you want to link and right-click to select Link 
Documents. 

3. In the Create Links Between Documents window, select the “parent” document from the 
list and click Link. The other files are considered “children” to the “parent” file. 

4. The documents are now linked. You can see how many files a document is linked to in the 
Linked column. 
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10.17. CHANGING THE DOCUMENT VERSION OWNER 

Organizers and Cabinet Administrators, for cabinets they own, can change the ownership of a 
document version. You can change ownership for one document at a time; it cannot be 
performed en masse. 

This is useful when certain users need to initiate workflows and the system administrator 
permission setting “Allow non document version owners to initialize workflows” is not enabled. 
For example, in a workflow template, the task can automatically be assigned to the document 
owner instead of having to set the user name each time a workflow is initiated. See Manually 
Initiating a Workflow for more information.  

 

TO CHANGE THE OWNERSHIP OF A DOCUMENT VERSION 

1. In the FDA, right-click on the document and select Change Document Owner. 

 In the Web Client, using the context sensitive menu, select Change Document 
Owner. 

2. In the Find People window, enter a first and/or last name and click Find Now. 

3. In the search results, select the user and click Select. The ownership of the document is 
changed to the selected user. 

10.18. CREATING SHORTCUTS TO DOCUMENTS 

Document shortcuts allow you to create and place shortcuts to documents in any folder that the 
user has access to in the Library. Users with Publisher role or higher can create shortcuts 
between several folders that they have access to. 

Creating shortcuts does not make a copy of the document; it is only a link to the original 
document location. 

WARNING: This functionality may be disabled. Contact your System Administrator for 
information. 

TO CREATE A DOCUMENT SHORTCUT 

1. Right click on the document and select Create Shortcut.  

2. Choose a folder in the Library that you want to put the shortcut in and click OK. 
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3. The location of the document shortcut opens. The document will have an icon with an 

arrow on it  indicating that is a shortcut. 

10.19. RENAMING DOCUMENTS 

You are able to rename documents in the Library if you have access and have a role of 
Publisher or higher. 

TO RENAME A DOCUMENT 

1. Right-click on a document and select Rename. 

 You can also click the Edit link that is in line with the document name in the folder or 
search view. 

 You can also edit the file name in the Metadata pane. 

2. Enter a new name for the document and click Save. 

 

10.20. EXPORTING DOCUMENTS 

You can export all documents from a cabinet, drawer, folder groups, or folders using the Export 
option. You can also export one or more documents from a folder. Once the Export command 
is selected, you can select where you want to export the documents on your local machine. 

When documents are exported, they are exported with a XML file and a Documents folder 
containing all of the exported documents in their native format. The XML file stores the 
metadata of all the selected documents in a FileHold compatible format. This allows for the 
importation of the documents back into the document management system. For example, if 
you are exporting documents out of a demo system and importing them back into a production 
system. 

Exporting can be done by users with a Document Publisher role or higher if they have access 
to those areas and are dependent on the role that you have: 
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Role Can export 

Document Publisher, Document Publisher + 
Delete 

Documents that they own. 

Publishers, Publisher + Delete Documents, folder groups, and folders that 
they own. 

Organizer, Organizer + Delete Any documents, any folder groups and any 
folders for the cabinets they have access to. 

Cabinet Administrators If not a cabinet owner: documents, folder 
groups, and folders that they own. 

If a cabinet owner: all drawers, folder groups, 
folders, and documents. 

Library and System Administrators All areas of the library structure and 
documents. 

TO EXPORT DOCUMENTS FROM THE DOCUMENT MANAGEMENT SYSTEM 

1. Right-click on a cabinet, drawer, folder, folder group, folder or document(s) name and 
select Export or Send to > Export. 

2. You will receive a warning message asking if you want to continue with the export: "If you 
are attempting to export x number of documents. Are you sure you want to continue?" 
Click OK to proceed with the export. 

3. Browse for the folder location where you want to export your documents and click OK. The 
documents are exported to the selected location in the Documents folder along with the 
XML file that contains the metadata information for each document. 

10.20.1. Converting Documents to Offline and Exporting 

When converting an electronic document to an offline document, the files can be exported to or 
destroyed. All versions of the electronic document are deleted from the document management 
system. Once the documents are exported, the documents are converted to offline. You can 
only convert documents to offline if you are a Library Administrator or higher. 

When documents are exported, they are exported with a XML file and a Documents folder 
containing all of the exported documents in their native format. The XML file stores the 
metadata of all the selected documents in a FileHold compatible format. This allows for the 
importation of the documents back into the document management system. 

NOTE: In order to convert electronic documents to offline documents, the permission needs to 
be enabled in the System Administrator Permission Settings area. 

TO CONVERT DOCUMENTS TO OFFLINE AND EXPORT THEM 

1. Right-click on a document name and select Convert to Offline. 

2. You will receive an alert message warning: "Alert: Selected documents will be converted to 
offline documents. The files associated with all versions of these documents will be 
permanently deleted. This operation cannot be undone. Do you wish to proceed?" Click 
OK. 

3. Select one of the following options and click OK: 

 Convert to Offline and Destroy Files - This will permanently delete all versions of the 
document. 
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 Convert to Offline and Export Files - This will permanently delete all versions of the 
document and allow you to export the electronic documents out of FileHold. 

4. If you are exporting the file, browse for the folder location where you want to export your 
documents and click OK. The documents are exported to the selected location in the 
Documents folder along with the XML file. 

10.20.2. Importing Exported Documents 

When documents have been exported from the document management system using the 
Export function mentioned above or using the FileHold Instrumentation Tool, you can import 
them back into FileHold using the Manage Imports Tool in the FileHold Desktop Application. 
See the Library Administrator Guide or online help for more information.  

10.21. DOWNLOADING DOCUMENTS TO A LOCAL FOLDER 

You can download a copy of document to a folder on your local computer. You can browse to 
where you want the document downloaded. Users with a document publisher role or higher 
can access this function. 

TO DOWNLOAD A DOCUMENT TO A LOCAL FOLDER 

1. Navigate or search for the document you want to download. 

2. Right-click on the document name and select Send To > Local Folder. 

3. Select the folder location on your local computer and click OK. 

4. A copy of the document is downloaded to the folder. 

10.22. VIEWING VERSION HISTORY 

The document management system retains a unique copy of each version of each file as it is 
checked out and back into the Library. When a document is checked in and changes have 
been made, FileHold automatically creates a new version of the document. FileHold versioning 
are simply numbered as 1,2,3,4, and so on. You can create your own numbering system with 
document control and version control numbers. See the Library Administration Guide for more 
information. 

When viewing a list of documents (folder view, search view), only the most recent version of 
the document is displayed. The 'Ver' column shows the number of versions of a given 
document. You can view previous versions of a file through the version history. 

 

When document is added to the library, it starts as version 1 and is "owned" by the person who 
added a document. As the document is checked out and checked back in, that number 
increases by 1 and the "owner" of the version changes to the person who has checked the 
document in. For example, Paul added a file to the document management system. That file 
starts as version 1 and is owned by Paul. Sally has access to the file and decides to check out 

http://www.filehold.com/help/home
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the file in order to modify it with the latest report information. Sally checks the file back into the 
system. That file is now at version 2 and is owned by Sally. 

10.22.1. Viewing Previous Versions of a Document 

When viewing the version history of a document, the "History of Document Versions for 
Document Name" window opens with the list of the previous versions of the document shown. 
The document name, document type, number of linked documents, version number, status, 
last modified on date, owner, and approval status is shown in the view. This view cannot be 
modified.  

You can get a copy, delete, or email older versions of documents. You cannot check out, check 
out and email, or link older versions of documents. In order to work with an older version of a 
document, you can reinstate it as the current version (see below) or download a copy and 
upload it into the document management system as a new document. 

TO VIEW PREVIOUS VERSION OF A DOCUMENT 

1. Select a document and click on the number of versions link in the Ver column.  

 Alternatively, click on View all versions in the Version Properties area of the 
Metadata Pane. 

2. A list of the previous versions will appear. To go back to the folder list, click Back to 
Folder. 

10.22.2. Deleting Previous Versions 

Library Administrators or document owners that have Document Publisher + Delete 
permissions are able to delete previous versions of files. Document owners may only delete 
the previous version of a document whereas Library Administrators can delete any version(s) 
of the file in the document management system. This means that the versions shown in the 
version history list are the ones that have not been explicitly deleted. 

TO DELETE A PREVIOUS VERSION OF A DOCUMENT  

1. View the Version History of a document. Select the version you want to delete and click 
Remove (X).  

2. In the Delete Files window, select a deletion option: 

 Delete only the versions of the files I have selected. 

 Delete all versions of each file that I have permission to delete. 
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3. Click OK. The version of the document is removed. If you need to recover the document, 
contact your Library Administrator. 

10.22.3. Reinstating a Previous Version as the Latest Version 

When viewing previous versions of a document the user can reinstate any of the previous 
versions of the document as the latest version. This is useful because you can only work with 
the latest version of a document. For example, the current version is 5 but a lot of mistakes 
occurred in that version and you would like to restart from version 4. Since you cannot check 
out version 4, you can reinstate it as the latest version (which would be 6) in order to check out 
and work on the document.  

TO REINSTATE A PREVIOUS VERSION AS THE LATEST VERSION 

1. Select a previous version of a document and click Reinstate as Latest Version. 

2. In the Reinstate as Latest Version window, select one of the following options: 

 Yes, reinstate the selected version’s metadata. 

 No, keep current metadata values. 

 

3. Click OK. The document is reinstated as the latest version. In other words, the version 
number will increase by 1 with the older document as the latest version. 

10.22.4. Viewing Edits to Metadata for Older Document Versions 

The system logs all edits to metadata for each version of a document.  

TO VIEW EDITS TO METADATA 

1. To view the metadata edits for a version of a document, select the version(s) from the 
history of versions list and click Edits to Metadata.  

2. To view a detailed description, click Show Metadata Edits link in the Metadata Change 
History view. The metadata pane opens with a list of who made the metadata change, 
when it was made and what was changed. Any changes are shown in bold font.  

10.22.5. Viewing the Document Usage of Document Versions 

You can view how one or more of a document version has been used. The document 
management system tracks how a document has been used. For example, if a document has 
been emailed, checked out, linked, viewed, and so on you can see what actions have been 
taken on a document. You can see who the action performer is and when the action was 
performed plus any details pertaining to the action (such as a change in ownership.  

Library Administrators can also use the Document Usage Log to see how documents were 
used. 
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TO VIEW THE USAGE OF A FILE 

1. In the Version History list, select one or more (using the CTRL or SHIFT keys) document 
versions and click Usage of File. 

2. The File Usage for Document Name window opens with a list of all of the actions taken 
upon the document versions, which user performed the action and when the action was 
performed. 

3. To return to the version history, click Version History. 

10.22.6. Viewing the Sign Off Sheet 

The Sign Off Sheet shows a list of all users that either approved or rejected this version of the 
document, when they did it and if they signed-off on behalf of someone else. 

If this was a multi-document workflow, all documents that were a part of the approval process 
will be shown in the sign off sheet. 

TO VIEW THE SIGN OFF SHEET 

1. In the folder or search view, do one of the following; 

 In the FDA, right-click on a document and select Workflow > View Sign Off Sheet. 

 In the Web Client, click the arrow next to the document name and select Sign Off 
Sheet.  

 In the Version History screen, click Sign-off Sheet. 

2. The Sign Off Sheet pane opens below with a list of all users that have approved or 
rejected all of the documents in the workflow. 

3. Click X to close the Sign Off Sheet pane. 

10.22.7. Viewing Workflow Reviews and Approvals 

The review and approval history shows each task that was completed in the workflow. The first 
level in the workflow shows information about the workflow instance itself. Information includes 
the type of workflow (the workflow template name), the name and version of the document, 
who the initiator is, when the workflow started and when it is due and if the workflow resulted in 
the document being approved or not.  

To expand the workflow details, click the + sign in the FDA or the > arrow in the Web Client 
next to the document name. In the task details, the percentage completed, the comments or 
feedback documents provided by participants, the completion date, the due date, and status 
(reviewed or approved) is shown. 

The review and approval history can only be seen by those users who have completed the task 
and senior administrators. 

TO VIEW THE WORKFLOW REVIEWS AND APPROVALS 

1. In the folder or search view, do one of the following; 
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 In the FDA, right-click on a document and select Workflow > View Review and 
Approval History. 

 In the Web Client, click the arrow next to the document name and select Review and 
Approval History.  

 In the Version History screen, click Reviews & Approvals. 

2. The Document Review and Approval History window opens with a list of all workflow 
tasks. 

3. To print the list of reviews and approvals click Print (FDA only). Note: The report will be 
printed exactly how it appears on the screen. 

4. To export the list of reviews and approvals click Export (FDA only). When exporting the 
report, you can choose to export only the workflow or you can include both the workflows 
and the tasks. The report can be exported to CSV or HTML. Note that for the HTML 
report, the workflow must be expanded in the Workflow Status Report results to print the 
tasks. In other words, the HTML report will be exported to look exactly how it appears on 
the screen. 

5. To return to the version history, click Back to Version History. 

6. To return to the folder, click Back to Folder. 

10.23. SETTING DOCUMENT ALERTS AND REMINDERS 

Document alerts allow you to be alerted of changes that occur to files or folders kept in the 
library. For example, a user in payroll subscribes to an Expense Reports folder that notifies 
them of when an expense report needs processing by sending an alert. You can choose to set 
alerts on both folders and/or documents. Once changes have been made to either the folder or 
the document, you receive an alert in the Document Alerts area of My FileHold. You can set 
the type of document or folder changes you want to be notified of and the email address to 
send the notifications to in your Alert Preferences. 

Users can also be notified via email and alerts of specific date based events called User 
Defined Events. For example, policies must be updated or reinstated at least once every three 
years. The policy team would like to review the documents 60 days before the three year 
anniversary. The event can be set up so that every three years, the owner of the policy will be 
notified 60 days prior to the policy expiry date. User defined events are set on the document 
schema by the Library Administrator. For more information, see the Library Administration 
Guide. 

Document reminders allow you to be reminded of when a document requires attention in the 
future. For example, you can be reminded monthly to update expense reports or to review 
yearly employee contracts that are up for renewal. Once a reminder comes due, you receive 
an email (if configured) and an alert in the Document Reminders area of My FileHold. You can 
set reminder preferences in your Alert Preferences. 

TO SET AN ALERT ON A FOLDER OR DOCUMENT 

1. Right-click on a folder or document and select: 

  Alert Me of Changes on a folder. 

 Notify Me > Alert Me of Changes on a document. 

2. You will receive a message stating that “You have subscribed to be alerted when this file 
changes”. Click OK. 
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If you subscribed to a folder, the folder icon will have an email icon on it  indicating 
you are subscribed to the folder.  

3. You will receive email notifications about your alerts if the system has been configured. 
You can also view and manage your alerts in My FileHold > Document Alerts. See how to 
manage your alerts.  

TO SET A REMINDER ON A DOCUMENT 

1. Right-click on a folder or document and select Notify Me > Set a Reminder on a 
document. 

2. In the Add Reminder for Document Name window, enter the date in which you wish to 
receive the reminder.  

3. Enter the frequency in which you wish to receive the reminder: Once Only, Daily, Weekly, 
Monthly, Quarterly, Bi-Annually, or Annually. 

4. Click OK. 

5. You will receive email notifications about your reminders if the system has been 
configured. You can also view and manage your alerts in My FileHold > Document 
Reminders. See how to manage your reminders. 

10.23.1. Managing Alerts and Reminders 

Users can view and manage their document subscriptions (alerts and reminders) in the 
Document Alerts and Document Reminders areas of My FileHold. 

Document reminders are those documents that require attention on a certain date and time 
period. You can view your document reminders in My FileHold > Document Reminders. You 
may also receive an email notification if your alert preferences are configured to do so. 

Document alerts are those documents or folders that have been set to trigger an alert. You can 
view your document alerts in My FileHold > Document Alerts. You may also receive an email 
notification if your alert preferences are configured to do so. Folder alerts are triggered when:  

 New documents are added to the folder.  

 Documents are transferred to the folders.  

 Documents are deleted from folders.  

Document alerts are triggered when: 

 A new version of a document is checked in. 

 Metadata values are updated.  

Users can also be notified of specific date based events called User Defined Events. For 
example, policies must be updated or reinstated at least once every three years. The policy 
team would like to review the documents 60 days before the three year anniversary. The event 
can be set up so that every three years, the owner of the policy will be notified 60 days prior to 
the policy expiry date. User defined events are set up by the Library Administrator only. See 
the Library Administration Guide for more information. 

In order to receive any new alerts on a document, the current alert must be "marked as read". 
Once documents are marked as read, then any new alerts are emailed and appear in the 
Document Alerts folder. 

Users must be subscribed to the folder or document prior to receiving an alert. See Setting 
Document Alerts and Reminders.  
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You can determine which type of alerts you want to receive by setting the Alert Preferences. 
See Alert Preferences for more information. 

TO MARK AN ALERT OR REMINDER AS READ 

1. Go to My FileHold > Document Alerts or Document Reminders and select an alert or 
reminder. 

2. Click Mark as Read. The alert or reminder is removed from the list. 

TO REMOVE AN ALERT OR REMINDER 

1. Go to My FileHold > Document Alerts or Document Reminders and click Manage 
Alerts or Manage Reminders. 

2. In the Manage My Alerts or Manage My Reminders window, select the file or folder you 
want to remove the subscription to and click Remove X. 

 

TO DISABLE AN ALERT ON A FOLDER 

1. Right-click on a folder that has an alert and select Disable this Alert. 
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11. LIBRARY ARCHIVE 

The Library Archive is the area where documents that are no longer in use but still need to be 
kept for historical record purposes reside. The advantage of archiving is that it keeps your 
current documents in the Library and search results uncluttered with old or obsolete 
information. Once documents are in the Library Archive, they can still be searched using the 
Include Archive in Search check box under the Advanced Search area. 

Documents can be archived using two methods: 

 Manually archiving. Users with a cabinet administrator role or higher can move electronic 
documents manually from the library into the library archive. Cabinet and Library 
administrators must be the owners of the cabinets in the library archive area in order to 
move documents in and out of the archive. You need to enable event functionality in Web 
Client > System Administrator > General Settings. 

 Using a scheduled event to automatically archive documents. See the Library 
Administration Guide for more information on scheduled events. 

Documents that have been placed in the document Archives section of the document 
management system can be: 

 Left in the document Archives indefinitely. 

 Deleted from the document Archives using an Event Schedule. See the Library 
Administration Guide for more information on scheduled events. 

 Moved back into the Library manually should the need arise.  

When documents are sent to the archive, the cabinet/drawer/folder group/folder structure is 
automatically duplicated. There is no need to recreate the structure. The security settings at 
the cabinet and folder levels are also maintained.  

TO MANUALLY SEND A DOCUMENT, CABINET, DRAWER, FOLDER GROUP, OR FOLDER INTO THE 

ARCHIVE 

1. Right-click on a folder and select Archive Folder or document and select Send to > 
Library Archive. 

2. The documents and/or folders are sent to the Library Archive and the cabinet/drawer/folder 
group/folder structure is copied as well.  

TO MOVE ARCHIVED DOCUMENTS OR FOLDERS TO THE LIBRARY 

1. In the Library Archive, select the document or folder and select Copy or Move. 

2. Select the Move files to a new location in the Library option and click Next. 

3. Select the destination in the Library for the documents or folder and click OK.  

4. At the alert message click OK. The documents and/or folder are moved back to the Library. 
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12. USING THE DOCUMENT TRAY 

The Document Tray allows users to collect and perform actions on documents that are filed in 
various folders throughout the system. The document tray behaves much like a shopping cart 
in an e-commerce application in that it provides a temporary holding bin for documents that 
users wish to perform actions on. 

The Document Tray helps users perform the same actions on documents that are stored in 
different folders. All actions available on the toolbar and right click commands are supported in 
the document tray including get copy, check out, move/copy, email, link and delete. 

NOTE: Documents that are in the Document Tray are not copied or moved. The Document 
Tray is only making reference to the documents located elsewhere in Library. 

TO OPEN THE DOCUMENT TRAY 

1. In FDA, click on the Document Tray icon  on the lower right side of the screen.  

 In the Web Client, click Document Tray located at the top of the hierarchy panel.  

 

The Document Tray opens at the bottom of the screen. In FDA, you can adjust the size of 
the Document Tray using the slider arrow. The Document Tray in the Web Client is self-
adjusting. It will expand to fit the documents automatically. 

 

Document Tray in FDA 

 

Document Tray in Web Client 

TO ADD DOCUMENTS TO THE DOCUMENT TRAY 

1. There are many ways to send documents to the FileHold to the Document Tray. Do one of 
the following: 
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 In FDA, select the document you wish to add to the document tray. Right-click on the 
file and select Send to > Document Tray. You can select multiple documents and 
send them to the Document Tray en masse. 

 In the Web Client, place a check mark next to the documents you want to move into 
the Document Tray and select Sent To > Tray. 

 In FDA, drag and drop document(s) from one or more folders and into the Document 
Tray.  

WARNING: You cannot drag and drop documents in the Web Client. 

TO REMOVE FILES FROM THE DOCUMENT TRAY 

1. Select the documents you wish to remove from the tray and click Clear. 
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13. USING THE DOCUMENT VIEWER 

Viewers have many user features and many benefits that increase productivity and save 
companies money. Viewers are purchased on a per user basis and assigned to registered 
users by the System Administrator. Two different viewers are available for purchase with 
FileHold: 

 Brava Viewer (3 levels) 

 PDF/Image Viewer 

If the Brava viewer is purchased (any level), customers receive the PDF/Image viewer at no 
additional cost. If a user is assigned a Brava viewer license, they can also use the PDF/Image 
viewer with the Brava viewer, with the Brava viewer being the default viewer. 

In order for a user to use one of the viewer types, they must be assigned a viewer by the 
System Administrator.  

13.1. BRAVA VIEWERS 

FileHold’s document management system can be customized to include one of three versions 
of the powerful Brava Document Viewer. The following are the three levels of Brava viewers 
available: 

 Enterprise Office Viewer 

 Enterprise Office Viewer with CAD support 

 Enterprise Office Viewer Engineering Edition 

The viewer allows users to open, read and work with a myriad of file formats, even if they do 
not have the proper application. To see the complete list of file formats that are supported by 
the Brava viewer, go to www.filehold.com/help/home. 

The viewer comes with other functionalities that allow users to convert files and publish them in 
PDF, TIFF, DWF, CSF formats and it also supports watermarking and other mark-up features, 
secure document creation with digital rights protection, redaction and printing. 

The Brava Document Viewer is an optional component of the FileHold document management 
software and comes with three licensing options. These options control the type of file formats 
that a given user can open. The viewer can only be used by the FileHold Desktop Application 
(FDA). 

To learn more about these features and what else Brava document viewer can do click on 
Help (?) located in the Brava viewer window. 

TO USE THE BRAVA VIEWER (ANY VERSION) 

1. Select a document from the Library and click the Document Viewer icon  in the 
bottom right corner of the window. 

2. Alternatively, right-click on a document and select Open in Document Viewer. To learn 
more about these features and what else Brava document viewer can do, click on Help (?) 
located in the Brava viewer window. 

NOTE: System Administrators are responsible for assigning the viewer licenses. 

file:///C:/Users/renee.FILEHOLD/Documents/My%20FileHold%20Documents/www.filehold.com/help/home
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13.2. PDF/IMAGE VIEWER 

The PDF/Image Viewer differs from the Brava Viewer. It supports the following file formats 
only: 

 PDF 

 TIFF (single or multi-page) 

 Image files (jpg, png, gif, bmp) 

If a user is assigned a PDF/Image viewer license then can only use the viewer for documents 
with the file extensions listed above. The Brava viewer supports several different types of file 
formats but does not allow you to remove or reorder pages in a PDF document. 

The PDF/Image Viewer allows users to: 

 Reorder pages in a PDF or multiple paged TIFF document 

 Open documents in FileHold or from your local computer. 

 Open multiple documents at a time. Each file is shown on a separate tab. Note that the 
tabbing feature needs to be enabled in the User Preferences > Advanced tab. 

 View thumbnails of a multi-page document. 

 Reorganize pages of a PDF or multi-page TIFF image using drag and drop. 

 Append an image to the current image file. 

 Insert an image from one image file to another image file using drag and drop. 

 Delete pages. 

 Select multiple pages of the document via the thumbnails. 

 Saved the altered document to FileHold or to your local machine as a PDF, JPEG, or TIFF 
only. 

 Print the document. 

 Undock the viewer so it is in its own window. 

If a user is assigned a Brava viewer license, they can also use the PDF/Image viewer with the 
Brava viewer, with the Brava viewer being the default viewer. They can use the function Open 
to Reorder Pages/Images to open the document in the PDF/Image viewer. 

TO USE THE PDF/IMAGE VIEWER TO REORDER PAGES OR IMAGES 

1. Right-click on a PDF or multiple page TIFF file and select Open to Reorder 
Pages/Images. The document opens in the viewer. 

2. Move the pages around using the drag and drop method. 

TO SAVE A MODIFIED PDF DOCUMENT 

1. After modifying a PDF document in the PDF/Image viewer, go to File > Publish to PDF. 

2. Select one of the options: 

 Publish Local File - Save the modified document to your local computer. 

 Publish File to FileHold Library - Saves the document to the Library. 

 Cancel - Cancels the action. 
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TO SAVE A PAGE AS AN IMAGE FILE (JPEG) 

1. After modifying a PDF document in the PDF/Image viewer, go to File > Save Page As. 

2. Save the current page to your local machine as a jpeg file. 

TO DELETE PAGES FROM A FILE 

1. Select the page or pages you want to delete in the thumbnail images. You can multi-select 
pages using the CTRL or SHIFT keys. 

2. Go to Edit > Remove Pages or click the Remove Pages button. 

TO PRINT A DOCUMENT 

 Go to File > Print or click the Print button. 

TO UNDOCK THE VIEWER 

 Click the Undock Viewer button. 

TO CLOSE A DOCUMENT IN A TAB 

 Click the X in the tab or go to File > Close File. 

NOTE: If you have the "Automatically open Document in Viewer" options selected in the User 
Preferences, the documents will only be opened in a single pane as you scroll through the 
documents. 
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14. SETTING PREFERENCES 

Preferences and Settings allows you to modify the document management system to suit your 
personal needs. You can modify your password, document list views, document alerts, 
workflow (if purchased), and FastFind preferences (if purchased). 

Some, none, or all of these settings may be determined and/or enforced by your System 
Administrator. See your System Administrator for details. 

TO SET PREFERENCES 

1. Do one of the following: 

 In FDA, go to File > Preferences and Settings. 

 In Web Client, click the arrow next to My FileHold. 

2. Set the following preferences: 

 View Preferences 

 User Preferences 

 Alert Preferences 

 Workflow Preferences  

 FastFind Preferences (FDA only) 

 Reset My Password (Web Client only) 

14.1. USER PREFERENCES 

The User Preferences allows you to edit your contact and password information. This includes 
the users account information, contact information, company information as well as default 
language preferences.  

The General tab contains user’s account setting information. The Contact and Company tabs 
contain user contact and company information respectively. The Advanced tab allows the user 
manage the functionality of the system. Some, none, or all of these settings may be 
determined and/or enforced by your System Administrator. See your System Administrator for 
details. 

TO SET THE USER PREFERENCES 

1. In FileHold Desktop Application (FDA), go to File menu > Preferences and Settings > 
User Preferences. 

 In the Web Client, click the contextual arrow next to My FileHold and select My User 
Preferences..  

2. The General tab contains the user account information. Use the following table to fill out 
the information in the General tab: 

Field Name Description 

First Name Your first name. 

Last Name Your last name. 



Fi leHold 14  End User  Guide  

120  February 2014 

Field Name Description 

User Logon Name You are not able to modify your user name in the 
User Preferences. Contact your System 
Administrator if you need to change your user 
name. 

Source Local FileHold account or a domain account 
(synchronized with Microsoft Active Directory). 

Default Language Select the default language. This is typically 
English. If the language you want is not available 
please contact your System Administrator and 
ask them about obtaining additional language 
packs from FileHold Systems. 

Default page after log in (Web Client only) 

 

Determines the window that is displayed after log 
in: Blank, Simple Search, Advanced Search, My 
Tasks 

Edit metadata upon Check In Action (Web 
Client only) 

When enabled, the metadata pane is displayed in 
edit mode after a new version is checked in. This 
allows the user to enter new metadata. If 
disabled, the user can check the document back 
in without editing metadata. 

Clear required metadata fields upon 
Check In (Web Client only) 

When enabled, any required fields in the schema 
are automatically blanked out (current value is 
deleted) when checking in a new version of a 
document. The users are forced to fill in the 
required field prior to checking in the document. 

Number of expanded drawers (Web Client 
only) 

The number of drawers that can be 
simultaneously expanded in the library tree can 
be set. The lower number of expanded drawers 
allows for a faster page loading time due to the 
lower number of permissions that needs to be 
calculated before displaying the library structure 
to the user. The last drawers that were opened by 
the user are preserved when the library is 
refreshed. The default is 3. 

Reset all “Don’t Show This Message 
Again” reminders (Web Client Only) 

If you have selected any “don’t show this 
message again” check boxes in various windows, 
you can have them reappear by clicking Reset. 

Change Password (FDA only) Click Change Password to change your 
password if you are using a locally-managed 
account. In the Set Password, enter your old 
password and a new password twice and click 
OK. NOTE: If you are using a domain user 
account (Active Directory), you will not be able to 
change your password. See your System 
Administrator. 
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Field Name Description 

Reset My Password (Web Client Only) Use the My FileHold context sensitive menu. 
Enter your current password, and enter your new 
password twice and click Update. 

 

Default Local Working Folder (FDA only) This is where your working documents are stored 
on your local machine. This is the path to where 
documents are checked out and downloaded. To 
change the path, click Browse and select the 
new working folder location. 

NOTE: For the Web Client, documents are 
downloaded to the location that is set in your web 
browser settings.  

 

3. In the FDA only, in the Advanced tab, select the settings you want enabled. NOTE: These 
options may be locked down by your System Administrator. 

Field Name Description 

Default page at start-up Determines the window that is displayed after 
log in: Blank, Simple Search, Advanced 
Search, My Tasks 

Number of expanded drawers The number of drawers that can be 
simultaneously expanded in the library tree 
can be set. The lower number of expanded 
drawers allows for a faster page loading time 
due to the lower number of permissions that 
needs to be calculated before displaying the 
library structure to the user. The last drawers 
that were opened by the user are preserved 
when the library is refreshed. The default is 3. 

Enable Click To Tag When enabled, the Click To Tag button 
appears in the metadata pane and allows you 
to “click” or “rubber band” text, numbers, 
dates, etc. on the screen and inserts the value 
into the metadata field of the schema.  

If disabled, the Click to Tag button does not 
appear in the metadata pane. 

Show Welcome Screen at Startup  Displays the FileHold Welcome Screen after 
you start the FDA: Blank, Simple Search, 
Advanced Search, Inbox, My Tasks, 
Calendar. 

Prompt me for download location when I 
make copies of files  

Allows you to select a location on your local 
machine to save your copied files. 
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Field Name Description 

Prompt me for download location when I 
check out files  

Allows you to select a location on your local 
machine to save your checked out files. 

Prompt me to remove files when sending 
them from the Inbox  

A prompt will ask you if you want to remove 
the files from your local machine when 
sending them from the Inbox. 

Prompt me to clean up my FileHold working 
folder when I close the FileHold Desktop 
Application  

A prompt will ask you if you want to remove 
the files in your working folder on your local 
machine when you exit out of FDA. 

By default close documents that I add/check 
in to FileHold  

Documents will be closed in their native 
application when it is checked in or added to 
the Library. 

By default delete documents that I add to 
FileHold  

Documents will be deleted from the working 
folder on your local machine after they are 
added to the Library. 

By default delete documents that I Check In to 
FileHold  

Documents will be deleted from the working 
folder on your local machine after they are 
checked into the Library. 

Auto-send documents to Auto-Tagged folders  Documents in the Inbox will be automatically 
sent to their location in the Library if the folder 
is Auto-tagged. You will not need to click the 
Auto-File button. 

Auto-send documents after completing 
metadata  

Documents in the Inbox will be automatically 
sent to their location in the Library after the 
metadata has been sent. You will not need to 
click the Send or Send All button. 

Move to recycle bin instead of permanently 
deleting  

Documents that are set to be deleted after 
checking in or adding to the Library will be 
moved to the Recycle Bin on your local 
machine instead of being deleted. 

Automatically open in the Viewer selected 
document in Inbox  

Any selected document in the Inbox will open 
in the Viewer automatically. NOTE: If this 
option is selected, only one tab will be opened 
at a time. This prevents users from opening 
several tabs at a time and using up a lot of 
system memory in the process. 

Automatically open in the Viewer selected 
document in folders and search results  

Any selected document in the folder view or 
search results will open in the Viewer 
automatically. NOTE: If this option is selected, 
only one tab will be opened at a time. This 
prevents users from opening several tabs at a 
time and using up a lot of system memory in 
the process. 
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Field Name Description 

Open documents in the Document Viewer 
using separate tabs  

Documents will be opened in multiple tabs in 
the viewer. NOTE: This option cannot be 
selected in conjunction with the "Automatically 
open in the Viewer selected document in 
folders and search results" or "Automatically 
open in the Viewer selected document in 
Inbox" options. 

Allow opening one document in multiple tabs A single document can be opened several 
times in multiple tabs using both Brava and 
PDF/Image viewers. Note that "Open 
documents in the Document Viewer using 
separate tabs" needs to be enabled in order 
to enable this feature. This feature is useful in 
multiple monitor situations. 

Enable Smart Check In and Smart Check Out 
messages  

Smart messages are the messages that 
appear when checking in and out a document 
using Microsoft Office applications. This 
setting is enabled by default. To turn off 
"Smart Messages", clear the check box. 
Examples of smart messages that are 
displayed in Microsoft Office applications from 
FileHold are: 

 When saving and closing a document without 
checking in a checked out document. 

 When getting a local copy of a document, 
making edits, and saving without checking 
out the document. 

 When checking out and opening a document 
and close the document after making no 
changes. 

 When opening and checking out a document 
(CTRL+double-click), and closing the 
document without making any changes. 

Edit metadata upon Check in action  When enabled, the metadata pane is 
displayed in edit mode after a new version is 
checked in. This allows the user to enter new 
metadata. If disabled, the user can check the 
document back in without editing metadata. 

Clear required metadata fields upon Check In  When enabled, any required fields in the 
schema are automatically blanked out 
(current value is deleted) when checking in a 
new version of a document. The users are 
forced to fill in the required field prior to 
checking in the document. 

Reset all “Don’t Show This Message Again” 
reminders  

 If you have selected any “don’t show this 
message again” check boxes in various 
windows, you can have them reappear by 
clicking Reset. 
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4. In the Contact Information tab, enter your personal contact information. This is for both the 
FDA and the Web Client. This information may be filled out if you are an Active Directory 
user. 

5. In the Company tab, enter your organization information. This is for both the FDA and 
Web Client. This information may be filled out if you are an Active Directory user. 

6. Click OK. 

14.2. VIEW PREFERENCES 

You can create or modify “views” in order to suit how you want documents displayed. There 
are several different view types, such as the folder list, checked-out documents, Inbox, 
Document Tray, and so on. You can customize each view to display specific columns and 
determine how you want the view sorted and grouped. The views can be made private or 
public which allows other users to access them. Users can also set a default view which 
displays the documents according to the default type unless otherwise specified. Changes to 
your view settings will not affect how other users view their folders or lists. 

The following is an example of a folder list view. You can change your view type by selecting 
an option from the Select View drop-down list. 

 

The benefit of customizing the views is that the user is able to see key information on a file 
without having to open up the file or view its metadata. For example, if a user is working in an 
engineering department and the majority of documents to be stored in the library will have a 
'Part Number' metadata value associated with it, then the part number field can be added as a 
column in the users folder display.  

The number of documents that are displayed per “page” is set in the view preferences. In the 
FDA, there can be 5 to 1000 documents displayed per page. In the Web Client, there can be 5 
to 30 documents displayed per page. The page numbers are shown in the right-hand top and 
bottom areas of the screen. The number of documents that are shown in the FileHold Office 
Client window when using the Microsoft Office Add-Ins can also be configured. 
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Library Administrators can create views and set them as the system default for all users. They 
can also reset the personal views of other users to a global view of their choice. They can also 
assign default views to cabinets, folders, virtual folders, and saved searches.  

TO SET YOUR VIEW PREFERENCES 

1. Go to File > Preferences and Settings > View Preferences in or right-click My FileHold 
from the Library tree and select View Preferences. 

2. In My Global View Preferences window, use the following table to fill out the form. 

Field Description 

Select View 
Type 

Select the view type you want to customize: Checked Out Documents, 
Document Alerts, Document Reminders, Document Tray, Folder List, Inbox, 
Linked Document List, My Favourites, My Workflow Tasks, Recently 
Accessed, Recently Added, Search Results, Workflow Documents (Show 
Documents pane), and Virtual Folder.  

For example, Checked out Documents will customize the My FileHold > 
Checked out Documents list. Inbox will customize the Inbox view. 

Select View Select a view from the list if it already exists for that view. 
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Field Description 

Add Click Add to create new view. Enter a view name and select if it is a Personal 
or Public view and click OK. A personal view will only visible to you while 
public views can be seen by all users. Only Administrators can create public 
views. 

Edit Click Edit to modify the name of the view. Rename the view and/or select a 
view type (personal or public) and click OK. 

Delete Click Delete to delete a view. Click OK at the confirmation message. The 
view is deleted. 

Set as System 
Default View 

When logged in as Library or System Administrator, you can add a new 
System Default View for the system. When creating a new System Default 
View, you must make the new view a Public view. Then click Set as System 
Default View. Now all users will see this view when logging onto the system. 

Set as My 
Default View 

When creating a new view, you can set it as your own default view. This view 
overrides the System Default View in any of the view types that do not have a 
designated view applied to them. 

Create My 
Personal View 

Create a personal view for a view type not seen by any other user such as 
personal search view or personal virtual folder. 

Current 
Fields/Column
s used in this 
view 

Lists all the column names, their descriptions, and the order they are sorted 
across the screen. 

To reorder the columns, select a number from the drop-down list. 

To remove a column, click the X. 

Add a field 
(column) to the 
view 

Select a metadata or system value to add to the view from the list and click 
Add Field. 

Once you have added a field, you can sort the order of the columns in the 
Order Column. 

Sort view by Select the column you want to sort by from the drop-down list and select if 
you want the documents displayed in ascending or descending order. 

Group by Select the check box and select how you want the documents grouped. 
Select a descending or ascending order. This is only available in the FDA. 

In the example below, the documents are grouped by Document Type: 

 

Show x items 
in this view 
(Web Client 
only) 

Enter the number of documents you want displayed in the Web Client. Enter 
a value from 5 to 30. 
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Field Description 

Number of 
documents per 
page – Main 
FDA window 
(FDA only) 

Enter the number of documents you want displayed “per page” in the 
FileHold Desktop Application. For example, if you have 4000 documents in a 
single folder, then 500 documents will be shown on a “page”. It is 
recommended that this value be set to 500. 

Number of 
documents – 
FOC windows 
(FDA only) 

Enter the number of documents you want displayed “per page” in the 
FileHold Office Client window. It is recommended that this value be set to 20. 

 

3. Click Apply or OK to save the view settings. 

14.2.1. Creating Ad-Hoc Views 

You can modify any view by adding or removing columns, grouping documents, expand or 
collapse groups, or reorder columns “on the fly”. 

TO CREATE AD-HOC VIEWS 

1. In any view, right-click on a column header and select one of the following: 
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 Group By – Group documents by document name, type, linked, version, status, or 
last modified date. 

 Add / Remove Columns – Add or remove columns from the view. All system values 
and metadata values can be added or removed from the view. All values with a check 
mark beside the name are shown in the view. To remove the column, select the value 
with the check mark. 

 Add / Remove Columns > Reorder Columns – This opens the Global View 
Preferences window. You can reorder the columns in the Order column. See View 
Preferences for more information. 

 Expand/ Collapse All Groups – This expands/collapses grouped documents. You can 
also click the +/- sign next to the Group Name. 

 

2. For exporting the document list to a CSV file, see Exporting Documents in a View to a CSV 
File. 

14.2.2. Workflow Views 

If you are a participant or an observer in a workflow, you can modify any view to include the 
Approval Status in the listed columns. This allows users to see where in the process a given 
file is, to check if it has been approved, know when the version of the document was approved. 

To add Approval Status to a view, right-click on a column header and select Add / Remove 
Columns > Approval Status and/or Approval Date. In the example below, you can see which 
invoices have been approved and those which have not gone through the workflow process. 

 

14.2.3. Setting the Default Folder, Cabinet, Virtual Folder, or Saved Search View 

Folders, cabinets, virtual folders, and saved searches can have specific views created and 
assigned to them so that the views are displayed in a certain way. Administrators can create 
public views in the View preferences area and then assign the default view to the search. 
Users can also do this for their "My Saved Searches" and “My Virtual Folders” using personal 
views. 

TO SET THE DEFAULT VIEW FOR A CABINET, FOLDER, VIRTUAL FOLDER, OR SAVED SEARCH 

1. Create a new view to be used. For folders, cabinets, public saved searches and public 
virtual folders, administrators will need to create a public view. For personal saved 
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searches (My Saved Searches) end users can create personal views. See View 
Preferences for more information. 

2. Right click on the folder, cabinet, virtual folder or saved search name and select Set 
Default View. 

3. Select the view you want to use from the drop down list. To use the global default view, 
select the Use global default view check box. 

4. To make this the default view all users, select the Make it the default setting for all 
users check box. 

5. To enforce the use of this view for this saved search, select the Force all users to use 
this default setting check box. 

6. Click OK to save your settings. 

14.3. ALERT PREFERENCES 

You can set alert preferences so that you are notified when a change occurs to a document or 
folder. You can view alerts in My FileHold > Document Alerts and/or receive an email alert, if 
you system has been configured. In order to receive an alert, you must have set an alert on a 
document or folder. See Setting Document Alerts and Reminders for more information.  

The alert preferences allow you to determine which type of change you want to be notified of, 
such as a document addition, change to metadata, or when a file is checked. Users can also 
be notified via email and alerts of specific date based events call user defined events. For 
example, policies must be updated or reinstated at least once every three years. The policy 
team would like to review the documents 60 days before the three year anniversary. The event 
can be set up so that every three years, the owner of the policy will be notified 60 days prior to 
the policy expiry date. User defined events are set on the document schema by the Library 
Administrator. For more information, see the Library Administration Guide. 

Some, none, or all of these settings may be determined and/or enforced by your System 
Administrator. See your System Administrator for details. 

TO SET ALERT PREFERENCES 

1. Go to File > Preferences and Settings > Alert Preferences in or right-click on My 
FileHold and select My Alert Preferences. NOTE: The alert options may be locked down 
by your System Administrator. 

2. In the My Alert Setting window, select the following folder alert options: 

 New documents/versions are added to folders I have subscribed to. 

 Documents are transferred to folders I have subscribed to. 

 Documents are deleted from folders I have subscribed to. 

3. Select the following File (document) alert preferences: 

 A new version of a document I have subscribed to is checked-in. 

 Metadata values are updated for a document I have subscribed to. 

4. In the Email Alert Preferences, select the check box if you wish to receive an email in 
addition to displaying alerts in the My FileHold > Document Alerts area. 

5. Enter the email address that the alert should be emailed to. 

6. Select an alert frequency: 
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 Send email immediately – Sends the email as soon as the change is made. 

 Send a daily summary – Sends the email once per day with a summary of all the 
alerts. 

 Send a weekly summary – Sends the email once per week with a summary of all the 
alerts. 

7. In the Reminders area, select the Send email… check box to have reminders emailed to 
the specified account. 

8. Select a email reminder frequency: 

 Send email immediately. 

 Send a daily summary. 

9. Click OK. 

14.4. WORKFLOW PREFERENCES 

You can set preferences to be notified via email when certain workflow events involving you 
occur and delegate your tasks to someone else if you are away from the office for a period of 
time.  

Workflow tasks can be viewed in Reviews and Approvals > My Tasks list. See Viewing 
Workflow Tasks for more information. 

Some, none or all of these settings may be determined and/or enforced by your System 
Administrator. See your System Administrator for details. 

TO SET WORKFLOW ALERTS 

1. Do one of the following: 

 In the FDA, go to File > Preferences and Settings > Workflow Preferences 

 In the Web Client, click on Reviews and Approvals arrow and select My Workflow 
Preferences.  

2. In the My Workflow Preferences window, select the check boxes for the events you want to 
be emailed for. NOTE: These options may be locked down by your System Administrator. 
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 A task is assigned or delegated to me 

 A task is assigned to me is overdue 

 A task assigned to me is overridden 

 A task assigned to me has been reserved by another participant. 

 A task assigned to me is cancelled 

 A task assigned to me is restarted 

 A document associated with a task assigned to me is added or removed 

 A document associated with a task assigned to me is checked out or checked in 

 If tasks in workflow I am the initiator are overdue 

 Activity is completed for a workflow I initiated 

 Workflow is completed for a workflow I initiated 

 Workflow is restarted for a workflow I initiated 

 Document is added or removed from a workflow I initiated 

 Workflow is completed for a workflow I am an observer of 

 Workflow is restarted for a workflow I am an observer of 

 Document is added or removed from a workflow I am an observer of 

 Activity is completed for a document that I own 

3. In the email alert frequency, set how often you wish to receive email alerts. NOTE: These 
options may be locked down by your System Administrator. 

 Send email immediately – Sends the email as soon as the change is made. 

 Send a daily summary – Sends the email once per day with a summary of all the 
alerts. 

 Send a weekly summary – Sends the email once per week with a summary of all the 
alerts. 

4. To automatically delegate your tasks to someone else in the event that you will be 
unavailable due to a vacation, sabbatical, or illness, select the Automatically delegate 
tasks… check box and click Find. To delegate a workflow on a case per case basis, see 
Delegating Tasks to Another User. 

NOTE: A Library Administrator can delegate tasks on a user’s behalf. See the Library 
Administration Guide for details. 

5. In the Find People window, enter a name or email address and click Find.  

6. In the Search Result select the user and click Select User(s). 

7. Click OK. 

14.5. FASTFIND PREFERENCES 

 FastFind provides search capability from third party windows-based forms applications such 
as Windows Desktop Applications such as accounting or GIS software. FastFind works in 
conjunction with the FileHold Desktop Application (FDA). Users can use keyboard shortcut 
shortcuts that perform searches directly from the chosen application in the document 
management system to find relevant data instantly. 
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FastFind is relatively easy to set up and use by most users with some basic instructions; 
however, FastFind can be leveraged to perform a more dynamic search of the document 
management system by someone who can work with regular expressions. You can also set up 
FastFind templates to improve your searches from various third party applications. 

For example, a search in a Microsoft Word document for the term “FastFind” using the shortcut 
key Ctrl +D, returns the search results in the FileHold Desktop Application. In the example 
below, there are 97 results found. 

 

NOTE: FastFind preferences can only be set in the FileHold Desktop Application. It cannot be 
set in the Web Client. 

Some, none, or all of these settings may be determined and/or enforced by your System 
Administrator. See your System Administrator for details. 

In order to use FastFind, you must purchase this optional feature. Contact sales@filehold.com 
to purchase the FastFind module. 

TO SET THE FASTFIND PREFERENCES 

1. In FDA, go to File > Preferences and Settings > FastFind Preferences. NOTE: These 
options may be locked down by your System Administrator. 

2. To enable FastFind, select the Enable FastFind check box. 

3. To have the FastFind templates updated when you log onto the document management 
system, select the Update FastFind templates… check box. Read more about FastFind 
templates.  

4. Select the check boxes for the following shortcut key options: 

 Mouse Search (Alt + S) – Activates an on-the-fly screen scraper. When this is done a 
green bar appears in the bottom-left corner of the user’s desktop screen. Users can 
now start moving their mouse over screen form objects such as data fields or field 
labels. The text under the current mouse position is captured and displayed in the 
green bar. If a user wishes to search with the captured text they may left click to 
invoke the FileHold search. This initiates the Full Text and Metadata search in 
FileHold and the search results are displayed within FileHold’s standard search 
results screen. Pressing the ESC button at any time will stop the mouse search 
mode. 

 Selection Search (Alt + D) – Highlighting a word or string or partial string in a third 
party application and pressing Alt+D will initiate a Full Text and Metadata search and 
display results within FileHold application. 

 Clipboard Search (Alt + C) – This uses a 2-step process to search for documents in 
the Library. First, you copy any text from the screen to the Windows clipboard using 
traditional “Copy” menu option or the Alt+C shortcut available in most Windows 
applications. Next, press Alt+C to use the contents of the Windows clipboard to 
activate a Full Text and Metadata search in FileHold. Since FastFind uses the 

http://www.filehold.com/help/user/fastfind-templates
mailto:sales@filehold.com
http://www.filehold.com/help/user/fastfind-templates
http://www.filehold.com/help/user/fastfind-templates
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contents of the clipboard, any string or partial strings can be copied to the clipboard 
and searched upon. 

 Enable screen OCR search (Alt + F) – Allows you to do a search based on the Click 
to Tag functionality. Once the shortcut key is invoked, you can click on the text on the 
screen or draw a bounding box (rubber band) around the text. Then a search is 
performed in FileHold to meet the selected criteria from the screen. 

 

5. To activate FastFind templates, select the check box next to the template name. Learn 
more about creating FastFind templates.  

6. Click OK. 

14.5.1. Changing the FastFind Keyboard Shortcuts 

You can change the predefined keyboard shortcuts to a different shortcut key. You would do 
this if the default FastFind shortcut key conflicts with another preset shortcut key in the 
application that you are doing the searching from. For example you can change the mouse 
search shortcut to Shift + F3 instead of using Alt+S. 

TO CHANGE THE SHORTCUT KEY 

1. In FDA, go to File > Preferences and Settings > FastFind Preferences. NOTE: These 
options may be locked down by your System Administrator. 

2. Click the keyboard shortcut type you want to change (mouse search, selection search, or 
clipboard search). 

3. In the Change Shortcut screen, change the default keyboard combination and click OK. 

http://www.filehold.com/help/user/fastfind-templates
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15. WORKING DOCUMENTS 

When the user wants to clean up the files that they have downloaded or checked out to their 
local machine they can do so by logging into the FileHold Desktop Client and using the 
Working Documents tool. 

The Working Documents window displays the contents of the default "local folder"*. It lets 
users know if the file has been checked out, the local version number and whether it is the last 
version located in FileHold. This information helps users decide what action to take for each 
file. 

NOTE: The "local folder" is the "My FileHold Documents” folder that is automatically created by 
FileHold when it is installed on a local computer. 

In order to see documents that a user may have downloaded to folders other than the default 
folder, the user can clear the Show my local working folder only check box setting. The list 
of all documents that a user has downloaded or checked out will appear. 

Users can then select files one at a time or in groups and using the Synchronize button at the 
bottom of the results screen, choose which local folder(s) clean-up function they would like to 
perform. Users have 3 functions to select from: 

 Get newer version of files from the library —Downloads a more recent version of a 
document from FileHold to the local folder when the version on FileHold is newer than the 
one in the local machine.  

 Check-in files that I have updated locally — Checks in files that users have updated locally 
but not yet returned to the system. 

 Remove duplicate or older files that I have on my local computer— Checks for files that are 
duplicated or are older versions of documents that have newer versions available and 
deletes them from the local folder 

The Working documents list can be accessed when users are disconnected from the server 
and working offline, however they will not be able to synchronize the files until they are again 
hooked up to the server. This means that they may not have access to the very latest version 
of a document or that any updating that they do to a document offline will have to wait until they 
are reconnected to the server to be updated in FileHold. 

TO ACCESS THE WORKING DOCUMENTS TOOL  

1. Open the FileHold Desktop Application.  

2. Select Tools > Working Documents. The list of working documents appears. 
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16. WATCHED FOLDERS 

Watched folders create a kind of direct line that allows users to place their documents into the 
watched folders and from there they are automatically sent to the document management 
system. Users can create as many watched folders as they need. When a user creates a 
Watched Folder, the files that are placed there are automatically associated with an existing 
document schema and metadata and then sent either to the Inbox or to a mapped folder in the 
Library. Files configured to be sent to an existing folder in the Library can be sent ONLY if the 
schema selected does not have any required fields missing. If the fields are required and the 
values are missing, the files will go to the Inbox for processing even if a destination folder has 
been mapped. 

The Watched Folder does not perform Auto-filing because in many cases the files will not have 
completed metadata values associated with them. However, documents can be tagged quickly 
en masse the Inbox. Once the files are prepared in the Inbox, the user can then click Auto-File 
in the Inbox to send all the files to their final destination. 

Watched folders are typically used in conjunction with scanning stations; however, you can 
also use this feature to import a large quantity of documents into the system. When scanning 
documents, you can set an output folder for the batch and then configure the Watched Folder 
to watch that output folder for any new scanned images. FileHold will automatically import any 
new documents from the output folder into the Inbox of FDA or configured folder in the Library. 
A different output folder for each batch type should be created in the scanning software (QSP) 
as well as a corresponding Watched Folder should be created for each output folder. See the 
QSP Best Practices for more information on creating batches. Watched folders should be used 
when you are scanning documents with Full-Text OCR or no OCR batches. For Zonal OCR 
scanned batches, use the Manage Imports tool. 

Watched Folders can only be created in the FileHold Desktop Application (FDA). 

NOTE: The following file types cannot be brought into FileHold using Watched Folders:  asp, 
asx, bas, bat, cer, chm, cmd, com, cpl, crt, csh, exe, fxp, hlp, hta, inf, ins, isp, js, jse, ksh, lnk, 
mda, mdb, mdt, mdw, mde, mdz, msc, msi, msp, mst, ops, pif, prf, prg, reg, scf, scr, sct, shb, 
shs, tmp, vb, vbe, vbs, vsmacros, vss, vst, vsw, ws, wsc, wsf, and wsh. 

TO CREATE A WATCHED FOLDER 

1. In FDA, go to Tools > Watched Folders and click Add. 

2. In the Browse for Folder window, select the folder that you want to "watch" on your local 
computer or network drive. For example, select the output folder for a scanned batch of 
documents. 

3. In the Watched Folder Properties window, the Folder Path to the Watched Folder is shown. 

4. Select the Delete input files check box to automatically delete the files from the folder that 
is being watched. This keeps the folder clean and reduces the folder size; this could 
potentially get quite large if you are scanning a lot of documents. 

5. To automatically send the files to a specific folder in the Library, select the Automatically 
send files to selected folder in FileHold check box and click ... to select a destination 
folder. 

6. To set the metadata for the documents, select the Automatically set metadata for input 
files check box and select the Document Schema name from the list. 

7. Enter the metadata values. You can determine which metadata fields will receive a fixed 
value for all the documents by selecting the check box next to the metadata field name and 
entering a value. If the check box is selected and the metadata field is required, a value 
must be entered into the field. If the check box for the metadata field is not selected, a 

http://www.filehold.com/help/scanning/manage-imports-tool


End User  Guide  F i leHold 14  

February 2014  137 

value is not required even if the field is required. However, the “Automatically send files to 
the FileHold Library” cannot be enabled since the required value is missing and will need to 
be entered in the Inbox. If the metadata field is set to “read-only”, then you cannot select 
the check box; this field will always use the default initial value set up in the schema.  

8. Select the Automatically "Send files" to the FileHold Library to automatically send the 
files to the set folder location. If you do not select this option, then all files will go to the 
Inbox instead of being automatically sent to the folder location. This option is not available 
unless the Automatically set metadata for input files is selected. 

9. To delete the files that are successfully imported into the library, select the Delete input 
files sent to library check box.  

10. Click OK when done. 

11. The new Watched Folder will appear in the List of Watched Folders. 

12. To delete a Watched Folder, click the red X next to the Watched Folder name in the 
Watched Folders list. 
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17. VIEWING ALL FILES IN TRANSFER 

If you are moving a bulk load of files into the system, you can view the files that are in transfer 
into the document management system. This is helpful when you want to see how the file 
transfer is progressing, or if you need to pause or cancel a transfer. 

In the View Files in Transfer window, you can pause, resume, cancel, or clear completed and 
cancelled transfers into the system. You can also view only those files that are being sent into 
the Library at the current time. 

 

The following table describes the functions in the All Files in Transfer View: 

Function Description 

Pause Puts a hold on the transfer of a document. 

Resume Removes a pause on a document so it can be 
transferred into the Library. 

Cancel Cancels a document from being transferred 
into the Library. 

Clear Completed and Cancelled Removes all completed and cancelled 
transfers from the view. 

Show Sending to Library Only Displays only the document that is currently 
being transferred into the Library. 
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18. WEBCAP – WEB BROWSER SCANNING 

FileHold WebCap is a web-based scanning feature that allows remote users to scan 
documents via a web browser without the need of scanning software installed except for the 
scanner drivers and the browser plug-ins required for the web scanning to work. Remote users 
can scan and store documents into the FileHold document management repository from 
anywhere they have access to the internet and a scanner. Note that WebCap works only with 
scanners that correctly support the TWAIN driver interface. 

This feature is useful for organizations that have many remote offices or many mobile workers 
who need to scan documents such as contracts, bill of sales, expenses, or work estimates into 
a document management system. It is especially powerful for companies who want these 
documents to go into a workflow to automate review and approval processes after they have 
been scanned. 

18.1. USING WEBCAP 

WebCap scanning is done via the FileHold Web Client which is a browser based client. The list 
of supported browsers can be viewed in the FileHold System Requirements. In the Web Client, 
all scanning and viewing of the documents is done in the Scanner Inbox. 

In order to scan images, ensure that you have the TWAIN driver installed on your computer for 
your scanner. You will also need to install the Web Scanning Plug-in control (browser plug-in) 
in order for the scanning to work.  

The quality of the scan and compression of the final document that is uploaded to the 
document management repository or saved to the local computer can be controlled in WebCap 
settings. 

The image viewer allows pages to be previewed, added, reordered, removed, zoomed, de-
skewed, rotated, compressed, loaded from, and saved to disk. Documents can be stored in 
FileHold in TIFF or PDF format. 

Documents in the Scanner Inbox are saved to the FileHold server until they are removed. This 
allows users to log off and come back to the images at a later time without losing them. 

In order to start scanning, you will need to: 

 Install the correct TWAIN driver for the scanner 

 Install the browser plug-in 

 Connect WebCap to the scanner 

 Configure the settings for the scanner. 

NOTE: Before you make a final scanner selection to use with WebCap you should test 
WebCap, the scanning workstation, the TWAIN driver, and the scanner together. WebCap 
supports the TWAIN 1.x and 2.x standards, but this is not true for all scanner vendors, on all 
operating systems, and with all of their models. 

18.2. INSTALLING THE SCANNER TWAIN DRIVER 

WebCap works with scanners that support the TWAIN driver interface. Using the software that 
came with your scanner, install the TWAIN driver. If your scanner did not come with TWAIN 
software for your scanner, contact the scanner manufacturer for support.  

http://www.filehold.com/how-to-buy/system-requirements
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18.3. INSTALLING THE BROWSER PLUG-IN 

When starting the Web Client and going to the Scanner Inbox for the first time, you will be 
prompted to install a Web Scanning browser plug-in. Depending on the browser you are using 
you may receive various messages and pop-ups to install the plug-in.  

For example, in Microsoft Internet Explorer 9, you may see the following message along with 
the pop-up to install: 

 

 

For more information on installing plug-ins for your browser, see your browser’s help guide. 

TO INSTALL THE PLUG-IN 

1. Log into FileHold and go to the Scanner Inbox. 

2. You will be prompted by the browser to install the plug-in. Follow all prompts to install the 
Web Scanning plug-in. 

3. Refresh the browser by clicking F5. You are now ready to start scanning. 

18.4. WEBCAP SCANNING  

WebCap allows you to scan from a web browser into the document management repository or 
the local computer. Prior to scanning, you will need the TWAIN driver and the Kofax plug-in 
installed. You will also need to connect WebCap to the scanner and configure the scanner 
settings. 

18.4.1. Scanner Inbox 

The Scanner Inbox is where all of the scanned or added images are stored in the Web Client 
version of FileHold. Documents in the Scanner Inbox are saved to the FileHold server until they 
are removed. This allows users to complete other functions in the document management 
system or log off and come back to the images at a later time without losing them. 

TO ACCESS THE SCANNER INBOX 

1. Log in to the Web Client version of FileHold. 

2. Click on the Scanner Inbox in the Library Tree area. 
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In the Document Viewer area, the thumbnails for the images are shown on the left and the 
entire image is shown on the right for the currently selected thumbnail. 

 

18.4.2. Configuring the Scanner  

You will need to select the scanner you want to use for scanning. Ensure that the TWAIN driver 
for the scanner has been installed on your computer. 

NOTE: There may be WIA drivers shown in the drop down list along with the TWAIN drivers. It 
is possible that selecting the WIA drivers by accident could cause WebCap to fail. If needed, 
the configuration can be changed to filter out any driver names containing "WIA". A Windows 
Server system administrator can edit the web.config file for the web client. The file can be 
commonly found on the FileHold server at C:\Program Files\FileHold Systems\Application 
Server\WebClient\web.config. Add the following entry to the <appSettings/> section.  

<add key="AtalasoftWebControls_RemoveWiaDevices" value="false"/> 

TO SELECT THE SCANNER 

1. In the Scanner Inbox, click Select a Scanner . 

2. Select the scanner from the drop-down list and click Close. 

18.4.3. Configuring the Scanning Settings 

Once you have the scanner that you want use selected, you can configure the settings. 

For more information on compression levels, see Compression Levels for Scanning. 

TO CONFIGURE THE SCANNING SETTINGS 

1. In the Scanner Inbox, select Scanning Settings . 

2. Depending on your TWAIN driver, the scanner settings may differ. Some configuration 
options may include: 

http://www.filehold.com/help/scanning/scanning-compression-test-results
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 Pixel Type – Select one of the following: Black and White (default), Greyscale, RGB 
24 bits per pixel, or Indexed color images 8 bits per pixel. 

 DPI – Select the DPI value: 100 (default), 150, 200 or 300. The higher the DPI, the 
higher quality the scan and document size. 

 Duplex – Select if duplex scanning is enabled (default) or disabled. 

3. Click Save once the scanner has been configured. 

18.4.4. Scanning, Adding, and Removing Images 

Once everything is configured for the scanner, you can now scan images into the Scanner 
Inbox of the Web Client of FileHold. 

With WebCap, you can add, replace, and delete pages as well as clearing the entire document 
from the Scanner Inbox.  

See the table below for a list of functions and descriptions. 

Function Description 

Scan a Document  
Scans all documents in the scanner and adds 
them as an image to the Scanner Inbox. The 
images appear in the Document Viewer as a 
thumbnail on the left side. Click on the 
thumbnail for the full size image which 
appears on the right. 

Replace Page  
Replaces the selected page with a newly 
scanned page. The scanner automatically 
scans and replaces the currently selected 
page. 

Add a New Page  
Allows you to add a new page from the local 
computer. Click Browse and then Upload to 
add the image. Note that only images files 
such as jpeg, gif, png, bmp, tiff (single or 
multi-page), emf, or wmf can be uploaded. 
For vector formats, the final rendering of 
the image is system dependent.  

Delete a Selected Page  
Deletes the currently selected page. 

Clear All Pages  
Clears all pages from the Scanner Inbox. 

18.4.5. Manipulating and Navigating Images 

Once you have images scanned into WebCap, you can use the various tools to modify how the 
images are displayed. 

See the table below for a list of functions and descriptions. 

Function Description 

Reorder pages Drag and drop images in the thumbnail pane 
to reorder images. A red bar appears where 
the image is dropped. 

Pan images Hold the left mouse button and drag the 
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Function Description 

cursor to where you want to pan to on the 
image.  

Zoom In  
Zooms in on the image. 

Zoom Out  

Zooms out from the image. 

Fit to Width  
Adjusts the image on the screen to fit the full 
width of the image. 

Best Fit  
Adjusts the image on the screen so the entire 
image is displayed. 

Full Size  
Shows the full image size. 

Rotate Left  
Rotates the image 90° to the left. 

Rotate Right  
Rotates the image 90° to the right. 

Rotate 180  
Rotates the image 180°. 

Deskew  
Straightens the image so that the text of the 
image is vertically aligned. 

Show Document  
Returns to the Document Viewer when a 
message is being displayed. For example, 
when the “delete page” or “upload page” 
message appears.  

Previous Page  
Previous image is displayed in the document. 

Next Page  
Next image is displayed in the document. 

<page number>  

Enter a page number to show the image. 

18.4.6. Submitting Documents to the Repository 

Once the document has been composed, you can submit it to the document management 
repository for storage. 

TO SUBMIT A DOCUMENT TO THE REPOSITORY 

1. After the document is scanned and arranged in the Scanner Inbox, click Submit 

Document . 

2. Select the folder location for the document from the library. The selected folder will be 
bolded. The last folder used will be selected, if applicable. 
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3. Click Next. 

4. In the Submit Settings screen, set the following options: 

Field Description 

Remove cover page before submitting the 
document 

Automatically removes the first image from 
the document that is being submitted.  

Clear Scanner Inbox after submitting the 
document 

Removes all images from the Scanner Inbox 
after the document is in the repository. 

Bi-level image compression Select one of the following compression levels 
for black and white or grayscale images: 

 None 

 CCIT Group 3 

 CCIT Group 4 (default) 

 LZW 

For more information on compression levels, 
see Compression Levels for Scanning. 

Color image compression Select a compression level for color images: 

 None 

 LZW 

 JPEG 25% 

 JPEG 50% 

 JPEG 75% (default) 

 JPEG 90% 

For more information on compression levels, 
see Compression Levels for Scanning. 

Document file format Select one of the following 

 TIFF 

 PDF 

http://www.filehold.com/help/scanning/scanning-compression-test-results
http://www.filehold.com/help/scanning/scanning-compression-test-results
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5. Do one of the following: 

 Click Next if you are using barcodes to index your documents. 

 Click Submit to add the document to the repository. 

6. If you clicked Next, review the schema and metadata information. Some of this information 
taken may be taken from a barcode such as the schema (if applicable). Enter a value in 
any remaining required metadata fields or edit any existing metadata values. 

7. Click Submit. 

8. The document is uploaded to the repository and is shown in the folder with the metadata 
pane open. 

18.4.7. Downloading Images 

Single images can be downloaded to the local computer. Downloaded images can only be 
saved as TIFF images. 

TO DOWNLOAD DOCUMENTS 

1. Select the image you want to download from the Scanner Inbox. 

2. Click Download Document . 

3. Open or Save the image locally. The document is saved to the default download location 
set in your browser.  

4. Click OK after the document is done downloading to return to the Scanner Inbox. 

18.5. TROUBLESHOOTING WEBCAP 

 WebCap works with scanners that correctly support the TWAIN driver interface. If you are unable to 
scan with WebCap, verify that you have a TWAIN driver installed for your scanner. If you are not 
sure, check with the manufacturer of the scanner. 

 Ensure you have the Web Scanning Plug-in (browser plug in) installed for your browser type that 
you are using with the Web Client. Check with the browser’s help for more information on plug-ins. 

 If you are experiencing problems with your browser, close the browser window completely and log 
back into FileHold. If you are still experiencing issues, try an alternate browser. 

 The HP ScanJet 5590 is not supported with WebCap. We strongly recommend avoiding this 
scanner. It is one of the few TWAIN scanners that we officially do not support. Use at your own risk. 

  

http://www.twain.org/scannerusers/find-drivers.html
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19. REFRESHING THE FILEHOLD SYSTEM 

If you have made changes in the Library Administration or System Administration areas of 
FileHold, you will need to update the FileHold Desktop Application by using the Refresh 
function. This will load your changes into the application. 

TO REFRESH THE FILEHOLD SYSTEM 

 Go to File > Refresh All.  

20. ACCESSING SYSTEM AND LIBRARY ADMINISTRATION 

To access the Library Administration or System Administration areas of FileHold: 

 In FDA, select Administration > Library Administration or System Administration from 
the menu bar. You will be redirected to the Web Client. 

 In Web Client, login and click the Library Admin or System Admin links at the top of the 
screen. 

 

Note that you will only have access to these areas if you are an administrator. 

21. FILEHOLD HELP 

To read a help topic, click a question mark (?) in the window. You will be redirected to the 
relevant topic in the online help.  

You can also access the home page for the online help by selecting Help > Help from the 
menu bar in the FileHold Desktop Application. 
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